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1 Welcome

LEAD is a learning event authoring suite for learning analysts, instructional designers, and

curriculum developers. It is a mature and comprehensive solution from training needs analysis

through content and assessment design and development. LEAD provides links from:

· Performance requirements, to task analysis skills, to learning objectives, and from there to

storyboards for IMI content, as well as instructor and participant content, and assessment

test items.

· Resources to learning events, and to specific pieces of content.

Links make it easy for you to manage and make updates to your learning content.

About this documentation

This document is designed both as a training aid in using LEAD and as an ongoing reference

while you are working in LEAD. You can skim it for easy reference, work through it

systematically for in-depth knowledge, and refer to it for more information whenever you

need.

What has changed in the LEAD User's Manual
For Version 2.0:

· Initiatives can be exported from one LEAD instance, and imported in another LEAD

instance.

· Comments  can be added to most initiative screens. The Status  and Priority  fields

can be customized for your organization. You can include comments on the Output

Options  screen for initiative outputs that come in PDF format. You can also output All

Comments for a selected initiative from the Implement  tab. 

· Resource Selection screens (for single  resource selection, multiple  resource

selections for the TNA/TMD and skills, and multiple  resource selections for sheets)

now display all resources that have been cited in the initiative and not just those listed on

the TNA or TMD Resources lists. 

· Cancellation TNAs can now be easily distinguished from other TNAs on the Analysis tab.

· TNAs can change TNA Type when they are created. 

Note: You can have only two TNAs active at any time (one New, Modification, or Revision

TNA Type and one Cancellation TNA Type). you can have as many approved TNAs as

needed.

· TO levels (i.e. lessons) can easily be moved between module levels in the same initiative,

using Copy /Paste: Move .

· Cited Sheet  screen has been added listing the sheets that have been created for a

table of contents item and whether the sheets have not been cited in an element.

218 235 236

208

154

144 211

140

115 113

138
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· Slide Viewer  can be used to view the slides of an IMM resource with an associated

PowerPoint file in LEAD without having to download the file.

· Multiple resources  can be selected on for sheets and performance job sheet test items

at the same time on the tabs that list resources.

· Resources can be selected for the following sheet tabs:

o Assignment Sheet - Study Questions

o Job Sheet - Self-Test Questions

o Problem Sheet - Problem

· Initiative output changes:

o Bookmarks have been added to the TNA, TMD, TDD, and Storyboard PDFs.

o File names are now included in the Media folder for IMM files that output as part of a

package on the Implement  tab.

· Replace   is now also available for Resources, Library items, Departments, Locations,

and Customizations > List items.

Note: You will only see Replace , when you have the Replace privilege as part of your

role.

· An IETM Extraction File can be generated for any IETM stored in LEAD.

· Missing File Resources report has been added for both IETM  and IMM  resources

that will list all IETMs with a Comparison File that is listed with the IETM but cannot be

found on the server and all IMMs with an Associated File that are listed with the IMM but

cannot be found on the server. You can also run the report for a specific initiative from

the Resource Management  screen.

· Likewise, the All Resources reports have been updated for IETMs  and IMMs  to

indicate any missing files that are associated with a listed resource.

· The Unused Resources report has been renamed to Uncited Resources Report .

· Login History report is now available on the Reports tab.

· Related Materials and All [selected item] reports are now available for Library items,

Departments, Locations, and Customizations > List items. A Report tab has been added

for the Customizer to be able to output the Customizations > List items reports.

· Locations can be associated to a different department at any time and not just when you

first create the location.

· Copy   a user is now available, as well as Changing the Password  of a user to a

either the automatically generated password or a manually entered password. You can

217

140

152

209

166 168
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200
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also View the details of a user's role from the User Detail screen. All changes to a user

(including creation and deletion) are logged in the System Log .

· Enable COI Item Level In-Use  configuration setting has been added to the Program

group to allow you to choose whether to use the traditional LEAD in-use functionality or

have the in-use setting cover the entire Table of Contents item. 

For Version 1.9.3:

· Added a field to the System Log Detail screen to show the Program Location of the error.

· Storyboard  can be output for any table of contents item on the Develop tab (except

for Overview and Summary).

· Overview or Summary  Instructor Guide can be output for any Terminal Objective Level.

For Version 1.9.2:

· Expanded information on the Font Size  selection for the Text Editor.

For Version 1.9.1:

· Login History  can be viewed for any user by selecting a user on the Admin > Users

screen.

· Configuration  entries have been grouped and an Explanation has been added to help

you customize LEAD settings.

· A new Deleted Users Can Be Restored  configuration setting has been added to allow

you to choose whether a deleted user can be re-activated or not.

For Version 1.9:

· Expand ( ) functionality has been added to screens with a tree structure to allow you to

open or expand more than one item in the tree structure at once. This includes the:

o Competencies  screens.

o Initiative screens on the Analysis , Design , and Develop  tabs.

o IETM Selection  screen.

· Deletion functionality has been updated: 

o Secondary Deletion screen has been added to when deleting archived initiatives, a

Modification TNA  on the Analysis tab, table of contents items  on the Design tab,

and all Resources tabs: Consumables , IETMs , IMM , Publications , Software

, and Tools/Equipment .

o Undo functionality has been added when deleting items on the Admin, Library, and

Customizations tabs, as well as various items on the Analysis, Objectives, and Develop

tabs for initiatives. The length of time that the Undo button stays on the screen can be

edited using the Deletion Undo Interval In Seconds entry on the Customizations >

Configuration  screen.

202

245
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· Output Options (Print Preview Options)  screen has been added to more screens,

including Cited Resources, Resource Management, TNA / TMD >Training Data / Initiative

Locations > Resources screens, and the Resources screens.

· Library items can be created from the selection screens in the Task Analysis:

o Conditions and Standards .

o KSAs .

o Interventions .

· Initiative changes:

o Assessment Package  can be generated separately from the ILT Package on the

Implement tab.

o Copy functionality has been added, allowing you to create initiatives from any existing

initiative.

o Copy/Paste functionality has been added to the Task Analysis , including Jobs ,

Duties , Tasks , Subtasks , and Steps , as well as EO levels  (e.g., sections can

be copied/moved/duplicated to another TO level , e.g., lesson), and Elements .

o Flags can be removed from resources listed on the TNA / TMD > Training Data >

Resources screen using the Explain Flag  screen.

o Select test items (Essay Question, Fill-in-the-Blank, Multiple Choice, Short Answer,

True/False, and Two-Column Matching) now have the ability to have a file associated

with the stem of the test item, allowing you to display a graphic, other IMM, or another

resource with the stem. 

o Practice test items can output at any Table of Contents level for review or maintenance.

o Select a Sheet to preview an individual sheet output, as well as a Related Materials

report that shows where the selected sheet is cited or used.

o Updates to the Team Members  screen to allow you to edit the team members and

owner at any time, regardless of the State or Status of the initiative.

o User Created  flag  has been added to distinguish between the different user

actions. The User Edited  flag  has not been changed.

o Uncited Resources Report and Unlisted Resources Report have been added to the TNA /

TMD > Training Data > Resources  and Initiative Locations > Resources  screens,

available via the Output Options screen.

· Resource changes:

208
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70

70
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o Resources can be created from the selection screens on the Analysis/Design  tabs, as

well as on the Develop  tab.

o IETM Selection  screen allows for more options to create citations on the Develop tab.

o All Resources reports have been updated for IETMs and IMMs to include any files

names that are associated with a listed resource.

o Unused Resource Management  screen has been added, allowing you to manage all

resources not used or cited in LEAD.

· Login History  screen has been added to allow each user to view their own login

history.

· User management has been updated:

o Reviewer license has been added as an option to allow for View and Generate access to

users with a Reviewer  role.

o Restricted Users have been added to allow you to have users that can only see/access

the initiatives where they are listed on the Team Members screen, either as part of the

team or as the initiative owner. This change includes:

§ A Restricted Access checkbox on the Users screen after the Role drop-down to give a

user restricted access.

§ The addition of the Default Restricted Access for New Users entry on the

Customizations > Configuration  tab, which when active ensures that the restricted

access checkbox is checked automatically for all new user account requests.

§ The addition of a new Restricted Users and their Initiatives report on the Reports

tab that lists all restricted users and their initiatives. 

o Email Admins on User Account Change has been added to the system configuration

settings (AppSettings.xml - those are not editable on editable on the Customizations

tab). Setting this to Yes will email the administrators listed in the System Admin Email

Address entry on the Customizations > Configuration  tab whenever a user account is

edited, made active, deactivated, reactivated, locked-out, or deleted.

For Version 1.8:

· Resource Management  screen has been added, allowing you to manage all resources

used or cited in the initiative.

· Cited Resources  screen has been added, allowing you to manage all resources used or

cited anywhere below a selected table of contents item on the Develop tab.

· System Logs  screen has been added, allowing you to review and export any error

messages that you may have seen to the LEAD support team for review and possible

action.

211
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· Output Options (Print Preview Options) screen has been added, allowing you to select the

delivery methods of the EO levels for the IG, PG, and assessment test items, for a selected

table of contents item on the Develop tab, as well as the Printed Guides and Training

Packages (except for the SCORM Package) on the Implement tab.

· Icons to change the State of the initiative from Active to Inactive and from Inactive to

Active have been updated on the Initiatives > Initiatives screen.

· Business Rules  have been added that can be customized to run when you save a

change in Status or Lock items of the initiative or Export the initiative. You can then review

the results on the Business Rules Results  screen and make most edits straight from that

screen. 

· Comparison File support has been added for IETMs, allowing you to upload a comparison

file even to an approved IETM.

· Performance Test Items have been updated with a new Setup Instructions tab, allowing

you to describe what the instructor or proctor needs to do to set up for the test, and a

new Pass/Fail option for Rubric entries.

· All Test Items have been updated with a new Reference tab, allowing you to list the

resources that form the basis of the test item.

For Version 1.7:

· New test item(s) have been added, along with a new Test Item Delivery field for all test

items to denote whether a test item is an open book or closed book test item.

o Performance Job Sheet - including a grading rubric.

For Version 1.6:

· System Announcements  are now available to read from any screen using the icons in

the header.

· Two-Column Matching test item has been added.

· Storyboard  screen now uses text and resource citations.

· Design Considerations now uses text citations at the Course, Module, TO,

Overview/Summary, and EO levels, as well as for Assessments. 

1.1 Login to LEAD

Use the User ID you were provided (usually first name.last name) and the password you

created when you requested the account to login to LEAD.

Occasionally, when the LEAD software code has been updated, the first user to login after the

update will be asked to update the database. If you are not comfortable doing so, please let a

244

218

17

143
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LEAD administrator or the IT support person for LEAD know, so that they can perform the

update, after backing up the database.

Figure 1: Login Screen

1.1.1   Request an Account

The easiest way to get an account to use LEAD is to select Request an Account on the login

screen for your organization's instance of LEAD. Fill out your information on the screen and

select Submit. LEAD notifies the LEAD administrator of your request automatically. 

1.1.2   Forgot Password

If, at any point, you forget your password, select the Forgot Password? link on the Login

screen and complete the fields below. An automatic email to the LEAD administrator will start

the process of having your password reset. If the information you supplied matches an

existing account, you will receive an email with a temporary password automatically.

Otherwise, you'll have to wait for a LEAD administrator to review your request and send you a

temporary password. Alternatively, you can ask a LEAD administrator to reset your password.
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Figure 2: Reset My Password Screen

1.1.3   Single-Sign-On

When it comes to Single-Sign-On (SSO) in LEAD, the system administrators have two options

on the Configuration  screen: Enabled and Required. In an SSO environment, you will be

logged into LEAD automatically, using your system login, no user ID or password required.

Instead of a User ID consisting of your first name.last name, your User ID contains your

system ID, or for CAC users, your DoD ID. 

1.2 Using LEAD

Some general notes on how to use LEAD:

· Any time you want to get back to the Dashboard, click on LEAD in the top left of the header

bar (the orange bar).

· If you need more room for your content, you can minimize the left-hand menu by clicking

on the three-bar icon  next to LEAD in the header bar. Selecting the three-bar icon

again will maximize the menu again.

· To view any system announcements, select the Announcement icon that displays between

your user name and the help icon in the header bar. Once you've reviewed the

announcements, you can close the pop-up. There are three types of Announcement icons:

o  - there is a new announcement to read.

o  - there are previously read announcements that are still active.

o  - there is a problem with the license for LEAD.

245
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· The area of the screen that displays a tree structure can also be enlarged by clicking and

dragging the bottom right corner of the tree structure window (or frame). You will find re-

sizable tree structures on the following screens:

o  Initiatives > Analysis

o  Initiatives > Design

o  Initiatives > Develop

o Competencies > O*Net

1.3 Help

When you select the Help icon on the top right of the screen, you get a drop-down menu. 

Figure 3: Help Menu

Choose:

· Help to open help for the current screen in a new tab of your browser.

· Overview or User's Manual to open the PDF.

· Contact Us  to provide us with your feedback comments, questions, or requests. If you

are logged in, the form will pre-fill your contact information from your user profile.

· About to review information about LEAD, including the version and build of LEAD. Select

X at the top right of the pop-up to close the pop-up.

19
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· License Agreement to review the license information. Select X at the top right of the pop-

up to close the pop-up.

To review help for a pop-up screen, select Help  next to the X on the pop-up screen. This

will open help for the current pop-up screen in a new tab of your browser.

1.3.1   Contact US

When you select the Contact Us option under the Help drop-down menu, you get a pop-up

screen to provide us with your feedback comments, questions, or requests. If you are logged

in to LEAD, the form will pre-fill your contact information from your user profile.

Figure 4: Contact Us

1.4 [Your User Name]

When you select your user name in the top right of the screen, you can select:

· My Profile  to view and edit your account information and preferences.

· Change Password  to change your password.

· Login History  to view your login history.

· Log Out to close your session in LEAD. Remember to close your browser, too.

20
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Figure 5: [Your User Name] Menu

1.4.1   My Profile

On the My Profile Detail screen, you can review or edit your account information and

preferences. Only a LEAD administrator can edit fields marked "(not user editable)". Select Edit

to make changes to the information. Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

1.4.2   Change Password

On the Change Password screen, you can change your existing password to a new password

to use when you login to LEAD. Enter your current password and your new password twice,

select Save to change the new password, or select Cancel to return to the previous screen.

1.4.3   Login History

On the Login History screen, you can review all the times you have logged into LEAD.



Home > Dashboard

This chapter describes the dashboard that you can use to access your initiatives,
milestones, and assignments in one place.
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2 Home > Dashboard

On the Dashboard screen, you can view your initiatives , any assigned milestones  that

are not in completed status, and a list of your assignments . 

Figure 6: Dashboard

· Selecting any Initiative will open that initiative in the Initiatives > Analysis  screen. 

· Selecting a Milestone will open that milestone in the Home > Milestones  screen. 

· Selecting an Assignment will open that assignment in the Home > Assignments  screen.

2.1 Milestones

The Milestones screen lists your milestones, grouped by initiative. Unlike the Dashboard, this

screen will show all milestones of your initiatives, regardless of Status, for all of your initiatives

(a specific initiative is 'yours' when you are the owner or creator of the initiative, or when

someone has added you as a team member to any initiative.) that have been assigned to you.

You can also create Self-Assigned Milestones, by selecting . 

22 22
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Figure 7: Milestones

From this screen you can select a milestone and then use the icons in each row in the Actions

and Delete columns to:

· View the detailed information of the milestone.

· Edit the milestone information.

· Select Show History   to review the changes made to the milestone, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Delete  a self-assigned milestone - delete initiative-based milestones on the Initiatives

> Analysis > Training Needs Analysis > Milestones  screen (if the TNA is not approved).

Once you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

2.2 Assignments

The Assignments screen lists your assignments, grouped by initiative. Unlike the Dashboard,

this screen will show all your assignments (by initiatives, if related to any initiative), regardless

of Status. 

You can also create self-assigned assignments, by selecting . 

210
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Figure 8: Assignments

From this screen you can select an assignment and then use the icons in each row in the

Actions and Delete columns to:

· View  the detailed information of the assignment.

· Edit  the assignment information.

· Select Show History   to review the changes made to the assignment, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Delete  a self-assigned assignment - delete initiative-based assignments on the

Initiatives > Analysis/Design > Initiative Management > Assignments  screen. Once

you've selected OK to the confirmation message, an Undo button displays on the bottom

left of the screen that allows you to revert the deletion. 

210
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Initiatives

This chapter is all about initiatives (or learning events), how to analyze, design, develop
and implement them.
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3 Initiatives

Initiatives are the main reason for using LEAD. An initiative is a learning event, like a course or

workshop, which is created to close an identified performance gap. LEAD supports the

development of several types of learning events (see Scope  below). LEAD uses the ADDIE

(Analysis, Design, Develop, Implement, and Evaluate) instructional design process to develop

and maintain initiatives. The main tabs under Initiatives mirror that process.

Figure 9: Initiatives > Initiatives

Unlike the Dashboard, this screen will show all the initiatives in LEAD, depending on your Filter

selection, as well as your role and level of access, of course. You can use Find  to look for a

specific initiative. 

· Add a  initiative to the existing list by selecting + New.

· Upload  a LEAD initiative.

· Search  for an initiative.

When you select any initiative on this screen you can select one of the subtabs under the

Initiatives tree on the left to open that initiative in that subtab, or you can:

· Create a New Version  of an approved initiative.

· Change the State of a selected initiative. 

26
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· Export  the selected initiative regardless of State or Status to move it to another LEAD

instance or to archive the initiative and store the export file that is generated, and then

delete the initiative in LEAD.

· Make a Copy  of a selected initiative.

· Select Explain Flag   to review the reasons the initiative has been flagged.

· Lock  the initiative to prevent any user from making changes without first unlocking 

the initiative.

· View   the initiative versions.

· View  the detailed information of the initiative.

· Approve the initiative by selecting View  and then Approve. 

· Comment on the initiative by selecting View  and then Comment  .

· Edit  the initiative information.

· Select Show History   to review the changes made to the initiative information,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

· Delete  an archived initiative.

You can click on the column headers of each table to sort the entries by that column. Clicking

on a column header again will reverse the sort. Clicking on the column header a third time will

remove the sort. Small arrows in the column header let you know which way the data is

currently sorted.

3.1 Work with Initiatives

On the Initiatives > Initiatives screen, you can: 

· Add a  initiative to the existing list by selecting + New.

· Create a New Version  of an approved initiative.

· Change the State of a selected initiative. 

· Copy  an initiative.

· View  the detailed information of the initiative.

· Approve the initiative by selecting View  and then Approve. 

220
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· Edit  the initiative information.

· Delete  an archived initiative.

3.2 Analysis

On the Analysis tab, you can manage your initiative , complete the Training Needs Analysis

 and the Task Analysis . You can also generate the analysis documents under the

Documents  folder. 

Figure 10: Initiatives > Analysis 

On this screen:

· Use the tree structure to expand out the four main folders and get to the data you need

to work with.

· To make more room to see items in the tree structure, click and drag the bottom right

corner of the tree window (or frame). 

· To make even more room, click on the three-bar icon  next to LEAD in the header

bar to minimize the main menu to show only the icons. To see all of the menu items

again, click on the three-bar icon again.

· Select a folder and then Expand  to open up the folders beneath the selected folder:

o Selecting the Initiative Management  folder and then Expand opens up all the sub-

folders. 

29
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o Selecting the Training Needs Analysis  folder and then Expand opens up all the sub-

folders, including those under Training Data and Initiative Locations. Selecting Training

Data or a specific Initiative Location and then Expand opens just that folder.

o Selecting the Task Analysis  folder and then Expand opens up the skill hierarchy

down to the step level. Selecting any skill and then Expand opens just that skill down to

the step level.

o Selecting the Documents  folder and then Expand opens up all the available output

options.

3.2.1   Initiative Management

When you click on the Initiative Management folder, you can view information about the

initiative. You can access the Initiative Management folder from both the Initiatives > Analysis

and the Initiatives > Design screens.

Figure 11: Analysis/Design > Initiative Management

3.2.1.1   Team Members
The Team Members screen lists the users currently assigned to the initiative. You can access

this folder from both the Initiatives > Analysis > Initiative Management and the Initiatives >

Design > Initiative Management screens. 
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Figure 12: Initiative Management > Team Members

3.2.1.2   Assignments

The Assignments screen lists all the assignments that have been created for the initiative. You

can access this screen from both the Initiatives > Analysis > Initiative Management and the

Initiatives > Design > Initiative Management screens. 

Figure 13: Initiative Management > Assignments

On this screen you can:

· Add a  assignment to the existing list by selecting + New.
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· Select an assignment and:

o View  the detailed information of the assignment.

o Edit  the assignment information.

o Select Show History   to review the changes made to the assignment, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  an assignment. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion. 

3.2.1.3   Resource Management
On the Resource Management screen, you can review, view, and update any resources that

are cited anywhere in the initiative. This includes resources cited in the:

· TNA or TMD Resources screen under the Training Data folder, or for a specific Initiative

Location.

· Task Analysis for a Task, Subtask, or Step.

· And on the Develop tab:

o Sub-Elements: Page / Paragraph / Caution / Note / Warning.

o Sheets.

o Certain Test Items.

o Storyboard.

o Test Instructions.
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Figure 14: Initiative Management > Resource Management

On this screen:

· Select View Comments   to view, edit, and add to the comments about the listed

resources.  

· Use the Type drop-down to limit the list of resources to a specific sub-category, as set up

on Customizations  screens. 

· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. Select  to clear the search term and view all items

again. 

· Select the Show Out-of-Date Resources Separately check box to see those outdated

resources at the top of the list grouped under: Items to Update.

· Preview  a spreadsheet listing All cited resources, or the Missing File Resources

spreadsheet listing all IETMs with a Comparison File that is listed with the IETM but cannot

be found on the server and all IMMs with an Associated File that is listed with the IMM

but cannot be found on the server.

· View the different versions of a resource by clicking on the arrow  in the first column.

· Select a resource and then Preview  to generate the: 

218
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o Related Materials Report that lists every place within the initiative where the selected

resource is cited or used.

o Impact Report that lists every place within the initiative where any previous version of

the selected resource is cited or used.

o All Resources spreadsheet listing all cited resources.

o Missing File Resources spreadsheet listing all IETMs with a Comparison File that is listed

with the IETM but cannot be found on the server and all IMMs with an Associated File

that is listed with the IMM but cannot be found on the server.

· Select a resource and then: 

o Update  to the latest version of a resource.

o View  the resource information.

o Edit  the resource information if the resource is not approved.

Note: This will update the resource everywhere it is used in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.

3.2.2   Training Needs Analysis

The Training Needs Analysis (TNA) is the first step in any initiative, which seeks to determine

whether a learning event is the right answer to close a performance gap on the job. That is,

do you have new equipment that you need to train people on, or is there a gap between the

performance standard and the actual performance you need to close, or do you need to

develop a learning event for another reason?

In the folders/fields under the TNA, you can capture the reasons for the TNA under

Justification, as well as information about the initiative, the Target Audience, and some overall

training data. The TNA shares some information with the Training Management Document

 (as shown in the title for each area in this document) until the TNA is approved.
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Figure 15: Analysis > Training Needs Analysis

On this screen, you can:

· View the information by selecting a Training Needs Analysis folder.

· Edit the information about the Training Needs Analysis and initiative.

· Approve the Training Needs Analysis.

· Create additional TNAs  to capture changes that occurred after the TNA was approved.

You can create a new TNA, even if the initiative has not been approved. 

Note: You can only have one unapproved Modification or Revision TNA and one

unapproved Cancellation TNA at a time. You can have as many approved TNAs of any

TNA Type as needed.

· Preview  the selected Training Needs Analysis.

Note: If a resource is missing in the output of the TNA or TMD, but is listed on the

Training Data > Resources  or Initiative Locations > [Selected Initiative Location] >

Resources  screen, check the Required quantity. If the Required quantity is set to 0, it

will not output in the TNA or TMD. 

· Delete  a Training Needs Analysis, if it is no longer needed. You cannot delete the

primary TNA in the initiative.

Note: Once you've selected OK to the confirmation message, the Training Needs

Analysis Deletion screen displays. Enter the title of the TNA to confirm the deletion. 
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Note: You can copy and paste the title from the screen into the field to make it easier on

yourself. If you only enter a partial title, the TNA will not be deleted, and the Training

Needs Analysis Deletion screen stays open, ready for you to try again.

· Select Explain Flag   to review the reasons the Training Needs Analysis has been

flagged.

· Lock  the Training Needs Analysis to prevent edits from taking place.

· Unlock  a locked Training Needs Analysis to allow edits to take place again.

· Expand  all sub-folders at once, including those under Training Data and Initiative

Locations, to capture the information required for the TNA.

· Select View Comments   to view, edit, and add to the comments about the selected

TNA.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.2.1   Justification (TNA Only)
On the Justification screen, you can capture the reasons for the development of a learning

event in the following fields:

· Reference(s)

· Cost / Benefit Analysis

· Changes from Previous Version

· Impact If Not Approved
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Figure 16: TNA > Justification

You can:

· View the information. 

· Edit the information (Editor Help) . Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments for each tab.  

3.2.2.2   Initiative Overview (TNA and TMD)
On the Initiative Overview screen, you can enter a description, or overview, of the proposed

learning event that will close the performance gap.
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Figure 17:  TNA/TMD > Initiative Overview

You can:

· View the information by clicking on the Initiative Overview folder.

· Edit the information (Editor Help) . Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.3   Milestones (TNA Only)
On the Milestones screen, you can work with the default milestones for the initiative. 
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Figure 18: TNA > Milestones

On this screen, you can:

· Select View Comments   to view, edit, and add to the comments.  

· Add a  milestones by selecting + New. 

You can select a milestone and then use the icons in each row in the Actions and Delete

columns to:

· View the detailed information of the milestone.

· Edit  the milestone information.

· Select Show History   to review the changes made to the milestone, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Delete  the milestone. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion.

3.2.2.4   Safety Risks and Hazardous Materials (TNA Only)
On the Safety Risks and Hazardous Materials screen, you can document any safety risks and

hazardous materials that might be met or used during the delivery of the learning event.
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Figure 19: TNA > Safety Risks and Hazardous Materials

You can:

· View the information by clicking on the Safety Risks and Hazardous Materials folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.5   Target Audience (TNA and TMD)
On the Target Audience screen, you can describe who the learning event is for and how many

people are in the target audience.
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Figure 20: TNA/TMD > Target Audience

You can:

· View the information by clicking on the Target Audience folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.6   Qualification Earned (TNA and TMD)
On the Qualification Earned screen, you can list any qualification(s) or certification(s) that a

participant earns by completing the learning event.

212

218

210



41

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

Figure 21: TNA/TMD > Qualification Earned

You can:

· View the information by clicking on the Qualification Earned folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.7   Associated Learning Events (TNA and TMD)

On the Associated Learning Events screen, you can list any associated learning events to the

current initiative, including:

· Prerequisite learning events that participants must or should complete before they can

attend this learning event or initiative.

· Equivalent learning events that participants can complete instead of this learning event or

initiative.

· Follow-on learning events that participants can or should complete after they completed

this learning event or initiative.
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Figure 22: TNA/TMD > Associated Learning Events

You can:

· View the information by clicking on the Associated Learning Events folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.8   Training Data (TNA and TMD)
The Training Data screen lists the current and planned data for the learning event, including

expected length, number of hours, minimum and maximum capacities, number of convenings

(how often the learning event will be delivered), and the expected throughput of participants.

All data from the Training Data screen and sub-folders will be copied to any newly added

Initiative Location . 
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Figure 23: TNA/TMD > Training Data

You can:

· View the training data. 

· Edit the training data. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made. 

· Select Explain Flag   to review the reasons the Training Data folder has been

flagged.

· Expand  all the folders underneath Training Data.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

In the screens underneath the Training Data screen, you can enter information about the:

· Schedule  for delivering the learning event (in the TMD only).

· Facilities  needed to deliver the learning event.

· Funding  needed to develop and/or deliver the learning event.

· Personnel  needed to deliver the learning event.
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· Resources  needed to deliver the learning event.

3.2.2.8.1   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. 

Figure 24: TNA/TMD > Training Data > Facilities

On this screen you can:

· View the facility information by selecting Facilities under the Training Data folder.

· Edit the information. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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3.2.2.8.2   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Training Data >

Funding screen, so if you changed the year by mistake you can return to the previous

selected year without any loss of data. The fiscal year used in LEAD is whatever fiscal year

your organization uses. 

Figure 25: TNA/TMD > Training Data > Funding

On the Funding screen you can:

· View the funding information by selecting Funding under the Training Data folder.

· Edit the information. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made.

o Add a  funding or expense row to the table.

o Delete a  funding or expense row from the table.
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· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.8.3   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. In LEAD, you can list the personnel requirements

for four types of personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.
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Figure 26: TNA/TMD > Training Data > Personnel

On this screen you can:

· View the personnel information by selecting Personnel under the Training Data folder.

· Edit the information. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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3.2.2.8.4   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during

development. 

Figure 27: TNA/TMD > Training Data > Resources

On this screen you can:

· Select Explain Flag   to review the reasons the list of resources has been flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Select Preview  to generate the: 

o Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas in the initiative. On the Output Options screen

that pops-up, you can choose to check for resources not cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but listed in the Resources table. 
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o Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas in the initiative and that are not in the Resources table. On the Output Options

screen that pops-up, you can choose to check for resources cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but not listed in the Resources table. 

· Select a resource and then: 

o Preview  to generate the:

§ Related Materials Report that lists every place within the initiative where the selected

resource is cited or used.

§ Impact Report that lists every place within the initiative where any previous version of

the selected IETM is cited or used.

§ Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas in the initiative. On the Output Options screen

that pops-up, you can choose to check for resources not cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but listed in the Resources table. 

§ Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas in the initiative and that are not in the Resources table. On the Output Options

screen that pops-up, you can choose to check for resources cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but not listed in the Resources table. 

o Update  to the latest version of a resource.

o View the different versions of a resource by clicking on the arrow  in the first column.

o Select Explain Flag   to review the reasons the selected resource has been

flagged.

o View the selected resource.

· Edit the resource list. 

3.2.2.9   Initiative Locations (TNA and TMD)
On the Initiative Locations screen, you can select the initiative locations where training will

take place. All data from the Training Data screen and sub-folders will be copied to a newly

selected initiative location. 
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Figure 28: TNA/TMD > Initiative Locations

On this screen you can:

· Add a  initiative location to the TNA or TMD. Initiative Locations are created on the

Admin > Locations  screen. 

· Select Explain Flag   to review the reasons the Initiative Locations folder has been

flagged.

· Expand  all the sub-folders of all initiative locations. 

3.2.2.9.1   [Selected] Initiative Location (TNA and TMD)

The [Selected Initiative Location] screen lists the current and planned data for the initiative

location, including expected length, number of hours, minimum and maximum capacities,

number of convenings (how often the learning event will be delivered), and the expected

throughput of participants at that initiative location. 
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 Figure 29: TNA/TMD > [Selected] Initiative Location

On this screen, you can:

· View the initiative location's information.

· Edit the initiative location's information. Once you're finished making the necessary

changes, select Save to keep the changes, or select Cancel without saving any updates

you made.

· Delete  the selected initiative location from the initiative. Once you've selected OK to

the confirmation message, an Undo button displays on the bottom left of the screen that

allows you to revert the deletion.

· Select Explain Flag   to review the reasons the initiative location has been flagged.

· Expand  all the folders underneath a selected initiative location.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the initiative location,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

In the screens underneath the selected initiative location, you can enter information about

the:
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· Schedule  for delivering the learning event (in the TMD only).

· Facilities  needed to deliver the learning event at that initiative location.

· Funding  needed to deliver the learning event at that initiative location.

· Personnel  needed to deliver the learning event at that initiative location.

· Resources  needed to deliver the learning event at that initiative location.

3.2.2.9.1.1   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. When you first add a new Initiative Location0, the data is copied from the Training

Data > Facilities screen for you to edit for the specific initiative location. 

Figure 30: TNA/TMD > Initiative Location > Facilities

On this screen you can:

· View the facility information by selecting Facilities under the [Selected Initiative Location]

> Initiative Locations folder.
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· Edit the information copied from the Training Data > Facilities screen. Once you're

finished making the necessary changes, select Save to keep the changes, or select Cancel

without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.9.1.2   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Initiative Locations >

[Selected Initiative Location] >Funding screen, so if you changed the year by mistake you can

return to the previous selected year without any loss of data. The fiscal year used in LEAD is

whatever fiscal year your organization uses. When you first add a new Initiative Location, the

data is copied from the Training Data > Funding screen for you to edit for the specific

initiative location. 
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Figure 31: TNA/TMD > Initiative Location > Funding

On the Funding screen you can:

· View the funding information by selecting Funding under the selected Initiative Location.

· Edit the information copied from the Training Data > Funding screen. Once you're

finished making the necessary changes, select Save to keep the changes, or select Cancel

without saving any updates you made.

o Add a  funding or expense row to the table.

o Delete a  funding or expense row from the table.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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3.2.2.9.1.3   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. When you first add a new Initiative Location, the

data is copied from the Training Data > Personnel screen for you to edit for the specific

initiative location. In LEAD, you can list the personnel requirements for four types of

personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.
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Figure 32: TNA/TMD > Initiative Location > Personnel

On this screen you can:

· View the personnel information by selecting Personnel under the selected Initiative

Location.

· Edit the information copied from the Training Data > Personnel screen. Once you're

finished making the necessary changes, select Save to keep the changes, or select Cancel

without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  
218
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· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.2.2.9.1.4   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during development.

When you first add a new Initiative Location, the data is copied from the Training Data >

Resources screen for you to edit for the specific initiative location. 

Figure 33: TNA/TMD > Initiative Location > Resources

On this screen you can:

· Select Explain Flag  to review the reasons the list of resources has been flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Select Preview  to generate the: 

o Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas for the selected initiative location. On the
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Output Options screen that pops-up, you can choose to check for resources not cited

within storyboards, design considerations, test instructions, and skills, along with the

default elements, sheets, practice and assessment test items (including the test item’s

references area), but listed in the Resources table. 

o Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas for the selected initiative location. and that are not in the Resources table. On the

Output Options screen that pops-up, you can choose to check for resources cited within

storyboards, design considerations, test instructions, and skills, along with the default

elements, sheets, practice and assessment test items (including the test item’s

references area), but not listed in the Resources table. 

· Select a resource and then: 

o Preview  to generate the:

§ Related Materials Report that lists every place within the initiative where the selected

resource is cited or used.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected IETM is cited or used.

§ Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas for the selected initiative location. On the

Output Options screen that pops-up, you can choose to check for resources not cited

within storyboards, design considerations, test instructions, and skills, along with the

default elements, sheets, practice and assessment test items (including the test item’s

references area), but listed in the Resources table.  

§ Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas for the selected initiative location. and that are not in the Resources table. On

the Output Options screen that pops-up, you can choose to check for resources cited

within storyboards, design considerations, test instructions, and skills, along with the

default elements, sheets, practice and assessment test items (including the test item’s

references area), but not listed in the Resources table. 

o View the different versions of a resource by clicking on the arrow  in the first column.

o Select Explain Flag  to review the reasons the selected resource has been flagged.

o View  a selected resource. 

· Edit the resource list. 
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3.2.3   Task Analysis

The Task Analysis area captures the job, task analysis information of the tasks that will be

trained to during the learning event. The skill hierarchy available to capture this information

includes: 

· Job  - based on the selected competency data; one or more jobs will be created when

you first select from the competencies to include in the task analysis. You can also create

one or more jobs as needed.

o Duty  - is a grouping of tasks. One duty is automatically created for every job created

from a competency. You can add duties to help you manage the tasks.

§ Task  - is a specific work behavior, with a clear beginning and end point, which can

be observed and measured. One task is created for each competency task,

knowledge, skill, or ability that is selected. You can have multiple tasks created from

the same competency selection. If no competency task, knowledge, skill, or ability is

selected, you can create as many tasks as needed. You can break down a task into

two or more subtasks, if needed.

· Subtask  - is a major part of a tasks. You can break down a subtask into two or

more steps, if needed.

o Step  - is a major part of a subtask. A step is the most specific form of behavior

and the smallest part defined in the task analysis.

Figure 34: Analysis > Task Analysis
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The skill hierarchy you develop in the task analysis is approved once the initiative is approved.

This allows you to make changes as needed, while you progress with your initiative. You have

the following actions available to you:

· View the information by clicking on the Task Analysis folder.

· Add  jobs not linked to competencies. 

· Preview  the skill hierarchy.

· Paste: Duplicate  a copied job (and any skills under that job). The Status of the copied

job will be updated to Incomplete when it is pasted. You can use the Duplicate option to

make copies of the job in other initiatives.

Note: You Copy  Jobs , Duties , Tasks , Subtasks , and Steps  by selecting

them and then going up one level in the hierarchy to Paste the copied skill. You cannot

paste a copied skill when the selected skill is Locked.

· Select Explain Flag   to review the reasons the Task Analysis has been flagged.

· Use Create From Competencies  to select competencies and create the first draft of

the skill hierarchy. You can continue to build your skill hierarchy from competencies

throughout your analysis.

· Lock   the Task Analysis to prevent edits from taking place.

· Unlock   a locked Task Analysis to allow edits to take place again.

· Expand  all sub-folders at once down to the step level. Selecting any skill and then

Expand opens just that skill down to the step level.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.3.1   Job
LEAD creates one or more jobs automatically based on the selected competencies. You can

rename the job title and add a job description, if desired. To add jobs manually, go to the

Task Analysis folder and select . 
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Figure 35: Task Analysis > Job

On the Job screen you can:

· View the information.

· Edit the information.

· Add  duty.

· Resequence   the duties below the job folder in the tree structure.

· Preview  the skill hierarchy.

· Copy  the selected job into memory. 

Note: Remember to go up one level in the hierarchy to the Task Analysis before trying to

select Paste.

· Paste: Duplicate/Move  a copied duty (and any skills under that duty) to the selected

job.

Note: You cannot Paste a copied duty when the selected job is Locked.

o Duplicate will create a copy of the duty. The Status of the copied duty will be updated

to Incomplete when it is pasted. You can use the Duplicate option to make copies of the

duty in other initiatives.

o Move will move the duty under the selected job. When you move a duty, the Status of

the moved duty does not change. You cannot move a duty to another initiative.

209
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· Delete  the selected job (including all duties, tasks, subtasks, and steps under the job).

Once you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion.

· Select Explain Flag   to review the reasons the job has been flagged.

· Use Create From Competencies  to select competencies from the selected job (see the

"This item was created from Competencies" for the currently selected job) to add to your

skill hierarchy. If you haven't selected anything from competencies, this will allow you to

choose from all available competencies data.

· Lock  the job to prevent edits from taking place.

· Unlock  a locked job to allow edits to take place again.

· Expand  all sub-folders at once down to the step level. 

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.3.2   Duty
LEAD creates a new duty automatically when you first select from the competencies data.

Duties allow you to group tasks. You can rename the automatically created duty to give it a

more user-friendly name and you can add additional duties (from the Job folder) as needed. 
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Figure 36: Task Analysis > Duty

On the Duty screen you can:

· View the information by clicking on the Duty folder.

· Edit the information.

· Add  tasks that are not selected from the competencies data.

· Resequence   the tasks below the Duty folder in the tree structure.

· Preview  the skill hierarchy.

· Copy  the selected duty into memory. 

Note: Remember to go up one level in the hierarchy to a job before trying to select

Paste.

· Paste: Duplicate/Move  a copied task (and any skills under that task) to the selected

duty.

Note: You cannot Paste a copied task when the selected duty is Locked.

o Duplicate will create a copy of the task. The Status of the copied task will be updated to

Incomplete when it is pasted. You can use the Duplicate option to make copies of the

task in other initiatives.

o Move will move the task under the selected duty. When you move a task, the Status of

the moved task does not change. You cannot move a task to another initiative.
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· Delete  the selected duty (including all tasks, subtasks, and steps under the duty). Once

you've selected OK to the confirmation message, an Undo button displays on the bottom

left of the screen that allows you to revert the deletion.

· Select Explain Flag   to review the reasons the duty has been flagged.

· Use Create From Competencies  to select competencies to add to your skill hierarchy.

· Lock  the duty to prevent edits from taking place.

· Unlock  a locked duty to allow edits to take place again.

· Expand  all sub-folders at once down to the step level. 

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.3.3   Task
LEAD creates tasks automatically when you first select tasks, knowledge, skills, or abilities from

the competencies data. You can also create tasks that are not linked to competencies data. A

task is a specific work behavior, with a clear beginning and end point, that can be observed

and measured. You can have multiple tasks based on the same competency selection. You

can break down a task into two or more subtasks, as needed. You can (and should) edit the

task as needed. The Task screen has multiple tabs that you can minimize to see just the

information you are working on:

· Task - for the main information about the task.

· Task Attributes - to list the conditions and standards under which the task is performed

on the job, along with any resources that someone would have available when they do

the task on the job. You can easily add conditions and standards from the

Condition/Standard Selection  screen and resources from the Resource Selection

screen.

· Training Task Analysis - a list of different areas with answers that will help you separate

the tasks that NEED to be trained from those that COULD be trained. The questions will

also help you determine the amount of time to spend on training each task (if everyone

performs the task, and it is hard to learn, then you need more time to train for that task; a

task that few people perform, and that is easy to learn and be proficient at will need less

time in training, if it is trained at all). The answers to each area can be customized for your

organization under Customizations > Lists > Task Analysis Content .
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· KSAs - the supporting knowledge, skill, and ability statements that support the task,

selected from the KSA entries on the Library tab. You can easily add KSA entries from the

KSA Selection  screen. 

· Interventions - any existing interventions that support the task, selected from the

Intervention entries on the Library tab. You can easily add interventions entries from the

Intervention Selection  screen. 

Figure 37: Task Analysis > Task

On this screen you can:

· View the information by clicking on the Task folder.

· Edit the information.

· Add a  subtask, based on the selected task (and competency).

· Resequence   the subtasks below the task folder in the tree structure.

· Preview  the skill hierarchy.
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· Copy  the selected task into memory. 

Note: Remember to go up one level in the hierarchy to a duty before trying to select

Paste.

· Paste: Duplicate/Move  a copied subtask (and any steps under that subtask) to the

selected task.

Note: You cannot Paste a copied subtask when the selected task is Locked.

o Duplicate will create a copy of the subtask. The Status of the copied subtask will be

updated to Incomplete when it is pasted. You can use the Duplicate option to make

copies of the subtask in other initiatives.

o Move will move the subtask under the selected task. When you move a subtask, the

Status of the moved subtask does not change. You cannot move a subtask to another

initiative.

· Delete  the selected task (including all subtasks, and steps under the task). Once you've

selected OK to the confirmation message, an Undo button displays on the bottom left of

the screen that allows you to revert the deletion. 

· Select Explain Flag   to review the reasons the task has been flagged.

· Lock  the task to prevent edits from taking place.

· Unlock  a locked task to allow edits to take place again.

· Expand  all sub-folders at once down to the step level. 

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.3.4   Subtask
Subtasks are major parts of a task. Depending on the competency statement, you may want

to create subtasks to break up the main task. You can also break down a subtask into two or

more steps, if needed. The Subtask screen has three tabs that you can minimize to see just

the information you are working on:

· Subtask - for the main information about the subtask.

· Subtask Attributes - to list the conditions and standards under which the subtask is

performed on the job, along with any resources that someone would have available when

they do the subtask on the job.
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· Interventions - any existing interventions that support the subtask, selected from the

Interventions in LEAD.

Figure 38: Task Analysis > Subtask

On this screen you can:

· View the information by clicking on the Subtask folder.

· Edit the information.

· Add a  step, based on the selected subtask (and competency).

· Resequence   the steps below the Subtask folder in the tree structure.

· Preview  the skill hierarchy.

· Copy  the selected subtask into memory. 

Note: Remember to go up one level in the hierarchy to a task before trying to select

Paste.

· Paste: Duplicate/Move  a copied step to the selected subtask.

Note: You cannot Paste a copied step when the selected subtask is Locked.
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o Duplicate will create a copy of the step. The Status of the copied step will be updated

to Incomplete when it is pasted. You can use the Duplicate option to make copies of the

step in other initiatives.

o Move will move the step under the selected subtask. When you move a step, the Status

of the moved step does not change. You cannot move a step to another initiative.

· Delete  the selected subtask (including all steps under the subtask). Once you've

selected OK to the confirmation message, an Undo button displays on the bottom left of

the screen that allows you to revert the deletion. 

· Explain Flag   to review the reasons the subtask has been flagged.

· Lock  the subtask to prevent edits from taking place.

· Unlock  a locked subtask to allow edits to take place again.

· Expand  to see all steps.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.3.5   Step
A step is a major part of a subtask and the most specific form of behavior, and the smallest

component defined in the task analysis. The Step screen has three tabs that you can minimize

to see just the information you are working on:

· Step - for the main information about the step.

· Step Attributes - to list the conditions and standards under which the step is performed

on the job, along with any resources that someone would have available when they do

the step on the job.

· Interventions - any existing interventions that support the task, selected from the

Interventions in LEAD.
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Figure 39: Task Analysis > Step

On this screen you can:

· View the information by clicking on the Step folder.

· Edit the information.

· Preview  the skill hierarchy.

· Copy  the selected step into memory.

Note: Remember to go up one level in the hierarchy to a subtask before trying to select

Paste.

· Delete  the selected step. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion.

· Select Explain Flag   to review the reasons the step has been flagged.

· Lock  the job to prevent edits from taking place.

· Unlock  a locked job to allow edits to take place again.
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· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

3.2.3.6   Adding Conditions, Standards, and Resources

Tasks, subtasks, and steps allow you to add the:

· Conditions under which the skill is performed.

· Standards to which the skill should be performed.

· Resources that are needed or support the skill when it is being performed.

3.2.3.7   Adding Knowledge, Skills, and Abilities

Tasks allow you to list the:

· Knowledge that is needed to perform the task. 

· Skills that are needed to perform the task. 

· Abilities that are needed to perform the task.

3.2.3.8   Adding Interventions

Tasks, subtasks, and steps allow you to list any existing interventions that support the skill.

3.2.3.9   Selecting from Competencies

There are two ways to select a Competency for a task in LEAD: 

· If you want to add new tasks that are linked to the O*Net Competencies , select Create

From Competencies  on the Task Analysis, Job, or Duty folders. This allows you to

make multiple selections to create new tasks for your skill hierarchy. 

· If you need to change the selected competency for a task (and its subtasks and steps),

first select Edit to edit the task, then select Edit under the "This item was created from

Competencies." text. This allows you to change or select a competency the task is based

on.

Either way will open the Competency Selection screen which shows the O*Net tree structure.

Select a folder and then Expand  to open up the folders up to three levels at a time:

· Selecting the O*Net folder and then Expand opens up to the Broad Jobs folders.
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· Selecting a Major Occupation folder and then Expand opens up to the Jobs folders under

the selected Major Occupation folder.

· Selecting a Minor Occupation folder and then Expand opens up to the Tasks of all Jobs

under the selected Minor Occupation folder.

· Selecting a Broad Job folder and then Expand opens up all entries of each Job, including

the Tasks, Knowledge, Skills, and Abilities under the selected Broad Jobs folder.

Figure 40: Task Analysis > Competency Selection Screen

Select the tasks, knowledge, skills, or abilities entry or entries you need by selecting the

checkbox(es) and then selecting Save.
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3.2.4   Documents

Figure 41: Analysis > Documents

Expand  the Documents folder to see the available options:

· Training Needs Analysis - a PDF document of the information contained in the Training

Needs Analysis folders, this will always output the current TNA, whether that's the first

TNA or the latest Modification TNA. You can choose whether to include any comments on

the Output Options screen.

· Skill Hierarchy - a PDF document of the skill structure that is contained in the Task

Analysis folders.

Select the document you wish to create in the tree structure. Then select Preview  to

generate the document.

3.3 Objectives

On the Objectives tab, you can build the learning objectives based on your completed task

analysis. LEAD will automatically generate the learning objectives by using the verb, skill text,

and any selected conditions and standards from the task, subtask, and step information you

entered for the task analysis. A task becomes a Terminal Objective (TO), while subtasks and

steps become Enabling Objectives (EOs). From this baseline, you can change the objective

type from Terminal to Enabling or vice versa. You can also change the Skill Basis the objective
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is based on (i.e., the task, subtask, or step), where an objective can be based on more than

one skill). An objective can also be based on the Knowledge, Skills, and Abilities (KSAs) entries

of a task (and yes, you can select more than one KSA for an objective).

Figure 42: Initiatives > Objectives

In the Design tab > Curriculum Development folder you will build out the table of contents

structure. The Scope of the initiative determines what each level in the table of contents

structure is named. In that table of contents structure, the EO is linked to the lowest level (e.g.,

section), while a TO is linked one level higher, i.e., to the second lowest level (e.g., lesson). 

Note: Each TO must have at least one EO associated (underneath) with it. If the scope of your

initiative is set to: Lesson, Distance Learning Lesson, Mentoring, or Workshop, you can have

only ONE TO. You can have as many EOs as you would like. All other initiative scopes allow

you to have as many TOs and EOs as you can come up with (and as you need).

In general, learning objectives should state what the participant will be able to do after they

complete a piece of learning content, using the construct of:

· Condition, under which the participant will be required to perform the desired behavior -

this could be a list of things they are allowed to use, or not allowed to use, or it could be

a location or time of day.
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· Behavior, what the participant will be required to be able to do.

· Standard, to which the participant should perform the behavior - this should be

measurable! That is why LEAD does not come with the verbs "Understand" or "Know" as

standard, as those are not measurable.

However, this will depend on your organization's standards for learning objectives. Some

organizations want very specific learning objectives, while others only want to see those

conditions and standards that are different from the expected conditions (e.g., in a classroom)

and standards (e.g., without errors).

Once you've added the automatically generated objectives using Add Missing , you can: 

· View  the objective.

· Edit  the objective, including the:

o Objective text.

o Objective type (TO or EO).

o Skill basis of the objective; an objective can be based on one or more skills or KSA

entries from the task analysis.

o Assessment information, including the learning domain, passing criteria, and criticality

index information, and for EOs also test item type and number of test items.

· Select View Comments   to view, edit, and add to the comments for that objective.  

· Select Show History   to review the changes made to the objective, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

· Delete  the selected objective, as long as it is not linked/used in the Curriculum

Development folder on the Design tab. Once you've selected OK to the confirmation

message, an Undo button displays on the bottom left of the screen that allows you to

revert the deletion. 

· Add a  objective, based on one or more skills or KSA entries from the task analysis.

· Resequence   the objectives in the teaching or learning order.

· Export  the Objective Assessment Information spreadsheet that is generated to list all

objectives, along with the assessment information that is gathered for the objective.

· Add Missing  to add objectives, after amending the task analysis on the Analysis tab.

· Select Explain Flag   to review the reasons the objective has been flagged.

· Lock   the objective to prevent edits from taking place.
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· Unlock   a locked objective to allow edits to take place again.

· Select View Comments   to view, edit, and add to the comments for all objectives on

the screen.  

3.3.1   Viewing or Editing Terminal Objectives

When you view or edit a Terminal Objective (TO), you see a tabbed screen. When editing,

you can make the desired changes to the TO to match your needs. There are several

tabs/areas on this screen:

· General  - the text of the objective, version, and type of objective.

· Skill Basis  - the skill basis of the objective.

· Assessment  - information about how the objective should be assessed.

3.3.2   Viewing or Editing Enabling Objectives

When you view or edit an Enabling Objective (EO), you see a tabbed screen. When editing,

you can make the desired changes to the EO to match your needs. There are several

tabs/areas on this screen:

· General  - the text of the objective, version, and type of objective.

· Skill Basis  - the skill basis of the objective.

· Assessment  - information about how the objective should be assessed.

3.3.3   Selecting the Skill Basis

On the Skill Basis Selection screen, you can select the skill basis for a learning objective. An

objective can be based on one or more tasks, subtasks, or steps. An objective can also be

based on one or more of the knowledge, skill, or ability entries that were selected for a task

in the task analysis.

3.4 Design

On the Design tab, you can manage your initiative, complete the Training Management

Document , lay out the table of contents for your Curriculum Development  initiative,

including detailed design information, and develop the Testing Plan . You can also

generate the design documents under the Documents  folder. 

72

218

75

75

75

75

75

75

81 108

120

123



76

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

Figure 43: Initiatives > Design

On this screen:

· Use the tree structure to expand out the five main folders and get to the data you need

to work with.

· To make more room to see items in the tree structure, click and drag the bottom right

corner of the tree window (or frame). 

· To make even more room, click on the three-bar icon  next to LEAD in the header

bar to minimize the main menu to show only the icons. To see all of the menu items

again, click on the three-bar icon again.

· Select a folder and then Expand  to open up the folders beneath the selected folder:

o Selecting the Initiative Management folder and then Expand opens up all the sub-

folders. 

o Selecting the Training Management Document folder and then Expand opens up all the

sub-folders, including those under Training Data and Initiative Locations. Selecting

Training Data or a specific Initiative Location and then Expand opens just that folder.

o Selecting the Curriculum Development folder and then Expand opens up the table of

contents structure of your initiative. Selecting any table of contents item and then

Expand opens just that table of contents down to the lowest level.

o Selecting the Testing Plan folder and then Expand opens it up to the lowest folder.
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o Selecting the Documents folder and then Expand opens up all the available output

options.

3.4.1   Initiative Management

When you click on the Initiative Management folder, you can view information about the

initiative. You can access the Initiative Management folder from both the Initiatives > Analysis

and the Initiatives > Design screens.

Figure 11: Analysis/Design > Initiative Management

3.4.1.1   Team Members
The Team Members screen lists the users currently assigned to the initiative. You can access

this folder from both the Initiatives > Analysis > Initiative Management and the Initiatives >

Design > Initiative Management screens. 
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Figure 12: Initiative Management > Team Members

3.4.1.2   Assignments

The Assignments screen lists all the assignments that have been created for the initiative. You

can access this screen from both the Initiatives > Analysis > Initiative Management and the

Initiatives > Design > Initiative Management screens. 

Figure 13: Initiative Management > Assignments

On this screen you can:

· Add a  assignment to the existing list by selecting + New.
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· Select an assignment and:

o View  the detailed information of the assignment.

o Edit  the assignment information.

o Select Show History   to review the changes made to the assignment, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  an assignment. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion. 

3.4.1.3   Resource Management
On the Resource Management screen, you can review, view, and update any resources that

are cited anywhere in the initiative. This includes resources cited in the:

· TNA or TMD Resources screen under the Training Data folder, or for a specific Initiative

Location.

· Task Analysis for a Task, Subtask, or Step.

· And on the Develop tab:

o Sub-Elements: Page / Paragraph / Caution / Note / Warning.

o Sheets.

o Certain Test Items.

o Storyboard.

o Test Instructions.

210
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Figure 14: Initiative Management > Resource Management

On this screen:

· Select View Comments   to view, edit, and add to the comments about the listed

resources.  

· Use the Type drop-down to limit the list of resources to a specific sub-category, as set up

on Customizations  screens. 

· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. Select  to clear the search term and view all items

again. 

· Select the Show Out-of-Date Resources Separately check box to see those outdated

resources at the top of the list grouped under: Items to Update.

· Preview  a spreadsheet listing All cited resources, or the Missing File Resources

spreadsheet listing all IETMs with a Comparison File that is listed with the IETM but cannot

be found on the server and all IMMs with an Associated File that is listed with the IMM

but cannot be found on the server.

· View the different versions of a resource by clicking on the arrow  in the first column.

· Select a resource and then Preview  to generate the: 
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o Related Materials Report that lists every place within the initiative where the selected

resource is cited or used.

o Impact Report that lists every place within the initiative where any previous version of

the selected resource is cited or used.

o All Resources spreadsheet listing all cited resources.

o Missing File Resources spreadsheet listing all IETMs with a Comparison File that is listed

with the IETM but cannot be found on the server and all IMMs with an Associated File

that is listed with the IMM but cannot be found on the server.

· Select a resource and then: 

o Update  to the latest version of a resource.

o View  the resource information.

o Edit  the resource information if the resource is not approved.

Note: This will update the resource everywhere it is used in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.

3.4.2   Training Management Document

The Training Management Document (TMD) is the output of the Design phase that outlines

the content, structure, and management information for the initiative. Several fields are

shared with the Training Needs Analysis (TNA) and are editable in both areas, until the TNA is

approved. Once the TNA has been approved, changes to the shared fields will only be

reflected in the TMD. 

Shared fields include the Changes from Previous Version tab on Justification screen, as well as

the Initiative Overview, Target Audience, Qualification Earned, and Associated Learning Events

fields, and the information under the Training Data folder. The TMD adds Foreword and

Purpose of Initiative fields, along with a Schedule of the learning events under the Training

Data folder.
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Figure 44: Design > Training Management Document

On this screen, you can:

· Preview  the TMD.

· Select Explain Flag   to review the reasons the TMD has been flagged.

· Lock   the TMD to prevent edits from taking place.

· Unlock   a locked TMD to allow edits to take place again.

· Expand  all sub-folders at once, including those under Training Data and Initiative

Locations, to capture the information required for the TMD.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

· View the information by selecting the Training Management Document folder.

· Select Edit  the information about the TMD and initiative. Once you've finished making

the necessary changes, select Save to keep the changes, or select Cancel to discard the

changes.

3.4.2.1   Foreword (TMD Only)
On the Foreword screen, you can explain any unique aspects of the learning event, which may

not be clear from the information that is provided in the rest of the document. 
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Figure 45: TMD > Foreword

You can:

· View the foreword by clicking on the Foreword folder.

· Edit the information (Editor Help) . Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.2   Changes from Previous Version (TMD Only)
The Changes from Previous Version lists the required and recommended changes to the new

version of the existing learning event.
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Figure 46: TMD > Changes from Previous Version

You can:

· View the information by clicking on the Changes from Previous Version folder.

· Edit the information (Editor Help) . Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.3   Initiative Overview (TNA and TMD)
On the Initiative Overview screen, you can enter a description, or overview, of the proposed

learning event that will close the performance gap.
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Figure 17:  TNA/TMD > Initiative Overview

You can:

· View the information by clicking on the Initiative Overview folder.

· Edit the information (Editor Help) . Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.4   Purpose of Initiative (TMD Only)
On the Purpose of Initiative screen, you can provide a summary of the reasons why the

initiative is being/or has been developed from the training needs analysis. This can help

someone unfamiliar with the initiative with some background information.
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Figure 47: TMD > Purpose of Initiative

You can:

· View the information by clicking on the Purpose of Initiative folder.

· Edit the information (Editor Help) . Once you're finished making the necessary changes,

select Save to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.5   Target Audience (TNA and TMD)
On the Target Audience screen, you can describe who the learning event is for and how many

people are in the target audience.
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Figure 20: TNA/TMD > Target Audience

You can:

· View the information by clicking on the Target Audience folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.6   Qualification Earned (TNA and TMD)
On the Qualification Earned screen, you can list any qualification(s) or certification(s) that a

participant earns by completing the learning event.
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Figure 21: TNA/TMD > Qualification Earned

You can:

· View the information by clicking on the Qualification Earned folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.7   Associated Learning Events (TNA and TMD)

On the Associated Learning Events screen, you can list any associated learning events to the

current initiative, including:

· Prerequisite learning events that participants must or should complete before they can

attend this learning event or initiative.

· Equivalent learning events that participants can complete instead of this learning event or

initiative.

· Follow-on learning events that participants can or should complete after they completed

this learning event or initiative.
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Figure 22: TNA/TMD > Associated Learning Events

You can:

· View the information by clicking on the Associated Learning Events folder.

· Edit  the information. Once you're finished making the necessary changes, select Save

to keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.8   Training Data (TNA and TMD)
The Training Data screen lists the current and planned data for the learning event, including

expected length, number of hours, minimum and maximum capacities, number of convenings

(how often the learning event will be delivered), and the expected throughput of participants.

All data from the Training Data screen and sub-folders will be copied to any newly added

Initiative Location . 
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Figure 23: TNA/TMD > Training Data

You can:

· View the training data. 

· Edit the training data. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made. 

· Select Explain Flag   to review the reasons the Training Data folder has been

flagged.

· Expand  all the folders underneath Training Data.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

In the screens underneath the Training Data screen, you can enter information about the:

· Schedule  for delivering the learning event (in the TMD only).

· Facilities  needed to deliver the learning event.

· Funding  needed to develop and/or deliver the learning event.

· Personnel  needed to deliver the learning event.
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· Resources  needed to deliver the learning event.

3.4.2.8.1   Schedule (TMD Only)

On the Schedule screen, you can assign times to the table of contents of your learning event,

specifically Overview, Enabling Objective Level items, Summary and Assessments, as well as

schedule events that are not linked to a table of contents item (like administrative time or

other time you wish to capture in the schedule, like breaks or lunch). 

When you Edit the schedule, for each schedule event you can enter when the event should

take place (week and day), select the type of event it is, enter a time in hours and minutes,

and the instructor or facilitator to participant ratios. You can have more than one type of

event per schedule item by adding additional schedule events for that schedule item.

Figure 48: TMD > Training Data > Schedule

48
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3.4.2.8.2   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. 

Figure 24: TNA/TMD > Training Data > Facilities

On this screen you can:

· View the facility information by selecting Facilities under the Training Data folder.

· Edit the information. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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3.4.2.8.3   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Training Data >

Funding screen, so if you changed the year by mistake you can return to the previous

selected year without any loss of data. The fiscal year used in LEAD is whatever fiscal year

your organization uses. 

Figure 25: TNA/TMD > Training Data > Funding

On the Funding screen you can:

· View the funding information by selecting Funding under the Training Data folder.

· Edit the information. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made.

o Add a  funding or expense row to the table.

o Delete a  funding or expense row from the table.
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· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.8.4   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. In LEAD, you can list the personnel requirements

for four types of personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.
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Figure 26: TNA/TMD > Training Data > Personnel

On this screen you can:

· View the personnel information by selecting Personnel under the Training Data folder.

· Edit the information. Once you're finished making the necessary changes, select Save to

keep the changes, or select Cancel without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

218

210



96

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

3.4.2.8.5   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during

development. 

Figure 27: TNA/TMD > Training Data > Resources

On this screen you can:

· Select Explain Flag   to review the reasons the list of resources has been flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Select Preview  to generate the: 

o Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas in the initiative. On the Output Options screen

that pops-up, you can choose to check for resources not cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but listed in the Resources table. 
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o Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas in the initiative and that are not in the Resources table. On the Output Options

screen that pops-up, you can choose to check for resources cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but not listed in the Resources table. 

· Select a resource and then: 

o Preview  to generate the:

§ Related Materials Report that lists every place within the initiative where the selected

resource is cited or used.

§ Impact Report that lists every place within the initiative where any previous version of

the selected IETM is cited or used.

§ Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas in the initiative. On the Output Options screen

that pops-up, you can choose to check for resources not cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but listed in the Resources table. 

§ Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas in the initiative and that are not in the Resources table. On the Output Options

screen that pops-up, you can choose to check for resources cited within storyboards,

design considerations, test instructions, and skills, along with the default elements,

sheets, practice and assessment test items (including the test item’s references area),

but not listed in the Resources table. 

o Update  to the latest version of a resource.

o View the different versions of a resource by clicking on the arrow  in the first column.

o Select Explain Flag   to review the reasons the selected resource has been

flagged.

o View the selected resource.

· Edit the resource list. 

3.4.2.9   Initiative Locations (TNA and TMD)
On the Initiative Locations screen, you can select the initiative locations where training will

take place. All data from the Training Data screen and sub-folders will be copied to a newly

selected initiative location. 

220
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Figure 28: TNA/TMD > Initiative Locations

On this screen you can:

· Add a  initiative location to the TNA or TMD. Initiative Locations are created on the

Admin > Locations  screen. 

· Select Explain Flag   to review the reasons the Initiative Locations folder has been

flagged.

· Expand  all the sub-folders of all initiative locations. 

3.4.2.9.1   Selected Initiative Location (TNA and TMD)

The [Selected Initiative Location] screen lists the current and planned data for the initiative

location, including expected length, number of hours, minimum and maximum capacities,

number of convenings (how often the learning event will be delivered), and the expected

throughput of participants at that initiative location. 

199
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 Figure 29: TNA/TMD > [Selected] Initiative Location

On this screen, you can:

· View the initiative location's information.

· Edit the initiative location's information. Once you're finished making the necessary

changes, select Save to keep the changes, or select Cancel without saving any updates

you made.

· Delete  the selected initiative location from the initiative. Once you've selected OK to

the confirmation message, an Undo button displays on the bottom left of the screen that

allows you to revert the deletion.

· Select Explain Flag   to review the reasons the initiative location has been flagged.

· Expand  all the folders underneath a selected initiative location.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the initiative location,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

In the screens underneath the selected initiative location, you can enter information about

the:
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218

210



100

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

· Schedule  for delivering the learning event (in the TMD only).

· Facilities  needed to deliver the learning event at that initiative location.

· Funding  needed to deliver the learning event at that initiative location.

· Personnel  needed to deliver the learning event at that initiative location.

· Resources  needed to deliver the learning event at that initiative location.

3.4.2.9.1.1   Schedule (TMD Only)

On the Schedule screen for each Initiative Location, you can edit when the event should take

place (week and day) and change the instructor or facilitator to participant ratios of the

standard schedule that are set up on the Schedule screen under the Training Data folder. You

can also add additional schedule events for the Overview, Enabling Objective Level items,

Summary and Assessments entries in the schedule. You can have more than one type of event

per schedule item by adding additional schedule events for that schedule item.
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Figure 49: TMD > Initiative Locations > [Selected Initiative Location] > Schedule

On this screen you can:

· View the schedule by selecting Schedule under the Initiative Location folder.

· Edit some of the standard schedule information.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

218
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3.4.2.9.1.2   Facilities (TNA and TMD)

The Facilities screen provides you with several fields to describe what facilities are needed to

deliver or conduct the learning event. This could be a simple description of the room (or

other spaces) needed, to a description of new construction that is needed for this learning

event. When you first add a new Initiative Location0, the data is copied from the Training

Data > Facilities screen for you to edit for the specific initiative location. 

Figure 30: TNA/TMD > Initiative Location > Facilities

On this screen you can:

· View the facility information by selecting Facilities under the [Selected Initiative Location]

> Initiative Locations folder.

· Edit the information copied from the Training Data > Facilities screen. Once you're

finished making the necessary changes, select Save to keep the changes, or select Cancel

without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

218

210



103

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

3.4.2.9.1.3   Funding (TNA and TMD)

The Funding screen provides you with several fields to list the funding needed to develop and

deliver or conduct the learning event over five fiscal (or financial) years. The starting fiscal

year is set on the Training Needs Analysis screen. You can change this at any time. Changing

the Starting Fiscal Year will NOT delete any funding information on the Initiative Locations >

[Selected Initiative Location] >Funding screen, so if you changed the year by mistake you can

return to the previous selected year without any loss of data. The fiscal year used in LEAD is

whatever fiscal year your organization uses. When you first add a new Initiative Location, the

data is copied from the Training Data > Funding screen for you to edit for the specific

initiative location. 

Figure 31: TNA/TMD > Initiative Location > Funding

On the Funding screen you can:

· View the funding information by selecting Funding under the selected Initiative Location.

· Edit the information copied from the Training Data > Funding screen. Once you're

finished making the necessary changes, select Save to keep the changes, or select Cancel

without saving any updates you made.



104

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

o Add a  funding or expense row to the table.

o Delete a  funding or expense row from the table.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.9.1.4   Personnel (TNA and TMD)

The Personnel screen provides you with several fields to describe the number of personnel

needed to deliver or conduct the learning event, including any expected shortfall of

personnel and the source of the personnel. When you first add a new Initiative Location, the

data is copied from the Training Data > Personnel screen for you to edit for the specific

initiative location. In LEAD, you can list the personnel requirements for four types of

personnel:

· Contractor - anyone you hire specifically to deliver or conduct the learning event, the

funding for which you would list in the Funding screen table.

· Facilitator - someone who facilitates the learning event and is employed by your

organization.

· Instructor - someone who instructs the learning event and is employed by your

organization.

· Support - someone that supports the delivery of the learning event, whether that's safety

personnel, administrative support, testing support, or some other kind of support.
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Figure 32: TNA/TMD > Initiative Location > Personnel

On this screen you can:

· View the personnel information by selecting Personnel under the selected Initiative

Location.

· Edit the information copied from the Training Data > Personnel screen. Once you're

finished making the necessary changes, select Save to keep the changes, or select Cancel

without saving any updates you made.

· Select View Comments   to view, edit, and add to the comments.  
218
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· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.2.9.1.5   Resources (TNA and TMD)

The Resources screen provides you with the ability to add any resources needed to deliver or

conduct the learning event. You can select resources on this screen that you anticipate

needing and LEAD will add to this list of resources when you select them during development.

When you first add a new Initiative Location, the data is copied from the Training Data >

Resources screen for you to edit for the specific initiative location. 

Figure 33: TNA/TMD > Initiative Location > Resources

On this screen you can:

· Select Explain Flag  to review the reasons the list of resources has been flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· Select Preview  to generate the: 

o Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas for the selected initiative location. On the

210
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Output Options screen that pops-up, you can choose to check for resources not cited

within storyboards, design considerations, test instructions, and skills, along with the

default elements, sheets, practice and assessment test items (including the test item’s

references area), but listed in the Resources table. 

o Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas for the selected initiative location. and that are not in the Resources table. On the

Output Options screen that pops-up, you can choose to check for resources cited within

storyboards, design considerations, test instructions, and skills, along with the default

elements, sheets, practice and assessment test items (including the test item’s

references area), but not listed in the Resources table. 

· Select a resource and then: 

o Preview  to generate the:

§ Related Materials Report that lists every place within the initiative where the selected

resource is cited or used.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected IETM is cited or used.

§ Uncited Resources Report. A spreadsheet that lists all resources in the Resources table

that are not cited in the selected areas for the selected initiative location. On the

Output Options screen that pops-up, you can choose to check for resources not cited

within storyboards, design considerations, test instructions, and skills, along with the

default elements, sheets, practice and assessment test items (including the test item’s

references area), but listed in the Resources table.  

§ Unlisted Resources Report. A spreadsheet that lists all resources cited in the selected

areas for the selected initiative location. and that are not in the Resources table. On

the Output Options screen that pops-up, you can choose to check for resources cited

within storyboards, design considerations, test instructions, and skills, along with the

default elements, sheets, practice and assessment test items (including the test item’s

references area), but not listed in the Resources table. 

o View the different versions of a resource by clicking on the arrow  in the first column.

o Select Explain Flag  to review the reasons the selected resource has been flagged.

o View  a selected resource. 

· Edit the resource list. 

220
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3.4.3   Curriculum Development

Under the Curriculum Development folder, you can build the table of contents structure for

your initiative. The scope of the initiative determines what the individual elements of the

structure are called:

Course / Distance Learning Course

· Module(s) - a grouping of one or more lessons 

o Lesson(s) - a grouping of one or more sections; each lesson is linked to a terminal

objective 

§ Overview - each lesson has one overview area for content

§ Section(s) - each lesson has one or more sections that contain the actual content of

the course; each section is linked to an enabling objective

§ Summary - each lesson has one summary area for content

Module / Distance Learning Module

· Lesson(s) - a grouping of one or more sections; each lesson is linked to a terminal

objective 

o Overview - each lesson has one overview area for content

o Section(s) - each lesson has one or more sections that contain the actual content of

the course; each section is linked to an enabling objective

o Summary - each lesson has one summary area for content

Lesson / Distance Learning Lesson - linked to one terminal objective

· Overview - the lesson has one overview area for content

· Section(s) - the lesson has one or more sections that contain the actual content of the

lesson; each section is linked to an enabling objective

· Summary - the lesson has one summary area for content

Manual

· Section(s) - a grouping of one or more chapters; each section is linked to a terminal

objective 

o Overview - each section has one overview area for content

o Chapter(s) - each section has one or more chapters that contain the actual content of

the course; each chapter is linked to an enabling objective

o Summary - each section has one summary area for content

Mentoring - linked to one terminal objective

· Overview - there is one overview area for content

· Subject(s) - there are one or more subjects that contain the actual content; each

subject is linked to an enabling objective

· Summary - there is one summary area for content
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On-the-Job-Training (OJT)

· Level(s) - a grouping of one or more procedures; each procedure is linked to a

terminal objective

o Overview - each level has one overview area for content

o Procedure(s) - each level has one or more procedures that contain the actual

content of the level; each procedure is linked to an enabling objective

o Summary - each level has one summary area for content

Performance Support

· Module(s) - a grouping of one or more procedures; each procedure is linked to a

terminal objective

o Overview - each module has one overview area for content

o Procedure(s) - each module has one or more procedures that contain the actual

content of the level; each procedure is linked to an enabling objective

o Summary - each module has one summary area for content

Workshop - linked to one terminal objective

· Overview - the workshop has one overview area for content

· Section(s) - the workshop has one or more sections that contain the actual content of

the lesson; each section is linked to an enabling objective

· Summary - the workshop has one summary area for content

Figure 50: Design > Curriculum Development

On this screen you can:
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· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· Expand  all sub-folders at once down to the lowest level. Selecting any table of

contents item and then Expand opens just that table of contents item down to the lowest

level. 

Select the top level to start working on the table of contents structure for your initiative.

In general, select a table of contents item by clicking on the relevant folder to:

· View the information about the table of contents item.

· Edit the information (including the title for modules and below, but not the Status - you

can edit the Status on the Develop tab).

· Resequence   the items below the selected item in the tree structure.

· Preview  the table of contents outline (structure of your initiative with applicable

objectives).

· Delete  an item at the module level or below (provided no content exists on the

Develop tab). Once you've selected OK to the confirmation message, the Training Outline

Deletion screen displays. Enter the title of the table of contents item to confirm the

deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier on

yourself. If you only enter a partial title, the item will not be deleted, and the Training

Outline Deletion screen stays open, ready for you to try again.

· Select Add Missing  to create new table of contents items based on newly added

learning objectives.

· Select View Comments   to view, edit, and add to the comments.

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.3.1   Course Level
Only initiatives with a Scope of Course or Distance Learning Course have a course level. On

this screen, you can use Add Missing  to automatically create the basic table of contents

structure based on the objectives. A default Module is added automatically. You can then

choose to add additional modules to group the lessons in your course. 
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Figure 51: Curriculum Development > Course Level

Once you've built the basic structure, you have the following actions available to you:

· View the course level information.

· Edit the course level information.

· Add a  Module or Assessment.

· Resequence   the table of contents items below the selected table of contents item

in the tree structure.

· Preview  the Table of Contents Outline (structure of your initiative with applicable

objectives).

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· Select Add Missing  to create new table of contents items based on newly added

learning objectives.

· Expand  all sub-folders at once down to the lowest level. 

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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· View/Edit the Design Considerations that gather information about the table of contents

item to help with the development of the learning event. 

3.4.3.2   Module Level
Only initiatives with a Scope listed below have a module level, though the name will vary

depending on the Scope (called Module Level in this manual):

· Course / Distance Learning Course: Module

· Module / Distance Learning Module - top level of the initiative: Module

· Manual - top level of the initiative: Manual

· On-the-Job Training (OJT) - top level of the initiative: On-the-Job Training

· Performance Support - top level of the initiative: Performance Support

Figure 52: Curriculum Development > Module Level

For initiatives where the Module Level is the top level of the initiative, any field differences are

marked "- Top Level Only" or "- Lower Level Only" as needed. On this screen, you can use

Add Missing to automatically create the basic table of contents structure based on the

objectives. Once you've built the basic structure, you have the following actions available to

you:

· View the module level information.
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· Edit the module level information, except for the Status, that you can only edit on the

Develop tab.

· Add a  Assessment.

· Resequence   the items below the selected item in the tree structure.

· Preview  the Table of Contents Outline (structure of your initiative with applicable

objectives).

· Paste: Move  a copied TO level (e.g., lesson) to the selected module level. When you

move a TO level, the Status of the moved TO level does not change. You cannot move a

TO level to another initiative.

Note: You cannot Move a copied TO level when the selected module level is Locked.

· Delete  an item at the module level or below (provided no content exists on the

Develop tab). Once you've selected OK to the confirmation message, the Training Outline

Deletion screen displays. Enter the title of the table of contents item to confirm the

deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier on

yourself. If you only enter a partial title, the item will not be deleted, and the Training

Outline Deletion screen stays open, ready for you to try again.

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· Add Missing  to create new table of contents items based on newly added learning

objectives (this is only available for the highest-level folder, for a Module, or Distance

Learning Module initiative).

· Expand  all sub-folders at once down to the lowest level. 

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision. 

· View/Edit the Design Considerations at every level that gather information about the

table of contents item to help with the development of the learning event.

3.4.3.3   Terminal Objective Level
All initiatives have at least one Terminal Objective (TO) Level, though the name will vary

depending on the Scope of the initiative (later called TO Level Name for field titles):

· Course / Distance Learning Course: Lesson

· Module / Distance Learning Module: Lesson
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· Lesson / Distance Learning Lesson - top level of the initiative: Lesson

· Manual: Section

· Mentoring - top level of the initiative: Mentoring

· On-the-Job Training (OJT): Level

· Performance Support: Module

· Workshop - top level of the initiative: Workshop

Figure 53: Curriculum Development > Terminal Objective Level

For initiatives where the TO Level is the top level of the initiative, any field differences are

marked "- Top Level Only" or "- Lower Level Only" as needed. On this screen, you can use

Add Missing to automatically create the basic table of contents structure based on the

objectives. Once you've built the basic structure, you have the following actions available to

you:

· View the TO level by clicking on the relevant folder.

· Edit the information, except for the Status, that you can only edit on the Develop tab.

· Add a  Assessment.
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· Resequence   the items below the selected item in the tree structure.

· Preview  the Table of Contents Outline (structure of your initiative with applicable

objectives).

· Copy  the selected TO level (e.g., lesson) into memory. You will need to go to a

module level before trying to select Paste: Move to move the TO level to a different

module level in the same initiative.

Note: You cannot Paste: Move a TO level to another initiative.

· Paste: Duplicate/Move  a copied EO level (e.g., section) to the selected TO level (e.g.,

lesson).

Note: You cannot Paste a copied EO level when the selected TO level is Locked.

o Duplicate will create a copy of the EO level. The Status of the copied EO level will be

updated to Incomplete when it is pasted. You can use the Duplicate option to make

copies of the EO level in other initiatives.

o Move will move the EO level under the selected TO level. When you move an EO level,

the Status of the moved EO level does not change. You cannot move an EO level to

another initiative.

· Delete  an item at the TO level or below (provided no content exists on the Develop

tab). Once you've selected OK to the confirmation message, the Training Outline

Deletion screen displays. Enter the title of the table of contents item to confirm the

deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier on

yourself. If you only enter a partial title, the item will not be deleted, and the Training

Outline Deletion screen stays open, ready for you to try again.

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· Add Missing  to create new table of contents items based on newly added learning

objectives.

· Expand  all sub-folders at once down to the lowest level. 

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· View/Edit the Objective  information by selecting the Objective: link.
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· View/Edit the Design Considerations at every level that gather information about the

table of contents item to help with the development of the learning event.

3.4.3.4   Overview/Summary

Underneath the Terminal Objective Level , you will see an Overview folder prior to the

Enabling Objective Level(s)  and a Summary folder at the end. 

Figure 54: Curriculum Development > Overview or Summary

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit the information, except for the Status, that you can only edit on the Develop tab.

· Preview  the Table of Contents Outline (structure of your initiative with applicable

objectives).

· Select Explain Flag   to review the reasons the Overview or Summary has been

flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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· View/Edit the Design Considerations at every level that gather information about the

table of contents item to help with the development of the learning event.

3.4.3.5   Enabling Objective Level
All initiatives have one or more Enabling Objective (EO) Levels, though the name will vary

depending on the Scope of the initiative (later called EO Level Name for field titles):

· Course / Distance Learning Course: Section

· Module / Distance Learning Module: Section

· Lesson / Distance Learning Lesson: Section

· Manual: Chapter

· Mentoring: Subject

· On-the-Job Training (OJT): Procedure

· Performance Support: Procedure

· Workshop: Section
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Figure 55: Curriculum Development > Enabling Objective Level

On this screen, you have the following actions available to you:

· View the EO level by clicking on the relevant folder.

· Edit the information, except for the Status, that you can only edit on the Develop tab.

· Preview  the Table of Contents Outline (structure of your initiative with applicable

objectives).

· Copy  the selected EO level (e.g., section) into memory. You will need to go to a TO

level (e.g., lesson) before trying to select Paste.

Note: If you make changes to the selected EO level on the Develop tab, after selecting

Copy, then return to the Design tab to Paste: Move/Duplicate the Enabling level

somewhere else, you will not get a copy of the original EO level before you made the

changes, rather the changes you made will be copied, too.

· Delete  an item at the EO level (provided no content exists on the Develop tab). Once

you've selected OK to the confirmation message, the Training Outline Deletion screen

displays. Enter the title of the table of contents item to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier on
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yourself. If you only enter a partial title, the item will not be deleted, and the Training

Outline Deletion screen stays open, ready for you to try again.

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· View/Edit the Objective  information by selecting the link.

· View/Edit the Design Considerations at every level that gather information about the

table of contents item to help with the development of the learning event.

· View  the Skill Basis that the EO level is based on.

3.4.3.6   Assessment

Assessments can be added under the Curriculum Development folder to be at the same level

as a Module Level (if you have that level in your initiative), or on the same level as a terminal

or enabling objective. You can select which enabling objectives will be tested in the

assessment in the Objectives tab, where you will see all objectives at the same level or below

the selected level in the tree structure. 

Figure 56: Curriculum Development > Assessment
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On this screen, you can:

· View the assessment information by clicking on the assessment.

· Edit the information, except for the Status, that you can only edit on the Develop tab.

· Preview  the Table of Contents Outline (structure of your initiative with applicable

objectives).

· Delete  the assessment (provided no content exists on the Develop tab). Once you've

selected OK to the confirmation message, the Training Outline Deletion screen displays.

Enter the title of the table of contents item to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier on

yourself. If you only enter a partial title, the item will not be deleted, and the Training

Outline Deletion screen stays open, ready for you to try again.

· Select Explain Flag   to review the reasons the assessment has been flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

· View/Edit the Test Design Considerations.

3.4.4   Testing Plan

On the Testing Plan screen, you can gather information about the overall assessment plan for

the initiative (if any). This includes the following information:

· Minimum Passing Grade - captures information about the minimum passing grade

required to pass the initiative.

· Justification / Comments - captures any information needed to justify the minimum

passing grade, along with any other comments about the testing plan.

· Test Procedure - captures the overarching testing procedure for the initiative; you can

capture test instructions for each assessment separately in the Develop tab.

· Matrix - lists all the assignments that were created under the Curriculum Development

folder and allows you to assign a weight to them that can be used to determine the

overall/final grade a participant receives.
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Figure 57: Design > Testing Plan

On these screens you have the following actions available to you:

· View the information.

· Edit the information.

· Preview  the testing plan.

· Expand  all sub-folders at once down to the lowest level.

· Select View Comments   to view, edit, and add to the comments. 

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

3.4.4.1   Test Matrix
On the Test Matrix screen, you can assign a weight to each assessment that was created under

the Curriculum Development folder. This weight can be used to determine the overall/final

grade a participant receives. 
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Figure 58: Testing Plan > Test Matrix

On this screen you can:

· View the information.

· Edit weight assigned to each assessment.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the information, including the

user name and date/time of saved changes, and revert to an earlier saved revision.
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3.4.5   Documents

Figure 59: Design > Documents

Expand  the Documents folder to see the available options:

· Training Management Document - a PDF document of the information listed under the

Training Management Document, plus the table of contents under the Curriculum

Development folder, along with the objectives. You can choose whether to include any

comments on the Output Options screen.

· Testing Plan - a PDF document of the information listed under the Testing Plan folder.

You can choose whether to include any comments on the Output Options screen.

· Training Outline - a PDF document listing the table of contents under the Curriculum

Development folder, along with their status and their objectives. You can choose whether

to include any comments on the Output Options screen.

· Training Design Document - a PDF document of the table of contents under the

Curriculum Development folder, along with the objectives, the design considerations,

assessment information, and the test design considerations. You can choose whether to

include any comments on the Output Options screen.

· Objective Assessment Information - a spreadsheet that contains the objectives along with

their assessment information, as detailed on the Objectives tab.

· Traceability Matrix - a spreadsheet listing the table of contents under the Curriculum

Development folder on the Design tab, the objectives for each applicable table of

contents item, the skills of the task analysis that support the objectives, along with the

competencies that the skills are based on.
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Select the document you wish to create in the tree structure. Then select Preview  to

generate the document.

3.5 Develop

On the Develop tab, you add the actual content to your initiative. Based on the Curriculum

Development tree structure you created on the Design tab, you can now add the following

content:

· Front Matter  information for the output generated for the instructor/facilitator and the

participants with predefined Elements  (or headings) to which you can add paragraphs,

notes, cautions, or warning)s .

· Terminal Objective Level  entries (e.g., Lessons) have Overview and Summary folders

before and after the Enabling Objective Level entries (e.g., Sections).

· Overview and Summary folders to which you can add Elements  (or main headings),

under which you can add paragraphs, notes, cautions, or warning)s .

· Enabling Objective Level  entries (e.g., Sections) contain the actual learning content,

including:

o Sheets  that will print in the Participant Guide (or similar output).

o Elements  (or main headings) for the content structure, based on the content type,

under which you can add paragraphs, notes, cautions, or warning)s .

o Practice test items , which will print in the output for the instructor/facilitator.

o Assessment test items , which will output in an assessment.

· Assessment  entries that allow you to edit the test instructions for a given assessment.
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Figure 60: Initiatives > Develop

On this screen:

· Select a folder and then Expand  to open up the folders beneath the selected folder

to get to the data you need to work with:

o Selecting a Course or Module Level and then Expand opens the tree down to the

enabling objective level, including the Overview and Summary folders. 

o Selecting a Terminal or Enabling Objective Level and then Expand opens the tree down

to the lowest level, including Sheets, Elements, and Sub-Elements.

o Selecting an Overview or Summary folder and then Expand opens the tree down to the

lowest level, including Elements and Sub-Elements.

o Selecting the Documents folder and then Expand opens up all the available output

options.

· To make more room to see items in the tree structure, click and drag the bottom right

corner of the tree window (or frame). 

· To make even more room, click on the three-bar icon  next to LEAD in the header

bar to minimize the main menu to show only the icons. To see all of the menu items

again, click on the three-bar icon again.



126

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

3.5.1   Front Matter

On the folders and screens below the Front Matter folder, you can edit the front matter text

that is output in the Instructor Guide (IG) and the Participant Guide (PG). Expand  the Front

Matter folder and select either IG to edit the front matter for the Instructor Guide or PG to

edit the front matter for the Participant Guide. LEAD comes with three default elements

(headings) for the front matter:

· IG

o How to Use the Instructor Guide

o Safety Hazard Awareness

o Security Awareness

· PG

o How to Use the Participant Guide

o Safety Hazard Awareness

o Security Awareness

Figure 61: Front Matter

3.5.2   Course Level

Only initiatives with a Scope of Course or Distance Learning Course have a course level. 
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Figure 62: Course Level

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit the information (including the title for modules and below).

· Preview  the Instructor Guide, Participant Guide, Storyboard, or test items.

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG. 

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· View the Cited Resources   at every level that lists all resources used or cited

anywhere below the selected table of contents item on the Develop tab. 

· View the Cited Sheets   at every level that lists all sheets listed anywhere below the

selected table of contents item on the Develop tab. 

· Lock  the table of contents item to prevent edits from taking place.

· Unlock  a locked table of contents item to allow edits to take place again.

· Expand  up to three levels of sub-folders at a time. Selecting the course level and

then Expand opens the tree down to the EO level, including the Overview and Summary

folders.

· Select View Comments   to view, edit, and add to the comments.  
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· View the Design Considerations at every level that gather information about the table of

contents item to help with the development of the learning event.

3.5.3   Module Level

Only initiatives with a Scope listed below have a module level, though the name will vary

depending on the Scope (called Module Level in this manual):

· Course / Distance Learning Course: Module

· Module / Distance Learning Module - top level of the initiative: Module

· Manual - top level of the initiative: Manual

· On-the-Job Training (OJT) - top level of the initiative: On-the-Job Training

· Performance Support - top level of the initiative: Performance Support

Figure 63: Develop > Module Level

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit the information (including the title for modules and below).

· Preview  the Instructor Guide, Participant Guide, Storyboard, or test items for this table

of contents item.

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG. 
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· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· View the Cited Resources   at every level that lists all resources used or cited

anywhere below the selected table of contents item on the Develop tab. 

· View the Cited Sheets   at every level that lists all sheets listed anywhere below the

selected table of contents item on the Develop tab. 

· Lock  the table of contents item to prevent edits from taking place.

· Unlock  a locked table of contents item to allow edits to take place again.

· Expand  up to three levels of sub-folders at a time. Selecting the module level and

then Expand opens the tree down to the EO level, including the Overview and Summary

folders.

· Select View Comments   to view, edit, and add to the comments.  

· View the Design Considerations at every level that gather information about the table of

contents item to help with the development of the learning event.

3.5.4   Terminal Objective Level

All initiatives have at least one Terminal Objective (TO) Level, though the name will vary

depending on the Scope of the initiative (later called TO Level Name for field titles):

· Course / Distance Learning Course: Lesson

· Module / Distance Learning Module: Lesson

· Lesson / Distance Learning Lesson - top level of the initiative: Lesson

· Manual: Section

· Mentoring - top level of the initiative: Mentoring

· On-the-Job Training (OJT): Level

· Performance Support: Module

· Workshop - top level of the initiative: Workshop
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Figure 64: Terminal Objective Level

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit the information (including the title).

· Preview  Instructor Guide, Participant Guide, Storyboard, or test items for this TO level.

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG.

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· View the Cited Resources   at every level that lists all resources used or cited

anywhere below the selected table of contents item on the Develop tab.

· View the Cited Sheets   at every level that lists all sheets listed anywhere below the

selected table of contents item on the Develop tab. 

· Lock  the table of contents item to prevent edits from taking place.

· Unlock  a locked table of contents item to allow edits to take place again. 
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· Expand  the folders down to the lowest level, including Sheets, Elements, and Sub-

Elements.

· Select View Comments   to view, edit, and add to the comments.  

· View/Edit the Objective  information by selecting the Objective: link.

· View the Design Considerations at every level that gather information about the table of

contents item to help with the development of the learning event.

· View  the Skill Basis that the terminal objective level is based on.

3.5.5   Overview/Summary

Underneath the Terminal Objective Level  you will see an Overview folder prior to the

Enabling Objective Level(s)  and a Summary folder at the end. On the screens below the

Overview and Summary folders, you can edit the overview and summary text for the terminal

objective level. There is one predefined element for each folder, Introduction for the

Overview folder, and Review for the Summary folder. 

Figure 65: Overview or Summary

On this screen, you can: 

· View the table of contents item by clicking on the relevant folder.

· Edit the information (including the title).

· Add a  element (heading).

· Resequence   the items below the selected item in the tree structure.
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· Preview  the Instructor Guide output for the Overview or Summary.

· Paste  a copied element at the end of the existing elements. If you cannot paste an

element directly, you can try to Paste/Append  the contents of the element by selecting

an element first. Though you cannot paste the contents an element that contains a sheet

citation to an Overview, or Summary element.

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· View the Cited Resources   at every level that lists all resources used or cited

anywhere below the selected table of contents item on the Develop tab. 

· Lock  the table of contents item to prevent edits from taking place.

· Unlock  a locked table of contents item to allow edits to take place again.

· Expand  the folders down to the lowest level, including all elements and sub-

elements.

· Select View Comments   to view, edit, and add to the comments.  

· View the Design Considerations at every level that gather information about the table of

contents item to help with the development of the learning event.

3.5.6   Enabling Objective Level

All initiatives have one or more Enabling Objective (EO) Levels, though the name will vary

depending on the Scope of the initiative (later called EO Level Name for field titles):

· Course / Distance Learning Course: Section

· Module / Distance Learning Module: Section

· Lesson / Distance Learning Lesson: Section

· Manual: Chapter

· Mentoring: Subject

· On-the-Job Training (OJT): Procedure

· Performance Support: Procedure

· Workshop: Section
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Figure 66: Enabling Objective Level

On this screen, you can:

· View the table of contents item by clicking on the relevant folder.

· Edit the information (including the title).

· Create a New Version  of an approved EO level, which will automatically also version

the linked enabling objective and any unversioned parents (TO level and module level). 

· Add  elements  that will contain the content in Pages or Paragraphs  and

provide notes, cautions, or warnings, as well as test items  for the Practice or

Assessment elements.

· Resequence   the elements below the selected item in the tree structure.

· Preview  the Instructor Guide, Participant Guide, Storyboard, or test items for this EO

level.

Note: If you leave an area (or tab/heading) on a Sheet empty by not adding any entries,

then that area will not output in the PG.

· Paste  a copied element. If you cannot paste an element directly, you can try to

Paste/Append  the contents of the element, by selecting an element and then
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Paste/Append. You can also copy all test items from a Practice or Assessment element at

a time, by copying the element and then selecting Paste/Append on another Practice or

Assessment element. The Performance Job Sheet test item cannot be pasted into a

Practice element, as that type of test item can only be copied/pasted to another

Assessment element. 

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· View the Cited Resources   at every level that lists all resources used or cited

anywhere below the selected table of contents item on the Develop tab. 

· View the Cited Sheets   at every level that lists all sheets listed anywhere below the

selected table of contents item on the Develop tab. 

· Lock  the table of contents item to prevent edits from taking place.

· Unlock  a locked table of contents item to allow edits to take place again.

· Expand  the folders down to the lowest level, including sheets, elements, and sub-

elements.

· Select View Comments   to view, edit, and add to the comments.  

· View the Objective information.

· View the Design Considerations at every level that provide information about the table of

contents item to help with the development of the learning event.

· View  the Skill Basis that the EO level is based on.

Underneath the EO Level in the tree structure, you will see:

· a Sheets  folder that lists any Participant Guide sheets (or handouts) that are linked to

this EO.

· the required elements (headings) as determined by the Content Type set for this EO level

on the Objective or Design tabs.

o underneath each element you can create Pages and Paragraphs (subheadings) for the

content, including Text and links to Resources and Sheets; Pages and Paragraphs can

also be converted to notes, cautions, or warnings.

o Pages are created for the IMI, Blended, and EPSS Delivery Methods of the EO level.

o Paragraphs are created for the Instructor-Led Delivery Method of the EO level.

· a Practice element (if required) for non-graded test items  that will be included in the

Instructor Guide.
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· an Assessment element (if required) for graded test items  that will be included in any

assessment that tests the EO (and not included in the Instructor Guide).

For each element (including Practice and Assessment elements) and pages, paragraphs, notes,

cautions, or warnings, you can review the Design Considerations and View/Edit the

Storyboard  for that particular element, page, paragraph, notes, cautions, or warnings. 

3.5.7   Elements

Elements are the major headings for your content. There are predefined elements for the

Front Matter  of the instructor and participant guides. You can create elements for the

Overview and Summary  folders underneath the Terminal Objective Level  and

underneath the Enabling Objective Level . 

Figure 67:  Elements

Once you have selected an element, you can:

· View/Edit  the element title and type.

· Add a  page or paragraph  (and convert either one to a note, caution, or

warning), or test item  for the Practice or Assessment elements.
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· Resequence   the pages, paragraphs, notes, cautions, or warnings underneath the

element.

· Copy  the element.

· Paste/Append  the contents (pages, paragraphs, notes, cautions, or warnings) of a

copied element at the end of any existing content. If you cannot paste an element

directly, you can try to Paste/Append the contents of the element, though you cannot

paste the contents an element that contains a sheet citation to a Front Matter, Overview,

or Summary element. You can also copy all test items from a Practice or Assessment

element at a time, by copying the element and then selecting Paste/Append on another

Practice or Assessment element. The Performance Job Sheet test item cannot be pasted

into a Practice element, as that type of test item can only be copied/pasted to another

Assessment element.

· Delete  a selected element. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion.

Note: You cannot delete a required element under the Enabling Objective Level.

· Select Explain Flag   to review the reasons the element has been flagged.

· Expand  the tree to the lowest level.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the element.

· View/Edit the Storyboard  for the element.

· View the Design Considerations for Front Matter elements, for Overview or Summary

elements, or for elements at the Enabling Objective Level. 

3.5.7.1   Sub-Elements
Underneath the Elements (major headings), you can create as many Pages or Paragraphs

(subheadings) as you need for your content. Pages are primarily meant for on screen display

(like eLearning), while Paragraphs are for printed materials (like the Instructor Guide). 

What you can do with a page or paragraph is identical, just how the information is output and

used is different. 

209

220

218

210

143



137

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Initiatives

Figure 68: Sub-Elements: Pages/Paragraphs and Notes/Cautions/Warnings

Once you have selected a page or paragraph, you can:

· View/Edit  the title, type, and contents by selecting the page or paragraph.

· Copy /Paste  a selected page or paragraph.

· Delete  a selected page or paragraph (including all the content it contains). Once

you've selected OK to the confirmation message, an Undo button displays on the bottom

left of the screen that allows you to revert the deletion. 

· Select Explain Flag   to review the reasons the selected page or paragraph has been

flagged.

· Select View Comments   to view, edit, and add to the comments.  

· Select Show History   to review the changes made to the page or paragraph.

· View/Edit the Storyboard  for the page or paragraph.

· View the Design Considerations for Front Matter sub-elements, for Overview or Summary

sub-elements, or for sub-elements at the Enabling Objective level.

· Add a  Text  entry.
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· Convert a Text entry to a Note, Caution, or Warning entry, which will output the text with

top and bottom lines and a Note, Caution, or Warning icon.

· Add a  Resource  entry.

· View or download a Resource entry, if a link is shown and you have the correct software

available.

· Add a  Sheet  entry (for Enabling Objective Level page or paragraph only).

· Select Explain Flag   to review the reasons the selected Text, Note, Caution,

Warning, Resource, or Sheet entry has been flagged.

· Edit  a selected Text, Note, Caution, Warning , Resource , or Sheet  entry.

· Delete  a selected Text, Note, Caution, Warning, Resource, or Sheet entry. Once you've

selected OK to the confirmation message, an Undo button displays on the bottom left of

the screen that allows you to revert the deletion. 

· Copy /Paste  a selected Text, Note, Caution, Warning, Resource, or Sheet entry.

· Move a selected Text, Note, Caution, Warning, Resource, or Sheet entry Up  or Down

 in the list of entries to resequence the list of entries.

3.5.8   Sheets

Sheets are the handouts to the participants that are collated into the Participant Guide (PG).

You create sheets by selecting the Sheets folder underneath the EO Level  and then

. A sheet can be cited in a Page or Paragraph  underneath an element of the same

EO Level that contains the sheet to provide the instructor or participant information about

how and when to refer to or use the sheet. 

LEAD supports the following sheet types, with the following tabs (headings) and types of

content (in parentheses):

· Assignment Sheet - lists materials to be studied, e.g. for homework:

o Introduction (Text ) - introduces the assignment.

o Study Assignment (Resources ) - lists the resources to be studied with additional

information provided using Before and After text.

o Study Questions (Text , Resources , and Test Items ) - lists questions that help

the participant apply the information.

· Diagram Sheet - displays diagrams, schematics, or charts:

o Diagram (Resources ) - displays the diagram in more detail than available elsewhere

and allows for participant notes.

· Information Sheet - expands on the information not available in other resources, specific

to the topic being discussed:
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o Introduction (Text ) - introduces the information and why it is useful to the

participant.

o References (Resources ) - lists the sources used to develop the sheet.

o Information (Text  and Resources ) - provides detailed information about the topic.

· Job Sheet - provides step by step information on a job (typically a procedure or process)

to be completed by the participant:

o Introduction (Text ) - introduces the job.

o Resources (Resources ) - lists the resources to use to perform the job.

o Safety Precautions (Text  and Resources ) - describes any safety precautions to

take prior, during, and after the job that are not detailed elsewhere in the PG.

o Job Steps (Text  and Resources ) - lists the steps to take to perform the job, along

with space for notes.

o Self-Test Questions (Text , Resources , and Test Items ) - lists questions for the

participant to answer that require reflection and analysis on the job.

· Outline Sheet - provides the major points to be covered in the topic:

o Introduction (Text ) - introduces the overall scope and content of the topic.

o Outline (Text  and Resources ) - outlines the content and major resources that will

be used, also, sometimes used to allow for note taking by the Participants.

· Problem Sheet - provides problem(s) for the participants to practice with:

o Introduction (Text ) - introduces the problem(s) to be solved.

o Resources (Resources ) - lists the available resources.

o Directions (Text  and Resources ) - details the directions and procedures to use to

solve the problem(s).

o Problem (Text , Resources , and Test Items ) - details the problem(s) to be

solved.

You can generate the PG, and thus all the relevant sheets, when you select the EO Level (e.g.,

sections), TO Level (e.g., lessons), Module Level, or the Course Level and select Preview .

You can also generate an individual sheet, by selecting it under the Sheets folder and

selecting Preview . 

Note: If there are no entries for a tab (heading), i.e., it is empty, then that tab will not output

on the sheet or in the PG. 

To copy and paste a sheet from one EO Level to anther EO Level, you need to copy the entry

under the Page or Paragraph that cites or references the sheet and paste the entry under a

Page or Paragraph to copy both the citation/reference entry and the sheet at the same time.
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Figure 69: Enabling Objective Level > Sheets

On the Sheets screen, you can:

· See a list of the sheets that have been created for the EO Level.

· Add  Sheet.

· Resequence   the sheets to change the order in which they are output in the

Participant Guide.

· Select Explain Flag   to review the reasons the Sheets folder has been flagged.

· Expand  the Sheets folder to show the existing sheets.

· View  a selected sheet.

3.5.8.1   Adding Multiple Resources to a Sheet
You can add Resource citations on tabs that list resources a little differently than you can on

the other Sheet tabs, as you can select multiple resources of multiple Resource Types to add

at the same time. You then edit  those multiple resource citations one at a time. The

information in this section describes what you can do on the following sheet tabs:

· Assignment Sheet - Study Assignment tab.

· Information Sheet - References tab.

· Job Sheet - Resources tab.
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· Problem Sheet - Resources tab.

· Performance Job Sheet Test Item - Resources, Setup Instructions, and Reference tabs.

3.5.8.2   Editing a Resource Citation/Entry

When you edit Resource citation on the tabs listed below:

· Assignment Sheet - Study Questions tab.

· Diagram Sheet - Diagram tab.

· Information Sheet - Information tab.

· Job Sheet - Safety Precautions, Job Steps, and Self-Test Questions tabs.

· Outline Sheet - Outline tab.

· Problem Sheet - Directions and Problem tab.

· Performance Job Sheet Test Item - Safety Precautions and Job Steps tabs.

For information on how to work with Resource citations on the other tabs, please see here .

You have additional options when you select an IMM graphic with an associated JPG, JPEG, or

PNG file, as you can also:

· View  the graphic.

· Set the following for each graphic:

o Width

o Rotation

o Alignment

3.5.9   Test Items

You can create test items on the Practice and Assessment elements underneath the enabling

objective levels, as well as for Assignment, Job, and Problem Sheets. When it comes to the

output of test items:

· Test items created under a Practice element will output in the Instructor Guide and similar

outputs at the module, terminal objective, and enabling objective levels. You can also

Preview  test items for a selected Practice element, as well as for a selected course,

module, terminal objective, and enabling objective level.

· Test items created under an Assessment element will output in Assessment(s)  and

Assessment Package  outputs. You can also Preview  test items for a selected
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Assessment element, as well as for a selected course, module, terminal objective, and

enabling objective level.

· Test items created on Sheets will output in the Participant Guide and answers to those

test items will output in the back of the Instructor Guide. You can Preview  the test

items in the Participant Guide output at the course, module, terminal objective, and

enabling objective level, as well as for a selected sheet.

LEAD supports the following test item types:

· Essay Question - free response test item.

· Fill-in-the-Blank - short answer test item.

· Multiple Choice - including single answer and multiple answer.

· Performance Job Sheet - complete with a rubric to help assess participants for

assessment elements only.

· True/False - single response test item.

· Two-Column Matching - mix and match test item.

Figure 70: Test Items - Practice Element Example
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Once you have selected the practice or assessment element, or are viewing the sheet, you

can:

· Select View Comments   or  to view, edit, and add to the comments.  

· View/Edit  the practice or assessment title, and the sheet information.

· Add a New .

· Paste  a copied test item at the top of the list of test items. 

· Select Explain Flag   to review the reasons the test item has been flagged.

· View  a selected test item and then edit the test item.

· Delete  a selected test item.

· Move a selected test item Up  or Down  in the list of test items to resequence the list

of test items.

· Copy /Paste  a test item.

· Select Show History   to review the changes made to the practice or assessment

element, or the sheet.

· Delete  a selected practice or assessment element, or sheet.

Note: Depending on your configuration of LEAD, you may not be able to delete the only

practice or assessment element under the Enabling Objective Level.

· View/Edit the Storyboard  for the test item, practice, or assessment element.

· View the Design Considerations for the Enabling Objective Level.

3.5.10   Storyboard

You can enter storyboard information, which allows you to detail how the content should be

implemented, especially for self-paced content that will be developed outside of this

software, at the Element and Page/Paragraph levels in LEAD. This includes the Front Matter

elements, as well as the Overview and Summary elements, along with all elements and test

items at the enabling objective level. On any screen that displays a Storyboard link, click that

link to display the Storyboard screen.

Once you've opened the Storyboard screen, you can:

· Select View Comments   to view, edit, and add to the comments for each tab.  

· Add a Text   entry to a selected tab (heading) and convert it to a Note, Caution,

Warning entry.

· Add a Resource   entry to a selected tab (heading).
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· Paste  a copied Text, Note, Caution, Warning, or Resource entry to the start of the list

of entries.

· Select Explain Flag   to review the reasons an item on the storyboard has been

flagged.

· View or download a Resource entry, if a link is shown and you have the correct software

available.

· Edit  a selected Text, Note, Caution, Warning, or Resource entry.

· Delete  a selected Text, Note, Caution, Warning, or Resource entry. Once you've

selected OK to the confirmation message, an Undo button displays on the bottom left of

the screen that allows you to revert the deletion.

· Copy /Paste  a selected Text, Note, Caution, Warning, or Resource entry.

· Move a selected Text, Note, Caution, Warning, or Resource entry Up  or Down  in

the list of entries to resequence the list of entries.

Select Close to close the Storyboard screen. 

You can Preview  the Storyboard from the Documents  folder, as well as any table of

contents item, except for Overview and Summary.

3.5.11   Adding or Editing a Text/Note/Caution/Warning Entry

You can view, add, or edit Text / Note / Caution / Warning entries in several places:

· Design Considerations 

· Sub-Element>: Page / Paragraph / Caution / Note / Warning

· Sheets

· Certain Test Items

· Storyboard

· Test Instructions

· Test Design Considerations

3.5.12   Adding a Resource Citation/Entry

You can add Resource citations as described below in several places: 

· Sub-Elements : Page / Paragraph / Caution / Note / Warning

220
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· Test Items , except for the Performance Job Sheet Test Item - Resources, Setup

Instructions, and Reference tabs.

· Sheets, for adding resource citations/entries on the other tabs, please see here .

o Diagram Sheet - Diagram tab.

o Information Sheet - Information tab.

o Job Sheet - Safety Precautions and Job Steps tabs.

o Outline Sheet - Outline tab.

o Problem Sheet - Directions tab.

· Storyboard .

· Test Instructions.

3.5.12.1   Working with IETM Table of Contents

Once you have selected the IETM on the Resource Selection screen, the IETM Selection screen

opens. 

Figure 71: IETM Selection Screen

On this screen you can select a node (or table of contents item) and then select:

·  to open the IETM to the selected node, provided you have the correct URL listed

in the IETM and any necessary software installed.

· Expand  to open up to five (5) levels of sub-folders of the IETM Table of Contents at a

time.

Note: You can also view the IETM Table of Contents on the Resources > IETMs screen, by

selecting the IETM in the list and then selecting View  in the toolbar.
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3.5.13   Editing a Resource Citation/Entry

You can view or edit Resource citations as described below in several places:

· Sub-Elements : Page / Paragraph / Caution / Note / Warning.

· Test Items , except for the Performance Job Sheet - Safety Precautions and Job Steps

tabs.

· Test Instructions.

· Storyboard .

3.5.14   Adding or Editing a Sheet Citation/Entry

You can view, add, or edit Sheet citations in several places:

· Sub-Elements - in Pages and Paragraphs

· Performance Test Items - for Resources and Setup Instructions

3.5.15   Cited Resources

This screen provides you with the ability to review, view and update any resources that are

cited anywhere below the selected table of contents item on the Develop tab. This screen

shows all the resources cited in:

· Sub-Element>: Page / Paragraph / Caution / Note / Warning

· Sheets

· Certain Test Items

· Storyboard

· Test Instructions

136
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Figure 72: Cited Resources

On this screen:

· Use the Type drop-down to limit the list of resources to a specific sub-category, as set up

on Customizations  screens. 

· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. Select  to clear the search term and view all items

again. 

· Select the Show Out-of-Date Resources Separately check box to see those outdated

resources at the top of the list grouped under: Items to Update. 

· Preview  the:

o All Resources spreadsheet listing all cited resources for the selected table of contents

item and all items below it in the tree structure. 

o Missing File Resources spreadsheet listing all IETMs with a Comparison File that is listed

with the IETM but cannot be found on the server and all IMMs with an Associated File

that is listed with the IMM but cannot be found on the server.

· View the different versions of a resource by clicking on the arrow  in the first column.

· Select a resource and then: 

o Preview  the:

228
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§ Related Materials Report that lists every place below the selected table of contents

item where the selected resource is cited or used.

§ Impact Report that lists every place below the selected table of contents item where

any previous version of the selected resource is cited or used.

§ All Resources spreadsheet listing all cited resources for the selected table of contents

item and all items below it in the tree structure. 

§ Missing File Resources spreadsheet listing all IETMs with a Comparison File that is

listed with the IETM but cannot be found on the server and all IMMs with an

Associated File that is listed with the IMM but cannot be found on the server.

o Update  to the latest version of a resource everywhere the selected resource is cited

below the selected table of contents item. So, if you selected a lesson, selecting Update

would only update to the latest version of the selected resource in that lesson and any

sections within that lesson, but not anywhere else that resource is cited within the

course.

o View  the resource information.

o Edit  the resource information if the resource is not approved.

Note: This will update the resource everywhere it is used in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.
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3.5.16   Cited Sheets

This screen provides you with the ability to view all the sheets that are listed anywhere below

the selected table of contents item on the Develop tab and whether they have been cited in a

sub-element. 

Figure 73: Cited Sheets

On the Cited Sheets screen, you can:

· See a list of the sheets that have been created for the selected table of contents item.

· View  a selected sheet.

3.5.17   Assessment

Assessments can be added under the Curriculum Development folder to be at the same level

as a Module (if you have that level in your initiative), or on the same level as a terminal or

enabling objective. You can select which enabling objectives will be tested in the assessment

in the Objectives tab, where you will see all objectives at the same level or below the selected

level in the tree structure. 
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Figure 74: Assessment

On this screen, you can:

· View the assessment information by selecting the assessment.

· Edit the information (including the title).

· Create a New Version of an approved Assessment, which will automatically also

version any unversioned parents (Terminal Objective Level/Lesson and/or Module Level). 

· Preview  the Assessment Test Items, or the Assessment Package, a zip file that contains

a preset number of Assessments and corresponding Answer Sheets, along with the

Testing Plan, Proctor Instructions, and any required Media (IMM) files.

Note: The Number of Assessment Object Tests to be generated in the Assessment

Package can be set on the Customizations > Configuration  tab, using the Number Of

Assessment Object Tests setting. 

Note: A Performance Assessment will not create multiple versions in the Assessment

Package.

· Select Explain Flag   to review the reasons the table of contents item has been

flagged.

· Lock  the table of contents item to prevent edits from taking place.

245
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· Unlock  a locked table of contents item to allow edits to take place again.

· Select View Comments   to view, edit, and add to the comments.  

· View the Test Design Considerations at every level that provide information about the

table of contents item to help with the development of the learning event.

3.5.18   Documents

Figure 75: Initiatives > Develop > Documents

Expand  the Documents folder to see the available options:

· Objective Assessment Information - a spreadsheet that contains the objectives along with

their assessment information, as detailed on the Objectives tab.

· Training Design Document - a PDF document of the table of contents items under the

Curriculum Development folder on the Design tab, along with the objectives, the design

considerations, assessment information, and the test design considerations. You can

choose whether to include any comments on the Output Options screen.

· Training Management Document - a PDF document of the information listed under the

Training Management Document, plus the table of contents items under the Curriculum

Development folder on the Design tab, along with the objectives. You can choose

whether to include any comments on the Output Options screen.

· Testing Plan - a PDF document of the information listed under the Testing Plan folder on

the Design tab. You can choose whether to include any comments on the Output Options

screen.

218
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· Training Outline - a spreadsheet listing the table of contents items under the Curriculum

Development folder on the Design tab, along with their status and their objectives. You

can choose whether to include any comments on the Output Options screen.

· Traceability Matrix - a spreadsheet listing the table of contents items under the

Curriculum Development folder on the Design tab, the objectives for each applicable

table of contents item, the skills of the task analysis that support the objectives, along with

the competencies that the skills are based on.

· Instructor Guide - a PDF document for the instructors to use to instruct/teach the

initiative. You can choose which of the delivery methods of the EO levels to include using

the Output Options, whether the main elements should output continuously or start per

page, as well as whether to include any comments.

· Participant Guide - a PDF document for the participants to use while being taught. You

can choose which of the delivery methods of the EO levels to include using the Output

Options, as well as whether to include any comments.

· Storyboard - a PDF document of all table of contents items, along with the elements, sub-

elements, test items, and any entered storyboard information. You can choose which of

the delivery methods of the EO levels to include using the Output Options, as well as

whether to include any comments.

Select the document you wish to create in the tree structure. Then select Preview  to

generate the document.

3.6 Implement

On the Implement screen, you can create outputs for a specific initiative. Simply find the

output you would like to generate. Select it in the list and select View . If an output has

options, they will show in the Output Options  screen for you to set as desired. 
208
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Figure 76: Initiatives > Implement

The outputs are organized in groups on the screen:

· Printed Guides - same output as found on the Develop tab.

o Instructor Guide - a PDF document for the instructors to use to instruct/teach the

initiative. You can choose which of the delivery methods of the EO levels to include

using the Output Options, whether the main elements should output continuously or

start per page, as well as whether to include any comments.

o Participant Guide - a PDF document for the participants to use while being taught. You

can choose which of the delivery methods of the EO levels to include using the Output

Options, as well as whether to include any comments.

· Training Packages - combined outputs to support teaching the content or for further

development.

o Instructor Guide Package - a zip file that includes the IG and IMM to use by the

instructors to instruct/teach the initiative. You can choose which of the delivery

methods of the EO levels to include using the Output Options, whether the main

elements should output continuously or start per page, as well as whether to include

any comments.

o Participant Guide Package - a zip file that includes the PG and IMM to use by the

participants while being taught. You can choose which of the delivery methods of the
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EO levels to include using the Output Options, as well as whether to include any

comments.

o Assessment Package - a zip file that contains a preset number of Assessments and

corresponding Answer Sheets, along with the Testing Plan, Proctor Instructions, and any

required Media (IMM files).

Note: The Number of Assessment Object Tests to be generated in the Assessment

Package can be set on the Customizations > Configuration  tab, using the Number Of

Assessment Object Tests setting. 

Note: A Performance Assessment will not create multiple versions in the Assessment

Package.

o ILT Package - a zip file that includes the IG, PG, IMM, Testing Plan, and Assessments.

You can choose which of the delivery methods of the EO levels to include using the

Output Options, whether the main elements should output continuously or start per

page, as well as whether to include any comments.

o SCORM Package - a SCORM-compliant zip file that can be imported to a Learning

Management System or used for further development in an e-learning tool.

· Management Documents - same output as found on the Analysis and Design tabs.

o Training Needs Analysis - a PDF document of the information contained in the Training

Needs Analysis folders, this will always output the current TNA, whether that's the first

TNA or the latest Modification TNA. You can choose whether to include any comments

on the Output Options screen.

o Training Management Document - a PDF document of the information listed under the

Training Management Document, plus the table of contents under the Curriculum

Development folder, along with the objectives. You can choose whether to include any

comments on the Output Options screen.

o Testing Plan - a PDF document of the information listed under the Testing Plan folder.

You can choose whether to include any comments on the Output Options screen.

· Management Reports - same output as found on the Analysis and Design tabs.

o Skill Hierarchy - a PDF document of the skill structure that is contained in the Task

Analysis folders. You can choose whether to include any comments on the Output

Options screen.

o Objective Assessment Information - a spreadsheet that contains the objectives along

with their assessment information, as detailed on the Objectives tab.

o Traceability Matrix - a spreadsheet listing the table of contents under the Curriculum

Development folder on the Design tab, the objectives for each applicable table of

245
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contents item, the skills of the task analysis that support the objectives, along with the

competencies that the skills are based on.

o All Comments - a PDF document that lists all comments that have been made by area in

the initiative. You can choose which comment statuses to include in the report on the

Output Options screen.

· Training Outline Documents - same output as found on the Design tab.

o Training Outline - a PDF document listing the table of contents under the Curriculum

Development folder, along with their status and their objectives. You can choose

whether to include any comments on the Output Options screen.

o Training Design Document - a PDF document of the table of contents items under the

Curriculum Development folder on the Design tab, along with the objectives, the design

considerations, assessment information, and the test design considerations. You can

choose whether to include any comments on the Output Options screen.

Finding Outputs

If you can't find the output you're looking for, enter a search term in the Find: field and select

Search. The table will list all output that contain your search term on the screen. Select  to

clear the search term and view all items again.

You can also sort the order of the output that is listed on the screen to find the relevant

output. You can click on the column headers of each table to sort the entries by that column.

Clicking on a column header again will reverse the sort. Clicking on the column header a third

time will remove the sort. Small arrows in the column header let you know which way the

data is currently sorted.
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Competencies

This chapter describes the competencies that are available in LEAD, that you can base
your task analysis on.
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4 Competencies

On this screen, you can review the competencies that form the basis of tasks, subtasks, and

steps (aka skills) in the task analysis of the initiative. Those skills are then used as the basis for

the learning objectives, which in turn are the basis for the content in the initiative.

In LEAD, we provide you with the Department of Labor (DOL) O*NET Tasks, Knowledge, Skills,

and Abilities listing, based on the DOL's Standard Occupational Classification (SOC). You may

wish to use the O*NET website: https://www.onetonline.org/ to find the relevant information

for your initiative. You can also review the occupational information directly in LEAD.

The DOL SOC classifies occupations at four levels of aggregation: Major Occupation, Minor

Occupation, Broad Jobs, and Jobs. These groups are reflected in the Type field in LEAD, while

the Major/Minor/Broad/Job Code is the specific code for that job or occupation. 

Figure 77: Competencies

On this screen:

· To make more room to see items in the tree structure, click and drag the bottom right

corner of the tree window (or frame). 

· To make even more room, click on the three-bar icon  next to LEAD in the header

bar to minimize the main menu to show only the icons. To see all of the menu items

again, click on the three-bar icon again.

· Select a folder and then Expand  to open up the folders up to three levels at a time:

o Selecting the O*Net folder and then Expand opens up to the Broad Jobs folders.

https://www.onetonline.org/
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o Selecting a Major Occupation folder and then Expand opens up to the Jobs folders

under the selected Major Occupation folder.

o Selecting a Minor Occupation folder and then Expand opens up to the Tasks of all Jobs

under the selected Minor Occupation folder.

o Selecting a Broad Job folder and then Expand opens up all entries of each Job, including

the Tasks, Knowledge, Skills, and Abilities under the selected Broad Jobs folder.
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Resources

This chapter describes the resources available in the software that you can add to and
reuse many times in your initiatives.
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5 Resources

Resources are all the things you use to support the delivery of a learning event. We

recommend that you include those resources that the instructor or facilitator needs to deliver

the learning event and whose costs you want or need to track. Resources are used or cited

extensively in initiatives, specifically, on the following screens:

· Analysis - in the Training Needs Analysis and the Task Analysis.

· Design - in the Training Management Document.

· Develop - in the initiative contents: pages and paragraphs, sheets, and test items.

On the Resources screens you can create and manage the following types of resources:

· Consumables  - any type of resource that is used up during the delivery of a learning

event, e.g., flip chart paper and pens.

· IETMs  - Interactive Electronic Technical Manuals that you can link to a specific node (or

table of contents entry) and launch directly to that specific node during a learning event.

· IMM  - Instructional Media Material are all types of media that can be used in a learning

event, including Microsoft® PowerPoint® slides, graphics, animations, simulations,

videos, and models (whether electronic or physical).

· Publications  - including instructions, manuals, books, articles, websites, and other

published materials.

· Software  - that is needed to deliver or that is used during the learning events, whether

used by the instructor, facilitator, or the participant.

· Tool/Equipment  - includes all tools or equipment that used during the learning event,

including hand tools, power tools, computers, maintenance trainers, and all other kinds of

training equipment.

You can set up the resource sub-categories on the Customizations  screens, to enable you

to define groups of resources within the main categories. 

5.1 Consumables

On the Consumables screen, you can create and manage the consumables that are used in

initiatives. Consumables are any type of resource that is used during the delivery of a learning

event and needs to be replenished or replaced at the end of the event, e.g., flip chart paper

and pens, or participant guides and handouts, or oil and oil filters. 
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Figure 78: Consumables

On the Consumables screen, you can:

· Add a  consumable to the existing list by selecting + New.

· Preview  the All Consumables spreadsheet listing all consumable entries with all the

details in LEAD for each entry, or the Unused Resources spreadsheet listing all

consumables that are not cited anywhere in LEAD.

· View and manage all unused consumables on the Unused Resource Management  

 screen.

· View the different versions of a consumable by clicking on the arrow  in the first column.

· Select a consumable and then: 

o Create a New Version  of an approved consumable, which will automatically flag all

initiatives and places within those initiatives where the selected consumable is cited or

used.

o Preview  the:

§ Related Materials Report that lists every initiative and place within each initiative

where the selected consumable is cited or used.

175
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§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected consumable is cited or used.

§ All Resources spreadsheet listing all consumable entries with all the details in LEAD for

each entry.

§ Unused Resources spreadsheet listing all consumables that are not cited anywhere in

LEAD.

o Replace   one consumable with another consumable in the list.

Note: This will replace the consumable everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the consumable information.

o To approve the consumable, select View  and review the information, then select

Approve. 

Note: Consumables are automatically approved when the initiative that cites/uses the

consumables is approved.

o Edit  the consumable information, as long as it has not been approved.

o Show History   to review the changes made to the consumable, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the consumable, if has not been cited in any initiative. Once you've selected

OK to the confirmation message, the Data Item Deletion screen displays. Enter the title

of the consumable to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier

on yourself. If you only enter a partial title, the item will not be deleted, and the Data

Item Deletion screen stays open, ready for you to try again.

5.2 IETMs

On the IETMs screen, you can add and manage the Interactive Electronic Technical Manuals

(IETMs) that are used in initiatives. The IETM extraction file can be imported into LEAD and

then referenced in the initiative down to a specific node (table of contents item). 
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Figure 79: IETMs

On the IETMs screen, you can:

· Add/Import a  IETM by selecting + New.

·  the IETM Table of Contents  by selecting View in the toolbar. This opens the

IETM screen listing the IETM Table of Contents. Select an IETM Table of Contents item or

node, then select:

o  to open the IETM to the selected node, provided you have the correct URL

listed in the IETM and any necessary software installed.

o Expand  to open up to five (5) levels of sub-folders of the IETM Table of Contents

at a time.

o Close to return to the IETMs screen.

· Preview  the:

o All IETMs spreadsheet listing all IETM entries with all the details in LEAD for each entry.

o Unused Resources spreadsheet listing all IETMs that are not cited anywhere in LEAD.
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o Missing File Resources spreadsheet listing all IETMs with a Comparison File that is listed

with the IETM but cannot be found on the server.

· View and manage all unused IETMs on the Unused Resource Management   screen.

· View the different versions of an IETM by clicking on the arrow  in the first column.

· Select an IETM and then: 

o Create a New Version  of an approved IETM, which will automatically flag all

initiatives and places within those initiatives where the selected IETM is cited or used.

o Preview  the:

§ Related Materials Report that lists every initiative and place within each initiative

where the selected IETM is cited or used.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected IETM is cited or used.

§ Missing File Resources spreadsheet listing all IETMs with a Comparison File that is

listed with the IETM but cannot be found on the server.

§ All Resources spreadsheet listing all IETM entries with all the details in LEAD for each

entry.

§ Unused Resources spreadsheet listing all IETMs that are not cited anywhere in LEAD.

o Replace   one IETM with another IETM in the list.

Note: This will replace the IETM everywhere it is used, including in approved initiatives!

Hence, you will only see Replace , when you have the Replace privilege as part of

your role.

o View  the IETM information by selecting View in the Actions column.

o To approve the IETM, select View  IETM and review the information, then select

Approve.

Note: IETMs are automatically approved when the initiative that cites/uses the IETMs is

approved.

o Edit  the IETM information, as long as it has not been approved.

o Show History   to review the changes made to the IETM, including the user name

and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the IETM, if has not been cited in any initiative. Once you've selected OK to

the confirmation message, the Data Item Deletion screen displays. Enter the title of the

IETM to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier
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on yourself. If you only enter a partial title, the item will not be deleted, and the Data

Item Deletion screen stays open, ready for you to try again.

5.3 IMM

On the IMM screen, you can create and manage the Instructional Media Materials (IMM) that

are used in initiatives. IMM are all types of media that can be used in a learning event,

including Microsoft® PowerPoint® slides, graphics, videos, models (electronic and physical),

and animations. 

Figure 80: IMM

On the IMM screen, you can:

· Add a  IMM to the existing list by clicking on + New.

· Preview  the:

o All IMM spreadsheet listing all IMM entries with all the details in LEAD for each entry.

o Unused Resources spreadsheet listing all IMM entries that are not cited anywhere in

LEAD.
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o Missing File Resources spreadsheet listing all IMMs with an Associated File that is listed

with the IMM but cannot be found on the server.

· View and manage all unused IMM on the Unused Resource Management   screen.

· View the different versions of an IMM by clicking on the arrow  in the first column.

· Select an IMM and then: 

o Create a New Version  of an approved IMM, which will automatically flag all

initiatives and places within those initiatives where the selected IMM is cited or used.

o Preview  the:

§ Related Materials Report that lists every initiative and place within each initiative

where the selected IMM is cited or used.

§ Missing File Resources spreadsheet listing all IMMs with an Associated File that is

listed with the IMM but cannot be found on the server.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected IMM is cited or used.

§ All Resources spreadsheet listing all IMM entries with all the details in LEAD for each

entry.

§ Unused Resources spreadsheet listing all IMMs that are not cited anywhere in LEAD.

o Replace   one IMM with another IMM in the list.

Note: This will replace the IMM everywhere it is used, including in approved initiatives!

Hence, you will only see Replace , when you have the Replace privilege as part of

your role.

o View  the IMM information. 

o To approve the IMM, select View  and review the information, then select Approve.

Note: IMMs are automatically approved when the initiative that cites/uses the IMMs is

approved.

o Edit  the IMM information, which includes the ability to Update the associated file, as

long as the IMM is not approved.

o Show History   to review the changes made to the IMM, including the user name

and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the IMM, if has not been cited in any initiative. Once you've selected OK to

the confirmation message, the Data Item Deletion screen displays. Enter the title of the

IMM to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier
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on yourself. If you only enter a partial title, the item will not be deleted, and the Data

Item Deletion screen stays open, ready for you to try again.

5.4 Publications

On the Publications screen, you can create and manage the publications that are used in

initiatives. Publications includes all information sources that are not purely media based (like

videos), e.g., books, articles, journals, magazines, manuals, instructions, newspapers, as well as

online information sources, like specific articles on websites or even entire websites (if

appropriate).

Figure 81: Publications

On the Publications screen, you can:

· Add a  publication to the existing list by clicking on + New.

· Preview  the All Publications spreadsheet listing all publication entries with all the

details in LEAD for each entry, or the Unused Resources spreadsheet listing all publications

that are not cited anywhere in LEAD.
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· View and manage all unused publications on the Unused Resource Management  

 screen.

· View the different versions of a publication by clicking on the arrow  in the first column.

· Select a publication and then: 

o Create a New Version  of an approved publication, which will automatically flag all

initiatives and places within those initiatives where the selected publication is cited or

used.

o Preview  the:

§ Related Materials Report that lists every initiative and place within each initiative

where the selected publication is cited or used.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected publication is cited or used.

§ All Resources spreadsheet listing all publication entries with all the details in LEAD for

each entry.

§ Unused Resources spreadsheet listing all publications that are not cited anywhere in

LEAD.

o Replace   one publication with another publication in the list.

Note: This will replace the publication everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View the publication information.

o To approve the publication, select View  and review the information, then select

Approve.

Note: Publications are automatically approved when the initiative that cites/uses the

Publications is approved.

o Edit  the publication information, as long as it has not been approved.

o Show History   to review the changes made to the publication, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the publication, if has not been cited in any initiative. Once you've selected

OK to the confirmation message, the Data Item Deletion screen displays. Enter the title

of the publication to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier

on yourself. If you only enter a partial title, the item will not be deleted, and the Data

Item Deletion screen stays open, ready for you to try again.
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5.5 Software

On the Software screen, you can create and manage the software that are used in initiatives,

whether by the participant or by the instructor. 

Figure 82: Software

On the Software screen, you can:

· Add a  software entry to the existing list by clicking on + New.

· Preview  the All Software spreadsheet listing all software entries with all the details in

LEAD for each entry, or the Unused Resources spreadsheet listing all software entries that

are not cited anywhere in LEAD.

· View and manage all unused software on the Unused Resource Management  

 screen.

· View the different versions of a software entry by clicking on the arrow  in the first

column.

· Select a software entry and then: 
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o Create a New Version  of an approved software entry, which will automatically flag

all initiatives and places within those initiatives where the selected software is cited or

used.

o Preview  the:

§ Related Materials Report that lists every initiative and place within each initiative

where the selected software is cited or used.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected software is cited or used.

§ All Resources spreadsheet listing all software entries with all the details in LEAD for

each entry.

§ Unused Resources spreadsheet listing all software entries that are not cited anywhere

in LEAD.

o Replace   one software with another software in the list.

Note: This will replace the software everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the software information.

o To approve the software, select View  and review the information, then select

Approve.

Note: Software entries are automatically approved when the initiative that cites/uses

the Software is approved.

o Edit  the software information, as long as it has not been approved.

o Show History  to review the changes made to the software, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the software, if has not been cited in any initiative. Once you've selected OK

to the confirmation message, the Data Item Deletion screen displays. Enter the title of

the software to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier

on yourself. If you only enter a partial title, the item will not be deleted, and the Data

Item Deletion screen stays open, ready for you to try again.
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5.6 Tools/Equipment

On the Tools/Equipment screen, you can create and manage the tools and equipment that are

used in initiatives. This includes all tools or equipment that are used during the learning event,

including hand tools, power tools, computers, maintenance trainers, and all other kinds of

training devices. 

Figure 83: Tools/Equipment

On the Tools/Equipment screen, you can:

· Add a  tool or piece of equipment to the existing list by clicking on + New.

· Preview  the All Tools/Equipment spreadsheet listing all tools and equipment entries

with all the details in LEAD for each entry, or the Unused Resources spreadsheet listing all

tools and equipment entries that are not cited anywhere in LEAD.

· View and manage all unused tools and equipment entries on the Unused Resource

Management   screen.

· View the different versions of a tool or piece of equipment by clicking on the arrow  in

the first column.

· Select a tool or piece of equipment and then: 
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o Create a New Version  of an approved tool or piece of equipment, which will

automatically flag all initiatives and places within those initiatives where the selected

tool or piece of equipment is cited or used.

o Preview  the:

§ Related Materials Report that lists every initiative and place within each initiative

where the selected tool or piece of equipment is cited or used.

§ Impact Report that lists every initiative and place within each initiative where any

previous version of the selected tool or piece of equipment is cited or used.

§ All Resources spreadsheet listing all tools and equipment entries with all the details in

LEAD for each entry.

§ Unused Resources spreadsheet listing all tools and equipment that are not cited

anywhere in LEAD.

o Replace   one tool or piece of equipment with another tool or piece of equipment

in the list.

Note: This will replace the tool or piece of equipment everywhere it is used, including

in approved initiatives! Hence, you will only see Replace , when you have the Replace

privilege as part of your role.

o View  the tool or piece of equipment information.

o To approve the tool or piece of equipment, select View  and review then

information, then select Approve.

Note: Tools or Equipment are automatically approved when the initiative that cites/uses

the Tools or Equipment is approved.

o Edit  the tool or piece of equipment information, as long as it has not been

approved.

o Show History   to review the changes made to the tool or piece of equipment,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

o Delete  the tool or piece of equipment, if has not been cited in any initiative. Once

you've selected OK to the confirmation message, the Data Item Deletion screen

displays. Enter the title of the tool or piece of equipment to confirm the deletion. 

Note: You can copy and paste the title from the screen into the field to make it easier

on yourself. If you only enter a partial title, the item will not be deleted, and the Data

Item Deletion screen stays open, ready for you to try again.
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5.7 Unused Resource Management

On the Unused Resource Management screen, you can view and remove resources that are

not cited anywhere in LEAD. This is independent of versions, so if versions 1 and 3 of a

publication are cited in initiatives and version 2 is not, then version 2 of the publication will be

listed on the Unused Resource Management screen and can be deleted/removed.

Note: When it comes to intervening versions of an IETM, where a later version has a

comparison file, you will get a message when you delete the IETM to remind you to check the

grouping and comparison files of the other versions of the IETM to ensure they are still

associated properly to each other.

Figure 84: Unused Resource Management Screen

On this screen:

· Use the Type drop-down to limit the list of resources to a specific category or sub-

category, as set up on Customizations  screens. 

· Enter a search term in the Find: field and select Search to list all resources that contain

your search term on the screen. Select  to clear the search term and view all items

again. 

· Export  a spreadsheet listing all unused resources regardless of the selected Type.

· View the different versions of a resource that are also unused (not cited) by clicking on

the arrow  in the first column.
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· Select a resource and then: 

o View  the resource information.

o Show History   to review the changes made to the consumable, including the user

name and date/time of saved changes.

o Remove the resource. This will remove the selected resource(s) from LEAD after

another check to ensure the selected resources are still not cited anywhere in LEAD.

You can click on the column header to sort the entries. Clicking on the column header again,

will reverse the sort. Small arrows in the column header let you know which way the data is

currently sorted.
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This chapter describes the library items available in LEAD that you can add to and reuse
many times in your initiatives.
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6 Library

On the Library screens, you can set up and manage the following:

· Verbs  - create and manage the verbs that are used the task analysis, whose skills form

the basis for the learning objectives in LEAD.

· Conditions  - create and manage the conditions that are used the task analysis, whose

skills form the basis for the learning objectives in LEAD.

· Standards  - create and manage the standards that are used the task analysis, whose

skills form the basis for the learning objectives in LEAD. 

· Knowledge  - create and manage the knowledge entries that are used in the task

analysis and which can also be used as the basis for learning objectives.

· Skills  - create and manage the skill entries that are used in the task analysis and which

can also be used as the basis for learning objectives.

· Abilities  - create and manage the ability entries that are used in the task analysis and

which can also be used as the basis for learning objectives.

· Interventions  - create and manage the existing interventions that are used to show

which skills are already being taught in existing learning events, particularly those outside

of LEAD. 

6.1 Verbs

On the Verbs screen, you can create and manage the verbs that are used for the skills in the

task analysis in LEAD. 
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Figure 85: Verbs

On the Verbs screen, you can:

· Add a  verb to the existing list by clicking on + New.

· Preview  the All Verbs spreadsheet listing all verbs entries with all the details in LEAD

for each entry.

· Select a verb and then: 

o Preview  the:

§ All Verbs spreadsheet listing all verbs entries with all the details in LEAD for each

entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected verb is cited or used.

o Replace   one verb with another verb in the list.

Note: This will replace the verb everywhere it is used, including in approved initiatives!

Hence, you will only see Replace , when you have the Replace privilege as part of

your role.

o View  the verb information.
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o To approve the verb, select View  and then select Approve.

Note: Verbs are automatically approved when the initiative that cites/uses the verbs is

approved.

o Edit  the verb information, as long as it has not been approved.

o Select Show History   to review the changes made to the verb, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the verb, if has not been cited in the task analysis of any initiative. Once

you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

6.2 Conditions

On the Conditions screen, you can create and manage the conditions that are used for the

skills in the task analysis in LEAD. 

Figure 86: Conditions

On the Conditions screen, you can:

· Add a  condition to the existing list by clicking on + New.
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· Preview  the All Conditions spreadsheet listing all conditions entries with all the details

in LEAD for each entry. 

· Select a condition and then: 

o Preview  the:

§ All Conditions spreadsheet listing all conditions entries with all the details in LEAD for

each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected condition is cited or used.

o Replace   one condition with another condition in the list.

Note: This will replace the condition everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the condition information.

o To approve the condition, select View  and then select Approve.

Note: Conditions are automatically approved when the initiative that cites/uses the

conditions is approved.

o Edit  the condition information, as long as it has not been approved.

o Select Show History   to review the changes made to the condition, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the condition, if has not been cited in the task analysis of any initiative. Once

you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

6.3 Standards

On the Standards screen, you can create and manage the standards that are used for the skills

in the task analysis in LEAD. 
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Figure 87: Standards

On the Standards screen, you can:

· Add a  standard to the existing list by clicking on + New.

· Preview  the All Standards spreadsheet listing all standards entries with all the details in

LEAD for each entry.

· Select a standard and then: 

o Preview  the:

§ All Standards spreadsheet listing all standards entries with all the details in LEAD for

each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected standard is cited or used.

o Replace   one standard with another standard in the list.

Note: This will replace the standard everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the standard information.
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o To approve the standard, select View  and then select Approve.

Note: Standards are automatically approved when the initiative that cites/uses the

standards is approved.

o Edit  the standard information, as long as it has not been approved.

o Select Show History   to review the changes made to the standard, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the standard, if has not been cited in the task analysis of any initiative. Once

you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

6.4 Knowledge

On the Knowledge screen, you can create and manage the knowledge entries that are used

for the skills in the task analysis in LEAD. In LEAD, we provide you with the Department of

Labor O*NET Knowledge listing, based on the Department of Labor's (DOL) Standard

Occupational Classification (SOC). These knowledge entries are already approved and used

on the Competencies screens, so they cannot be deleted. 
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Figure 88: Knowledge

On the Knowledge screen, you can:

· Add a  knowledge entry to the existing list by clicking on + New.

· Preview  the All Knowledge spreadsheet listing all knowledge entries with all the details

in LEAD for each entry.

· Select a knowledge entry and then: 

o Preview  the:

§ All Knowledge spreadsheet listing all knowledge entries with all the details in LEAD for

each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected knowledge entry is cited or used.

o Replace   one knowledge entry with another knowledge entry in the list.

Note: This will replace the knowledge entry everywhere it is used, including in

approved initiatives! Hence, you will only see Replace , when you have the Replace

privilege as part of your role.

o View  the knowledge entry.
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o To approve the knowledge entry, select View  and then select Approve.

Note: Knowledge entries are automatically approved when the initiative that cites/uses

the knowledge entries is approved.

o Edit  the knowledge entry, as long as it has not been approved.

o Select Show History   to review the changes made to the knowledge entry,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

o Delete  the knowledge entry, if has not been cited in the task analysis of any initiative,

or for a competency entry. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion. 

6.5 Skills

On the Skills screen, you can create and manage the skill entries that are used for the skills in

the task analysis in LEAD. In LEAD, we provide you with the Department of Labor O*NET Skills

listing, based on the Department of Labor's (DOL) Standard Occupational Classification (SOC).

These skill entries are already approved and used on the Competencies screens, so they

cannot be deleted. 
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Figure 89: Skills

On the Skills screen, you can:

· Add a  skill entry to the existing list by clicking on + New.

· Preview  the All Skills spreadsheet listing all skills entries with all the details in LEAD for

each entry.

· Select a skill entry and then: 

o Preview  the:

§ All Skills spreadsheet listing all skill entries with all the details in LEAD for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected skill is cited or used.

o Replace   one skill with another skill in the list.

Note: This will replace the skill everywhere it is used, including in approved initiatives!

Hence, you will only see Replace , when you have the Replace privilege as part of

your role.

o View  the skill entry.
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o To approve the skill, select View  and then select Approve.

Note: Skills are automatically approved when the initiative that cites/uses the skills is

approved.

o Edit  the skill entry, as long as it has not been approved.

o Select Show History   to review the changes made to the skill entry, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the skill entry, if has not been cited in the task analysis of any initiative. Once

you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

6.6 Abilities

On the Abilities screen, you can create and manage the ability entries that are used for the

skills in the task analysis in LEAD. In LEAD, we provide you with the Department of Labor

O*NET Abilities listing, based on the Department of Labor's (DOL) Standard Occupational

Classification (SOC). These ability entries are already approved and used on the

Competencies screens, so they cannot be deleted. 

Figure 90: Abilities
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On the Abilities screen, you can:

· Add a  ability entry to the existing list by clicking on + New.

· Preview  the All Abilities spreadsheet listing all abilities entries with all the details in

LEAD for each entry.

· Select an ability entry and then: 

o Preview  the:

§ All Abilities spreadsheet listing all abilities entries with all the details in LEAD for each

entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected ability is cited or used.

o Replace   one ability with another ability in the list.

Note: This will replace the ability everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the ability entry.

o To approve the ability entry, select View  and then select Approve.

Note: Abilities are automatically approved when the initiative that cites/uses the

abilities is approved.

o Edit  the ability entry, as long as it has not been approved.

o Select Show History   to review the changes made to the ability entry, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the ability entry, if has not been cited in the task analysis of any initiative.

Once you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

6.7 Interventions

On the Interventions screen, you can create and manage the existing interventions that are

used for the skills in the task analysis in LEAD. 
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Figure 91: Interventions

On the Interventions screen, you can:

· Add a  intervention to the existing list by clicking on + New.

· Preview  the All Interventions spreadsheet listing all interventions entries with all the

details in LEAD for each entry.

· Select an intervention and then: 

o Preview  the:

§ All Interventions spreadsheet listing all intervention entries with all the details in LEAD

for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected intervention is cited or used.

o Replace   one intervention with another intervention in the list.

Note: This will replace the intervention everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the intervention information.
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o To approve the intervention entry, select View  and then select Approve.

Note: Interventions are automatically approved when the initiative that cites/uses the

interventions is approved.

o Edit  the intervention information, as long as it has not been approved.

o Select Show History   to review the changes made to the intervention, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the intervention, if has not been cited in the task analysis of any initiative.

Once you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 
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Reports

This chapter describes how to generate the reports available in LEAD.
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7 Reports

On the Reports screen, you can create outputs from LEAD that are not tied to specific

initiatives. Simply find the report you would like to generate. Select it in the list and select

View . If a report has options, they will show in a pop-up window for you to select as

desired. 

Figure 92: Reports

The following reports are available:

· In the Customizations group:

o Locations/Lists Listing - a spreadsheet listing all initiative locations and all items found

under Customizations > Lists, each on their own tabs.
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· In the Departments group:

o All Departments - a spreadsheet listing all departments.

· In the Initiatives group:

o Restricted Users and their Initiatives - a PDF document listing all restricted users and the

initiatives they are assigned to on the Team Member screen.

o All Initiatives - a spreadsheet listing all initiatives, grouped by Departments and My

Initiatives, along with the Initiative State, Start and End Date information.

· In the Library group:

o All KSAs - a spreadsheet listing all KSAs that are in the Library, with Knowledge, Skills,

and Abilities each on their own tabs.

o All Conditions/Standards - a spreadsheet listing all Conditions, Standards, and Verbs on

separate tabs.

o All Interventions - a spreadsheet listing all Interventions that are in the Library.

· In the Resources group:

o All Resources - a spreadsheet listing all resources in LEAD along with their information,

with each resource category (Consumables, IETMs, IMM, Publications, Software, and

Tools/Equipment) listed on a separate tab.

o Unused Resources - a spreadsheet listing all resources in LEAD that have not been cited

or linked to in any initiative, with each resource category (Consumables, IETMs, IMM,

Publications, Software, and Tools/Equipment) listed on a separate tab; this allows users

to identify any resources that are not in use for possible deletion.

· In the Users group:

o User Listing - a spreadsheet listing all users in LEAD.

o Login History - a spreadsheet listing all LEAD logins within a specified date range.
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Admin

This chapter describes the administrative options available in LEAD.
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8 Admin

On the Admin screens, you can set up and manage the following:

· Announcements  - create and manage the announcements that show on the login

screen.

· Departments  - create and manage the departments in LEAD.

· Initiative Locations  - create and manage the learning event initiative locations for use

in initiatives.

· Users  - create and manage the users that have access to LEAD.

· Roles  - create and manage the roles that determine the privileges users have in LEAD.

· System Logs  - review and delete system logs.

· In-Use  - review and reset in-use data. 

· Licensing  - create and manage LEAD licenses.

8.1 Announcements

On the Announcements screen, you can create and manage the announcements that show on

the login screen and on the Announcements screen that you can access by selecting the

Announcement icon that displays between your user name and the help icon in the header

bar. Once you've reviewed the announcements, you can close the pop-up. There are three

types of Announcement icons:

·  - this icon displays when there are active announcements to view.

·  - this icon displays when there are unread/new announcements to view.

·  - this icon displays whenever there is a problem with the license for LEAD.
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Figure 93: Announcements

On the Announcements screen>, you can:

· Add a  announcement to the existing list by clicking on + New.

· Select an announcement and then: 

o View  the announcement information.

o Edit  the announcement information.

o Select Show History   to review the changes made to the announcement,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

o Delete  the announcement. Once you've selected OK to the confirmation message,

an Undo button displays on the bottom left of the screen that allows you to revert the

deletion.

8.2 Departments

On the Departments screen, you can create and manage the departments that are used in

LEAD. 
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Figure 94: Departments

On the Departments screen, you can:

· Add a  department to the existing list by clicking on + New.

· Preview  the All Departments Report that lists all departments with all the details in

LEAD for each department.

· Select a department and then: 

o Preview  the:

§ All Departments Report that lists all departments with all the details in LEAD for each

department.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected department is cited or used.

o Replace   one department with another department in the list.

Note: This will replace the department everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the department information.
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o Edit  the department information.

o Select Show History   to review the changes made to the department, including

the user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the department, if has not been cited anywhere (particularly in initiatives).

Once you've selected OK to the confirmation message, an Undo button displays on the

bottom left of the screen that allows you to revert the deletion. 

8.3 Locations

On the Locations screen, you can create and manage the locations that you can select from

when you add the initiative location to the TNA or TMD of the initiatives. 

Figure 95: Locations

On the Locations screen, you can:

· Add a  location to the existing list by clicking on + New.

· Preview  the All Locations Report that lists all locations with all the details in LEAD for

each locations.

210



200

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Admin

· Select a location and then: 

o Preview  the:

§ All Locations Report that lists all locations with all the details in LEAD for each

locations.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected department is cited or used.

o Replace   one location with another location in the list.

Note: This will replace the location everywhere it is used, including in approved

initiatives! Hence, you will only see Replace , when you have the Replace privilege as

part of your role.

o View  the location information.

o Edit  the location information.

o Select Show History   to review the changes made to the location, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the location, if has not been cited in any initiative. Once you've selected OK

to the confirmation message, an Undo button displays on the bottom left of the screen

that allows you to revert the deletion. 

8.4 Users

On the Users screen, you can create and manage the users in LEAD. Use Filter drop-down to

narrow down the list of users displayed. Depending on the Filter selected, you can perform

different actions on the users listed, including creating new users or deleting them. When you

select a user on this screen, you can:

· Make the user Active  or Inactive .

· Create a Copy  of a user with all information copied, except for the Information,

Administrative, and Preferences tabs.

· View the Login History  of the user.

· Change the Password  of the user.

· View  the user information.

· Edit  the user information.

209

210



201

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Admin

· Select Show History   to review the changes made to the user, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

8.5 Roles

On the Roles screen, you can create and manage the roles that give users their primary

privileges in LEAD. A user is assigned a role on the User screen. Initiatives have their own

privileges that you can set for each user. 

Figure 96: Roles

On the Roles screen, you can:

· Add a  role to the existing list by clicking on + New.

· Select a role and then: 

o View  the role information.

o Edit  the role information.

o Select Show History   to review the changes made to the role, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

210
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o Delete  the role. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

Note on Customizer: The Customizer role that you can assign on the Users screen is a LEAD

system role, which cannot be edited. Likewise, you cannot add privileges for the

Customizations screens on the Roles screen, as those can only be accessed with the

Customizer role. Users assigned the Customizer role do not count towards the licensed

number of users, regardless of license type.

Note on Reviewer: The Reviewer role that you can assign on the Users screen is another LEAD

system role, which cannot be edited. Users with the Reviewer role have View and Generate

privileges on the Initiatives, Competencies, Resources, Library, and Reports tabs. Users

assigned the Reviewer role count towards the licensed number of Reviewers (if a Reviewer

license is available) or Full licenses (if no Reviewer license is available).

Note on Review Privilege: The Review privilege that you can assign to a role you create,

allows someone to edit the initiative, when (and only when) that initiative is in Lock for Review

status.

8.6 System Logs

On the System Logs screen, you can review, export, and delete system logs that are

automatically generated when a change is made to a user, or when a problem occurs in LEAD.

 You need the System Logs privilege assigned to your role to see the System Logs entry

under the Admin tab. Whenever you get an error message in LEAD, that error message, along

with the detailed Stack Trace information, is saved in the system logs. This enables you to

forward the full error information to the LEAD support team to find a resolution. 
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Figure 97: System Logs

On this screen you can:

· Export /generate all system log entries to a spreadsheet for off-line review.

· Delete  system log entries.

· Select a system log entry and View  the system log information.

8.7 In-Use

On the In-Use screen, you can review and reset in-use data that may be preventing you or

another user from editing something in LEAD. Whenever you open an item in LEAD for

editing, that item is set to be in-use or locked, meaning other users cannot simultaneously

edit the same item. However, there are times when an item is locked when no one is actually

editing the item, i.e., the system hiccupped and didn't unlock the item, when it should have. 
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Figure 98: In-Use

8.8 Licenses

On the Licensing screen, you can review your existing license for LEAD and add a new license

when needed. 



205

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Admin

Figure 99: Licensing

On the Licensing screen, you can:

· Add a new license to the existing list by clicking on , entering the License Code

provided by Aimereon, Inc., and selecting Save. 

· Select a license and then: 

o View  the license information.

o Select Show History   to review the changes to the license, including the user

name and date/time when it was saved.

o Delete  the license.

You can click on the column headers of the table to sort the licenses by that column. Clicking

on a column header again will reverse the sort. Clicking on the column header a third time will

remove the sort. Small arrows in the column header let you know which way the data is

currently sorted.
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9 Common Actions

Some of the things you may do frequently and across multiple areas of LEAD are:

· Output Options  when selecting the Preview icon on various screens.

· Reviewing the History  of an item and possibly reverting to an earlier revision/saved

version of that item.

· Resequencing Items  on the screen, including item that are in a tree structure.

· Selecting Resources  for the TNA, TMD, and skills.

· Using the Text Editor . 

· Working with Business Rules .

· Working with Flags .

9.1 Output Options

The Output Options screen will display when you select Preview in the following places:

· Resource Management under the Initiative Management folder on the Analysis and

Design tabs and Cited Resources screens on the Develop tab.

· TNA or Skill Hierarchy on the Analysis or Implement tab, or the TMD, Testing Plan, TDD,

or Training Outline on the Design or Implement tab.

· TNA and TMD Resources screens under the Training Data and Initiative Locations folders.

· Develop tab, when selecting:

o An individual Table of Contents item 

o A Sheet

o An Assessment Object

o The Instructor Guide, Participant Guide, or Storyboard options under the Documents

folder

· Implement tab, when generating the Assessment Package, Instructor Guide, Participant

Guide, or packages that contain the IG, PG, or both.

· Implement tab, when generating the All Comments report.

· Library screens.

· Resources screens.
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· Login History report on the Reports  tab.

· User Listing report on the Reports  tab.

The Output Options screen may allow you to select the Document you wish to generate, and

may also give you additional options for your output.

9.2 Resequencing Items

Any time you see Resequencing  or , you can change the order of the items

underneath the selected item. When you select Resequencing, you see a list of items that you

can resequence (change the order of) simply by clicking and dragging individual items in the

order they should appear.

Figure 100: Resequencing Screen - Skills Example 

You can also use the Always Sort Alphabetically link to automatically sort all entries in

alphabetical order when that link is on the screen.

Once you've sorted everything to your satisfaction, select Save to save the changes. Selecting

Cancel will revert back to the previous order.

9.3 Replacing Resources, Library Items, Departments,

Locations, Customization List Items

Any time you see Replace , you can replace one item with another item in the list (select an

item and then Replace  to display the Replacement screen). When you save on the

Replacement screen, the Replace item will be replaced with the Replace With item

everywhere in LEAD. This includes approved initiatives!

Note: You will only see Replace , when you have the Replace privilege as part of your role.
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Figure 101: Replacement Screen

On the Replacement screen, you can:

· Select View  to view the full information about a selected Resource , Library  item,

Department , Location , or Customizations > List  item.

· Select Replace  to add an item to the Replace With field on the screen.

· Select Switch  to change the positions of the items listed under Replace and Replace

With.

· Use the Find: field to Search for items that match your search term. The table will list all

items that contain your search term on the screen. Select  to clear the search term and

view all items again.

9.4 Reviewing and Reverting History

Any time you see Show History  or , you can review the save history for the selected

item. 

162 178

197 199 227
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Figure 102: Revision Selection Screen

Each row in the table lists a saved revision of the item, along with the user name that saved

the change, and the date and time the change was saved. Selecting a row and then View 

will display that saved revision on the bottom of the screen, so you can review it. Revert 

allows you to go back to that saved revision. You will only see Revert, if the item is not

approved, and if you have the privileges to edit the item.

9.5 Selecting Resources for the TPP, TCCD, and Skills

On the Resource Selection screen: 

Figure 103: Resource Selection Screen for the TNA, TMD, and Skills

· Currently selected resources are listed at the start of the list.
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· Use the Type drop-down and the Find field to search for the resources to add. 

· View the different versions of a resource by clicking on the arrow  in the first column. 

· Select  to create a new resource based on the current selected Type: Consumables,

IETMs, IMM, Publications, Software, or Tools/Equipment. 

o Complete the fields of the new resource. 

o Select Save to keep the new resource. The newly created resource is shown as selected

at the top of the list.

o Select Cancel to return to the selection screen. 

· Select View  to view the resource information.

· Put a checkmark next to the resource(s) you wish to select (or unselect). You can select or

unselect multiple resources and resource types at a time.

· Select OK to save the selected resources, select Cancel to return to the previous screen.

Remember, you still have to save on that screen, selecting OK merely confirms your

resource selection. 

9.6 Using the Text Editor

You can use the icons and drop-downs of the text editor to manage how your content

appears, whether on-screen or in printed materials. Depending on you privilege level to a

certain area you may have three views available to you (buttons on the bottom of the text

area), if you do not see three buttons, then you do not have the privilege level required to

use the HTML or Preview views:

· Design - the default view, with active icons depending on what you have selected.

· HTML - for advanced users that want or need to tweak the output.

· Preview - to preview the end result.

In LEAD, you have the following options available:

Icon Description Shortcut

Applies bold formatting to selected text. Ctrl+B

Applies italic formatting to selected text. Ctrl+I
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Applies underline formatting to selected text. Ctrl+U

Applies strike-through formatting to selected text.

Converts the selected text to upper case, preserving the non-

text elements such as images and tables.

Converts the selected text to lower case, preserving the non-

text elements such as images and tables.

Aligns the selected paragraph to the left.

Aligns the selected paragraph to the center.

Aligns the selected paragraph to the right.

Sets the paragraph style.

Sets the font typeface.

Sets the font size. You can set the default font size on the

Customizations > Configuration  screen. 

Note: The default font size is Size 2 on the drop-down.

Changing the font size to Size 1 and saving the change, resets

the selected text to the default font size (even though you

can see the smaller text on screen prior to saving).

You can force smaller font sizes by:

· Selecting the text.

· Selecting font size 3 from the Font Size drop-down.

· Selecting the HTML tab and changing the font size to 9px

or smaller.

Note: Any font size between 10px and 12px resets to the

default automatically when you save the text.

Font sizes 3 to 7 are the same, regardless of the default font

size that was set up on the Configuration screen. For easy

reference, here are the comparative font sizes for each font

size:

· 1 - resets to default font size on save.

245
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· 2 - default font size - shows as 13px on the HTML tab

regardless of the default font size.

· 3 - shows as 16px on the HTML tab - about 13 pt.

· 4 - shows as 18px on the HTML tab - about 14 pt.

· 5 - shows as 24px on the HTML tab - about 18 pt.

· 6 - shows as 32px on the HTML tab - about 24 pt.

· 7 - shows as 48px on the HTML tab - about 36 pt.

Cuts the selected content and copies it to the clipboard. Ctrl+X

Copies the selected content to the clipboard. Ctrl+C

Pastes the copied content from the clipboard into the editor. Ctrl+V

Pastes the copied content from the clipboard into the editor

using one of the following options:

· Paste from Word - Pastes content copied from Word and

removes the web-unfriendly tags.

· Paste from Word, strip font - cleans all Word-specific tags

and removes font names and text sizes.

·  Paste Plain Text - Pastes plain text (no formatting) into the

editor.

·  Paste as HTML - Pastes HTML code in the content area and

keeps all the HTML tags.

·  Paste HTML - Pastes HTML content in to the editor.

Indents paragraphs to the right.

Indents paragraphs to the left.

Creates a bulleted list from the selected text.

Creates a numbered list from the selected text.

If you wish to change the type of list, first create your list,

then select </> HTML below the text editor and change the

<ol> code to:
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· <ol type="A"> for capital letters (A, B, C, etc.).

· <ol type="a"> for lower case letters (a, b, c, etc.).

· <ol type="I"> for capital roman numbers (I, II, III, etc.).

· <ol type="i"> for lower case roman numbers (i, ii, iii,

etc.).

Select Design below the text editor to see the results. 

If you wish to stop and start your list, create your lists first,

then select </> HTML below the text editor and change the

<ol> code for the lists you want to continue counting to:

<ol start="X"> where X is the number to start the list with

(in the case of a letter list, use the number represented by the

letter). 

For example, if you want to start the list with 3, then it would

state: <ol start="3">

Note: When you continue numbering, it may be easier to add

the desired starting number in your text until you update the

HTML code. Once you've verified that everything is OK, then

you can delete that number from your text. The number

makes it easier to find the text in the HTML code view. 

Also, the text editor may change some of the HTML code,

after you save it. So it may not look the same, but it should

still work as expected.

Undoes the last action. Selecting the drop-down allows you

to pick how many actions to undo.

Ctrl+Z

Redoes/Repeats the last action, which you just undid.

Selecting the drop-down allows you to pick how many

actions to redo.

Ctrl+Y

Format Painter allows you to:

· Copy the format of selected text.

· Apply the copied format to other text.

· Clear the format of selected text.

Changes the color of the selected text (the foreground).
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Changes the background color of the selected text.

Opens the Table options:

· Select number of rows and columns and insert a table of

that size.

· Table Wizard link has more options to configure a table.

· Insert Row Above - inserts a row above the selected row.

· Insert Row Below - inserts a row below the selected row.

· Delete Row - deletes the current selected row.

· Insert Column to the Left - inserts a column to the left of the

selected column.

· Insert Column to the Right - inserts a column to the right of

the selected column.

· Delete Column - deletes the current selected column.

· Merge Cells Horizontally - merges the selected cell with the

cell to the right.

· Merge Cells Vertically - merges the selected cell with the

cell below.

· Split Cell Horizontally - splits the selected cell into two cells

side by side.

· Split Cell Vertically - splits the selected cell into two cells

one above the other.

· Delete Cell - deletes the current selected cell.

· Table Properties - also opens the Table Wizard for options

to configure the selected table.

Makes a text subscript.

Makes a text superscript.

Inserts the selected symbol.

Prints the contents of the editor using the browser's print

functionality.

Ctrl+P
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Selects all the text in the editor. Ctrl+A

Inserts a page break at the cursor, which will force a page

break in the PDF output. 

9.7 Viewing Slides

The Slide Viewer displays any time you select the link for an IMM resource that has an

associated PowerPoint file. The Slide Viewer will display both from the Resources > IMM tab in

a new tab, when viewing an individual IMM, as well as from the Develop tab, when working

with a resource in an element, sheet, or test item. If you have a From Slide value set for the

IMM, then the Slide Viewer will start with that slide number.

Figure 104: Slide Viewer

When you select the link for the IMM resource that has an associated PowerPoint file, LEAD

will automatically create an image of each slide to display, which may take a little while. These

images will be saved for 7 days in the temporary file location, so the Slide Viewer will display

more quickly the second time you look at the slides. Once the images are ready, LEAD will

display them in the Slide Viewer, allowing you to view the slides without having to download

the PowerPoint file or launching PowerPoint itself.

When using the Slide Viewer, you have to following options:

· Download  the PowerPoint file.
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· Navigate to other slides using the arrows, or the thumbnails below the main slide.

· Play  the slide automatically.

· Go Full Screen  to see more details on the slides.

· Exit Full Screen  to return to the smaller Slide Viewer.

· Hide  the thumbnails.

· Show  the thumbnails.

9.8 Working with Business Rules

When you change the status or lock various items in an initiative, the business rules will run to

check whether anything is missing or incorrect for the item or any of its children. This includes

the following items in LEAD: 

· the initiative itself when editing on the Initiatives > Initiatives screen and the

Analysis/Design > Initiative Management screens.

· the TNA and TMD.

· all skills under the Training Needs Analysis folder.

· all objectives.

· the table of contents items on the Develop tab, e.g., the course and individual modules,

lessons, sections, and assessments.

The business rules will also run when you export or generate a SCORM Package of the

initiative on the Implement tab. You can select which business rules run for which action or

change of status on the Customizations  tab. When an item fails one of more business rules,

the Business Rules Results screen pops-up notifying you of the items that need to be fixed.

9.9 Working with Comments

You will see the Comments screen whenever you select the  above the tree structure in

any tab of the initiative, the  at the top of a pop-up screen, the  in a tab header, or the

 in a table (for the example on the Objectives screen). Comments can be added to most

things in your initiative. You will see an option to include comments on the Output Options

screen for initiative outputs that come in PDF format. On the Comments screen you can:

244
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· Add a new   comment.

· Paste  a copied comment to the end of the list of comments, making the pasted

comment your comment.

· Copy /Paste  a selected comment, making the pasted comment your comment.

· Move a selected comment Up  or Down  in the list of comments to resequence the

list of comment.

For your comments, you can do the above and:

· Edit   your comments.

· Delete  your comments. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion. 

If you are a Team Member  for the initiative, you can do the above and: 

· Edit   the Status field of someone else's comment.

If you are the initiative Owner  or are an initiative administrator (i.e., you have the

administer privilege for initiatives as part of your role), then you can the above and:

· Edit   the Priority field in addition to the Status field of someone else's comment.

· Delete  a selected comment. Once you've selected OK to the confirmation message, an

Undo button displays on the bottom left of the screen that allows you to revert the

deletion. 

Select  in the top right of the screen to close the Comments screen.
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Figure 105: Comments Screen

9.10 Working with Flags

LEAD uses various flags to alert you to new versions of resources in you initiatives, as well as

changes to your initiative content, after you have approved the initiative. 

Explain Flag Screen and Deleting Flags

Any time you see Explain Flag, either above the tree structure, in a table, or next to a citation,

you can review the flag or flags for the selected item. When you select Explain Flag, you see a

list of flags that apply to the selected item or any of its subordinates. Flags on subordinate

items are listed in the Inherited Flags tab, while flags for the selected item are listed in the

Item Flags tab.
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Flag Detail Screen - Initiatives > Initiatives Screen Example

You can delete a selected flag by selecting Delete . Deleting an inherited flag will delete all

of the selected flag type on the subordinate items. So, if you delete an inherited new version

flag, then that flag is deleted from all subordinate items. Once you've finished reviewing the

flags, select Close to close the pop-up.

Where Flags Can Be Found

A ‘flag’ on an item indicates the item itself is flagged. An ‘inherited’ flag on an item indicates a

child item of that item has a flag. Inherited flags apply specifically to tree-like items like skills,

table of contents items, sheets, or elements and sub-elements. You will see flags in the

following areas:

· Initiatives > Initiatives screen, in the list of initiatives, which will show inherited flags and

deleted objective flags.

· Analysis tab: 

o TNA and the Training Data, Initiative Locations and their respective Resources screens,

which will show item and inherited flags.

o Task Analysis and the skills under that folder, which will show item and inherited flags.
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· Objectives tab, in the list of objectives.

· Design tab:

o TMD and the Training Data, Initiative Locations and their respective Resources screens,

which will show item and inherited flags.

o Curriculum Development and all table of contents items under that folder, which will

show item and inherited flags.

· Develop tab and all items under the initiative folder, which will show item and inherited

flags.

Types of Flags and Order of Precedence

This is the list of flags in LEAD, in order of precedence (so, if you have multiple flags for an

item, the color of the flag is determined by which flag is higher in this list). 

Note: The order of precedence and color for each flag (green, orange, red, or yellow) can be

customized using the Flag Group  option on the Customization > Default Text screen.

1. New Version  - This flag is added, when a new version of a resource has been created

that is being cited by the item. 

Note: When you Update  to the latest version, the New Version flag changes to a

System flag.

2. System  - These flags help identify when something an item is linked to has changed

and, thus, needs to be reviewed:

§ Updated Skill - This flag is added to an objective when the skill the objective is based

on has been modified.

§ Updated Objective - This flag is added to a table of contents item when the objective

the table of contents item is based on has been modified; for example, if the enabling

objective has changed, the section that uses the EO is flagged.

§ Updated Resource - This flag is added to all citations of a resource when the resource

is updated  to the latest version. 

Note: When you edit a citation with a System flag and save the change, the System

flag changes to a User Edited flag in initiatives that are at version 2 or higher. The

System flag is removed in the first version of an initiative.

3. User Edited  - These flags are only added to initiatives that are at version 2 or higher:

§ Deletion - This flag is added when something was deleted underneath the selected

item (for objectives and tree-like items only, like skills, TNA / TMD initiative locations,

table of contents items, sheets, or elements and sub-elements).
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§ Edited - This flag is added to an item when the item was modified in a new version of

the initiative. 

§ Resequence - This flag is added when the items underneath the selected item have

been resequenced (for objectives and tree-like items only, like skills, table of contents

items, sheets, or elements and sub-elements).

4. User Created  - This flag is only added to initiatives that are at version 2 or higher.

This flag is added to an item when the item is created in a new version of the initiative. 

Note: The created flag will not change to an edited flag when you edit the item; you

have to remove the created flag in order to get an edited flag on further edits.
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Customizations

A special group of users can customize certain features of LEAD. This chapter details
what can be customized in LEAD.
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10 Customizations

Only designated users with a Customizer role have access to the Customizations screens,

where they can customize your LEAD experience. This includes the following:

· Under Reports - select  to generate the Locations/Lists Listing spreadsheet that details

all initiative locations and list items for easy review.

· Under Customization > Lists :

o Resource Sub-Categories  - to manage the resource sub-categories.

o Proficiency Levels  - to manage the proficiency levels that display in the task analysis

and for the objectives, for each of the three learning domains (cognitive, affective, and

psychomotor).

o Task Analysis Content  - to manage the task analysis content that shows on the

Training Task Analysis sub-tab for the tasks, subtasks, and steps in the task analysis for

any initiative.

o Schedule Event Types  - to manage the events that can be chosen for a schedule in

the Training Management Document on the Design tab of any initiative.

o Comment  - manage the options that display on the Comment screen, specifically

the:

§ Status  drop-down for a comment.

§ Priority  drop-down for a comment.

o Before Text  - to manage the options that display before a resource on the Develop

tab of any initiative.

o Intervention Types  - to manage the options that display on the Type drop-down on

the Library > Interventions screen.

o Status of Training - to manage the options that display on the Status of Training

drop-down on the main sub-tab for the tasks, subtasks, and steps in the task analysis

for any initiative.

o Type of Training  - to manage what shows on the screen that opens when you select

the Type of Training link on the main sub-tab for the tasks, subtasks, and steps in the

task analysis for any initiative.

o Test Item Delivery  - to manage what shows on the Test Item Delivery drop-down on

the test item editing screen on the Initiatives > Develop tab.

· Customization > Business Rules  - to manage the business rules that apply when you

change the Status of an item.
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· Customization > Configuration  - to manage admin settings.

· Customization > Default Text  - to manage the default text that displays in some

initiative documents, as well as standard system email messages.

10.1 Lists

On the Customizations > Lists screens, you can customize your LEAD experience. This includes

the following:

· Resource Sub-Categories  - to manage the resource sub-categories.

· Proficiency Levels  - to manage the proficiency levels that display in the task analysis

and for the objectives, for each of the three learning domains (cognitive, affective, and

psychomotor).

· Task Analysis Content  - to manage the task analysis content that shows on the

Training Task Analysis sub-tab for the tasks, subtasks, and steps in the task analysis for

any initiative.

· Schedule Event Types  - to manage the events that can be chosen for a schedule in the

Training Management Document on the Design tab of any initiative.

· Comment  - manage the options that display on the Comment screen, specifically the:

o Status  drop-down for a comment.

o Priority  drop-down for a comment.

· Before Text  - to manage the options that display before a resource on the Develop tab

of any initiative.

· Intervention Types  - to manage the options that display on the Type drop-down on the

Library > Interventions screen.

· Status of Training - to manage the options that display on the Status of Training drop-

down on the main sub-tab for the tasks, subtasks, and steps in the task analysis for any

initiative.

· Type of Training  - to manage what shows on the screen that opens when you select

the Type of Training link on the main sub-tab for the tasks, subtasks, and steps in the task

analysis for any initiative.

· Test Item Delivery  - to manage what shows on the Test Item Delivery drop-down on

the test item editing screen on the Initiatives > Develop tab.
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10.1.1   Resource Sub-Categories

On the Resource Sub-Categories screens, you can customize what shows on the Type drop-

downs for the resources in LEAD. You can edit entries for the following existing resource

groupings: 

· Consumables

· IETMs (Interactive Electronic Technical Manuals)

· IMM (Instructional Media Materials)

· Publications

· Software

· Tool/Equipment

LEAD comes with some common resource sub-categories predefined, that you can change

and update as needed.

Figure 106: Resource Sub-Categories - Consumables Example

For each of the categories, you can:

· Add a  entry to the existing list by selecting + New.  

· Preview  the All [selected Resource Sub-Category] Report that lists all resource sub-

category entries with all the details in LEAD for each entry.

· Select a resource sub-category and then: 
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o Preview  the:

§ All [selected Resource Sub-Category] Report that lists all resource sub-category

entries with all the details in LEAD for each entry.

§ Related Materials Report that lists every resource where the selected resource sub-

category is cited or used.

o Replace   one resource sub-category with another resource sub-category in the

list.

Note: This will replace the resource sub-category everywhere it is used, including in

approved initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.2   Proficiency Levels

On the Proficiency Levels screens, you can customize what is shown on the Proficiency Level

drop-down on the Task, Subtask, of Step sub-tab in the task analysis for any initiative, as well

as on the Assessment subtab for enabling and terminal objectives. The proficiency levels are

listed from lowest level to highest level in the drop-down on those screens. You can edit

entries for the following learning domains:

· Cognitive - based on Bloom's revised taxonomy for the cognitive learning domain that

covers mental skills and knowledge.

· Affective - based on Krathwohl's taxonomy (an adaptation of Bloom's taxonomy) for the

affective learning domain that covers emotional growth and feelings.

· Psychomotor - based on Atkinson's adaptation of Dave's taxonomy for the psychomotor

learning domain that covers manual or physical skills.
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Figure 107: Proficiency Levels - Cognitive Example

For each of the learning domains, you can:

· Add a  entry to the existing list by selecting + New. 

· Resequence   the entries.

· Preview  the All Proficiency Levels Report that lists all proficiency level entries with all

the details in LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All Proficiency Levels Report that lists all proficiency level entries with all the details in

LEAD for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected proficiency level is cited or used.

o Replace   one proficiency level with another proficiency level in the list.

Note: This will replace the proficiency level everywhere it is used, including in approved

initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.
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o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.3   Task Analysis Content

On the Task Analysis Content screens, you can customize what shows on the drop-downs on

the Task Analysis sub-tab for the tasks, subtask, and steps in the task analysis for any initiative.

You can edit entries for the following existing categories:

· Safety Hazard Severity

· Criticality of Performance

· Task Delay Tolerance

· Frequency of Performance

· Probability of Inadequate Performance

· Difficult of Performance

· Task Learning Difficulty

· Percent Performing

· Percent of Time Spent on Performance

· Immediacy of Performance

These categories are based on the Department of Defense Handbook: Instructional Systems

Development/Systems Approach to Training and Education, MIL-HDBK-29612-2 Chapter

6.8.1. 
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Figure 108: Task Analysis Content - Safety Hazard Severity Example

For each of the categories, you can:

· Add a  entry to the existing list by selecting + New. 

· Resequence   the entries.

· Preview  the All [selected Task Analysis Content] Report that lists all the selected Task

Analysis Content entries with all the details in LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All [selected Task Analysis Content] Report that lists all the selected Task Analysis

Content entries with all the details in LEAD for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected Task Analysis Content is cited or used.

209
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o Replace   one task analysis content with another task analysis content in the list.

Note: This will replace the task analysis content everywhere it is used, including in

approved initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.4   Schedule Event Types

On the Schedule Event Types screens, you can customize what shows in the:

· Type drop-downs on the schedule, under the Training Management Document on the

Design tab of any initiative.

· Test Type drop-down for assignments on both the Design and Develop tabs of any

initiative.

You can edit entries for the following schedule event types:

· Class Types - for theoretical and cognitive events, like lectures or discussions.

· Laboratory Types - for skill and psychomotor events, like shop or field work.

· Assessment Types - for all assessment or test events that are graded (non-graded

assessments like quizzes can be created under Theory or Laboratory).

· Other Types - for all other events that you need to account for in your schedule, like

administrative time or lunch.
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Figure 109: Schedule Event Types - Assessment Types Example

For each of the schedule event types, you can:

· Add a  entry to the existing list by selecting + New. 

· Preview  the All [selected Schedule Event Type] Report that lists all the selected

Schedule Event Type entries with all the details in LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All [selected Schedule Event Type] Report that lists all the selected Schedule Event

Type entries with all the details in LEAD for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected Schedule Event Type is cited or used.

o Replace   one schedule event type with another schedule event type in the list.

Note: This will replace the schedule event type everywhere it is used, including in

approved initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.
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o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.5   Comments

On the Comments screens, you can customize what shows in the:

· Statuses  drop-down on all comment screens.

· Priorities  drop-down on all comment screens.

10.1.5.1   Statuses
On the Statuses screen, you can customize what shows in the Status drop-down for all

comments.

Figure 110: Statuses

On the Statuses screen, you can:

· Add a  entry to the existing list by selecting + New.

· Resequence   the entries.

· Preview  the All Statuses Report that lists all the Status entries with all the details in

LEAD for each entry.

· Select an entry and then: 

235

236

209



236

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Customizations

o Preview  the:

§ All Statuses Report that lists all the Status entries with all the details in LEAD for each

entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected status is cited or used.

o Replace   one status with another status in the list.

Note: This will replace the status everywhere it is used, including in approved

initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.5.2   Priorities
On the Priorities screen, you can customize what shows in the Priority drop-down for all

comments.

Figure 111: Priorities

On the Priorities screen, you can:

· Add a  entry to the existing list by selecting + New.
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· Resequence   the entries.

· Preview  the All Priorities Report that lists all the priority entries with all the details in

LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All Priorities Report that lists all the priority entries with all the details in LEAD for each

entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected priority is cited or used.

o Replace   one priority with another priority in the list.

Note: This will replace the priority everywhere it is used, including in approved

initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.6   Before Text

On the Before Text screen, you can customize what shows on the Before Text drop-downs

when you cite a resource on the Develop tab of any initiative, in a page or paragraph, on a

sheet, or in a test item. 
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Figure 112: Before Text

You can:

· Add a  entry to the existing list by selecting + New.

· Resequence   the entries.

· Preview  the All Before Text Report that lists all the before text entries with all the

details in LEAD for each entry.

· Select an entry and then: 

o Preview  the All Before Text Report that lists all the before text entries with all the

details in LEAD for each entry.

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 
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10.1.7   Intervention Types

On the Intervention Types screen, you can customize what shows on the Type drop-down on

the Library > Interventions screen. 

Figure 113: Intervention Types

You can:

· Add a  entry to the existing list by selecting + New.

· Resequence   the entries.

· Preview  the All Intervention Types Report that lists all the intervention type entries with

all the details in LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All Intervention Types Report that lists all the intervention type entries with all the

details in LEAD for each entry.

§ Related Materials Report that lists every intervention where the selected intervention

type is cited or used.
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o Replace   one intervention type with another intervention type in the list.

Note: This will replace the intervention type everywhere it is used, including in

approved initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.8   Status of Training

On the Status of Training screen, you can customize what shows on the Status of Training

drop-down on the main sub-tab for the tasks, subtasks, and steps in the task analysis for any

initiative. 

Figure 114: Status of Training

You can:

· Add a  entry to the existing list by selecting + New.

· Resequence   the entries.

· Preview  the All Status of Training Report that lists all the status of training entries with

all the details in LEAD for each entry.
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· Select an entry and then: 

o Preview  the:

§ All Status of Training Report that lists all the status of training entries with all the

details in LEAD for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected status of training is cited or used.

o Replace   one status of training entry with another status of training entry in the

list.

Note: This will replace the status of training entry everywhere it is used, including in

approved initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.9   Types of Training

On the Types of Training screen, you can customize what shows on the screen that opens

when you select the Types of Training link on the main sub-tab for the tasks, subtasks, and

steps in the task analysis for any initiative. 
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Figure 115: Types of Training

You can:

· Add a  entry to the existing list by selecting + New.

· Resequence   the entries.

· Preview  the All Types of Training Report that lists all the type of training entries with all

the details in LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All Types of Training Report that lists all the type of training entries with all the details

in LEAD for each entry.

§ Related Materials Report that lists every initiative and place within each initiative

where the selected type of training is cited or used.

o Replace   one type of training with another type of training in the list.

Note: This will replace the type of training everywhere it is used, including in approved

initiatives! 

o View  the entry information. 

o Edit  the entry information.
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o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.1.10   Test Items Delivery

On the Test Items Delivery screen, you can customize what shows on the Test Item Delivery

drop-down on the test item editing screen on the Initiatives > Develop tab. 

Figure 116: Test Items Delivery

On the Test Items Delivery screen, you can:

· Add a  entry to the existing list by selecting + New.

· Resequence   the entries.

· Preview  the All Test Item Delivery Report that lists all the test items delivery entries

with all the details in LEAD for each entry.

· Select an entry and then: 

o Preview  the:

§ All Test Item Delivery Report that lists all the test items delivery entries with all the

details in LEAD for each entry.
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§ Related Materials Report that lists every initiative and place within each initiative

where the selected test item delivery is cited or used.

o Replace   one test item delivery with another test item delivery in the list.

Note: This will replace the test item delivery everywhere it is used, including in

approved initiatives! 

o View  the entry information. 

o Edit  the entry information.

o Select Show History   to review the changes made to the entry, including the user

name and date/time of saved changes, and revert to an earlier saved revision.

o Delete  the entry. Once you've selected OK to the confirmation message, an Undo

button displays on the bottom left of the screen that allows you to revert the deletion. 

10.2 Business Rules

On the Business Rules screen, you can select which business rules will run for which action(s)

or change(s) in status of various items in an initiative, including:

· the initiative itself when editing on the Initiatives > Initiatives screen and the

Analysis/Design > Initiative Management screens.

· the TNA and TMD.

· all skills under the Training Needs Analysis folder.

· all objectives.

· the table of contents items on the Develop tab, e.g., the course and individual modules,

lessons, sections, and assessments.
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Figure 117: Business Rules

For each business rule, you can select an entry and then:

· View  the business rule. 

· Edit  the business rule.

· Select Show History   to review the changes made to the configuration entry,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

10.3 Configuration

On the Configuration screen, you can set up the details for a specific LEAD instance/install.

This includes the settings for the system administrator email address, time limits, and email

server settings, among several others. 

210
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Figure 118: Configuration

The configuration settings are organized in groups on the screen:

· User Account - includes options for restricted access for new users and how to handle

deleted users.

· Email - includes the settings for email, whether to allow LEAD to send automated emails,

as well as the email addresses to use for the LEAD administrator(s). If the email addresses

don't pass validation, you will see an announcement to notify you of the problem.

· Versioning Options - includes the default options to be checked, when a user versions the

initiative.

· Printing - includes the font and font size to use when generating outputs from LEAD.

· Directories - includes the location for web-based help, when installed in a non-standard

location.

· Debugging - includes options for debugging issues in LEAD. Please only change these

when directed by Aimereon, Inc.

· Program - includes various options for LEAD, including the number of tests to create

when generating output packages like the ILT Package.

· Housekeeping - includes options on how long to retain the debug files.
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· Delay Actions - includes options on how long the undo message stays on screen.

· Other - includes additional debugging options. 

For each of the configuration entries, you can select an entry and then:

· View  the configuration information. 

· Edit  the configuration entry. 

· Select Show History   to review the changes made to the configuration entry,

including the user name and date/time of saved changes, and revert to an earlier saved

revision.

10.4 Default Text

On the Default Text screen, you can customize the , as well as the following:

· Configuration Files:

o Streaming MIME Types - to determine whether IMM audio or video files download or

play automatically when you click on the hyperlink of the IMM. 

· Email Documents, including the:

o default text that displays for the standard system email messages.

o Email Signature used in all emails, unless changed for a specific email.

· Assessment instructions that display when you select the Test Instructions link:

o Proctor Instructions.

o Participant (Student) Instructions.

· Content Type Wizard that displays when you select the Decision Wizard for the Content

Type when editing the enabling objective or the EO Level:

o Content Type - instructions for using the wizard.

o Content Type Wizard Data - including the examples that are used in the wizard.

210
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Figure 119: Default Text

For each of the default text areas, you can select an entry and then:

· View  the default text. 

· Edit  the default text. 

· Select Show History   to review the changes made to the default text, including the

user name and date/time of saved changes, and revert to an earlier saved revision.

210



249

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Table of Figures

Figure 1: Login Screen ................................................................................................................................................. 16

Figure 2: Reset My Password Screen ......................................................................................................................... 17

Figure 3: Help Menu ................................................................................................................................................... 18

Figure 4: Contact Us ................................................................................................................................................... 19

Figure 5: [Your User Name] Menu ............................................................................................................................. 20

Figure 6: Dashboard ................................................................................................................................................... 22

Figure 7: Milestones ................................................................................................................................................... 23

Figure 8: Assignments ................................................................................................................................................ 24

Figure 9: Initiatives > Initiatives ................................................................................................................................. 26

Figure 10: Initiatives > Analysis ................................................................................................................................. 28

Figure 11: Analysis/Design > Initiative Management ............................................................................................... 29

Figure 12: Initiative Management > Team Members ............................................................................................... 30

Figure 13: Initiative Management > Assignments .................................................................................................... 30

Figure 14: Initiative Management > Resource Management ................................................................................... 32

Figure 15: Analysis > Training Needs Analysis .......................................................................................................... 34

Figure 16: TNA > Justification .................................................................................................................................... 36

Figure 17:  TNA/TMD > Initiative Overview ............................................................................................................... 37

Figure 18: TNA > Milestones ...................................................................................................................................... 38

Figure 19: TNA > Safety Risks and Hazardous Materials .......................................................................................... 39

Figure 20: TNA/TMD > Target Audience .................................................................................................................... 40

Figure 21: TNA/TMD > Qualification Earned ............................................................................................................. 41

Figure 22: TNA/TMD > Associated Learning Events .................................................................................................. 42

Figure 23: TNA/TMD > Training Data ......................................................................................................................... 43

Figure 24: TNA/TMD > Training Data > Facilities ...................................................................................................... 44

Figure 25: TNA/TMD > Training Data > Funding ....................................................................................................... 45

Figure 26: TNA/TMD > Training Data > Personnel .................................................................................................... 47

Figure 27: TNA/TMD > Training Data > Resources .................................................................................................... 48

Figure 28: TNA/TMD > Initiative Locations ............................................................................................................... 50

Figure 29: TNA/TMD > [Selected] Initiative Location ................................................................................................ 51

Figure 30: TNA/TMD > Initiative Location > Facilities ............................................................................................... 52

Figure 31: TNA/TMD > Initiative Location > Funding ................................................................................................ 54

Figure 32: TNA/TMD > Initiative Location > Personnel ............................................................................................ 56

Figure 33: TNA/TMD > Initiative Location > Resources ............................................................................................ 57

Figure 34: Analysis > Task Analysis ............................................................................................................................ 59

Figure 35: Task Analysis > Job .................................................................................................................................... 61

Figure 36: Task Analysis > Duty .................................................................................................................................. 63

Figure 37: Task Analysis > Task .................................................................................................................................. 65

Figure 38: Task Analysis > Subtask ............................................................................................................................ 67

Figure 39: Task Analysis > Step .................................................................................................................................. 69

Figure 40: Task Analysis > Competency Selection Screen ........................................................................................ 71



250

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Table of Figures

Figure 41: Analysis > Documents ............................................................................................................................... 72

Figure 42: Initiatives > Objectives .............................................................................................................................. 73

Figure 43: Initiatives > Design .................................................................................................................................... 76

Figure 44: Design > Training Management Document ............................................................................................. 82

Figure 45: TMD > Foreword ........................................................................................................................................ 83

Figure 46: TMD > Changes from Previous Version .................................................................................................... 84

Figure 47: TMD > Purpose of Initiative ...................................................................................................................... 86

Figure 48: TMD > Training Data > Schedule .............................................................................................................. 91

Figure 49: TMD > Initiative Locations > [Selected Initiative Location] > Schedule ................................................ 101

Figure 50: Design > Curriculum Development ......................................................................................................... 109

Figure 51: Curriculum Development > Course Level ............................................................................................... 111

Figure 52: Curriculum Development > Module Level ............................................................................................. 112

Figure 53: Curriculum Development > Terminal Objective Level ........................................................................... 114

Figure 54: Curriculum Development > Overview or Summary ............................................................................... 116

Figure 55: Curriculum Development > Enabling Objective Level ........................................................................... 118

Figure 56: Curriculum Development > Assessment ................................................................................................ 119

Figure 57: Design > Testing Plan .............................................................................................................................. 121

Figure 58: Testing Plan > Test Matrix ...................................................................................................................... 122

Figure 59: Design > Documents ................................................................................................................................ 123

Figure 60: Initiatives > Develop ............................................................................................................................... 125

Figure 61: Front Matter ............................................................................................................................................ 126

Figure 62: Course Level ............................................................................................................................................ 127

Figure 63: Develop > Module Level ......................................................................................................................... 128

Figure 64: Terminal Objective Level ......................................................................................................................... 130

Figure 65: Overview or Summary ............................................................................................................................. 131

Figure 66: Enabling Objective Level ......................................................................................................................... 133

Figure 67:  Elements ................................................................................................................................................. 135

Figure 68: Sub-Elements: Pages/Paragraphs and Notes/Cautions/Warnings ....................................................... 137

Figure 69: Enabling Objective Level > Sheets .......................................................................................................... 140

Figure 70: Test Items - Practice Element Example .................................................................................................. 142

Figure 71: IETM Selection Screen ............................................................................................................................. 145

Figure 72: Cited Resources ....................................................................................................................................... 147

Figure 73: Cited Sheets ............................................................................................................................................. 149

Figure 74: Assessment .............................................................................................................................................. 150

Figure 75: Initiatives > Develop > Documents ......................................................................................................... 151

Figure 76: Initiatives > Implement ........................................................................................................................... 153

Figure 77: Competencies .......................................................................................................................................... 158

Figure 78: Consumables ........................................................................................................................................... 163

Figure 79: IETMs ....................................................................................................................................................... 165

Figure 80: IMM .......................................................................................................................................................... 167



251

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Table of Figures

Figure 81: Publications ............................................................................................................................................. 169

Figure 82: Software ................................................................................................................................................... 171

Figure 83: Tools/Equipment .................................................................................................................................... 173

Figure 84: Unused Resource Management Screen ................................................................................................. 175

Figure 85: Verbs ........................................................................................................................................................ 179

Figure 86: Conditions ............................................................................................................................................... 180

Figure 87: Standards ................................................................................................................................................. 182

Figure 88: Knowledge ............................................................................................................................................... 184

Figure 89: Skills ......................................................................................................................................................... 186

Figure 90: Abilities .................................................................................................................................................... 187

Figure 91: Interventions ........................................................................................................................................... 189

Figure 92: Reports .................................................................................................................................................... 192

Figure 93: Announcements ...................................................................................................................................... 197

Figure 94: Departments ............................................................................................................................................ 198

Figure 95: Locations .................................................................................................................................................. 199

Figure 96: Roles ........................................................................................................................................................ 201

Figure 97: System Logs ............................................................................................................................................. 203

Figure 98: In-Use ....................................................................................................................................................... 204

Figure 99: Licensing .................................................................................................................................................. 205

Figure 100: Resequencing Screen - Skills Example .................................................................................................. 209

Figure 101: Replacement Screen .............................................................................................................................. 210

Figure 102: Revision Selection Screen ..................................................................................................................... 211

Figure 103: Resource Selection Screen for the TNA, TMD, and Skills .................................................................... 211

Figure 104: Slide Viewer ........................................................................................................................................... 217

Figure 105: Comments Screen ................................................................................................................................. 220

Figure 106: Resource Sub-Categories - Consumables Example ............................................................................. 228

Figure 107: Proficiency Levels - Cognitive Example ................................................................................................ 230

Figure 108: Task Analysis Content - Safety Hazard Severity Example ................................................................... 232

Figure 109: Schedule Event Types - Assessment Types Example ........................................................................... 234

Figure 110: Statuses ................................................................................................................................................. 235

Figure 111: Priorities ................................................................................................................................................ 236

Figure 112: Before Text ............................................................................................................................................ 238

Figure 113: Intervention Types ................................................................................................................................ 239

Figure 114: Status of Training .................................................................................................................................. 240

Figure 115: Types of Training ................................................................................................................................... 242

Figure 116: Test Items Delivery ................................................................................................................................ 243

Figure 117: Business Rules ....................................................................................................................................... 245

Figure 118: Configuration ........................................................................................................................................ 246

Figure 119: Default Text ........................................................................................................................................... 248



252

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

This page is intentionally left blank.



253

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

- A -
Abilities     187

All Abilities Spreadsheet     188

Approve     188

Delete     188

Related Materials Report     188

About LEAD    

Version     18

Admin     196

Announcements     196

Departments     197

In-Use     203

Licenses     204

Locations     199

Roles     201

System Logs     202

Users     200

All Abilities Spreadsheet     188

All Conditions Spreadsheet     181

All Interventions Spreadsheet     189

All Knowledge Spreadsheet     184

All Resources Spreadsheet    

Consumables     163

IETMs     165

IMM     167

Publications     169

Software     171

Tools/Equipment     173

All Skills Spreadsheet     186

All Standards Spreadsheet     182

All Verbs Spreadsheet     179

Analysis Documents    

Skill Hierarchy     72

Training Needs Analysis     72

Analysis tab     28

Documents     72

Initiative Management     29, 77

Task Analysis     59

Training Needs Analysis     33

Announcements     196

Delete     197

License Announcement     17

New Announcements     17

Read     17

Assessment     119

Create New Version     150

View Test Design Considerations     149

Assessment Package     153

Assessment Test Items     141

Assignments     30, 78

Find     23

Associated Learning Events (TNA/TMD)     41, 88

- B -
Before Text    

All Before Text Spreadsheet     238

Customize     237

Delete     238

Business Rules     218

Customize     244

- C -
Caution Entry     144

Chapter     117

Add Element     132

Cited Resources     146

Cited Sheets     149

Cited Resources     146

Missing File Resources     147

Cited Sheets     149

Comment Priorities    

All Priorities Spreadsheet     237

Customize     236

Delete     237

Related Materials Report     237

Comment Statuses    

All Statuses Spreadsheet     236

Customize     235

Delete     236

Related Materials Report     236

Comments     218

Generate All Comments     154

Common Actions     208

Competencies     158

Conditions     180

All Conditions Spreadsheet     181

Approve     181

Delete     181

Related Materials Report     181

Configuration    

Customize     245



254

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Consumables     162

All Consumables Spreadsheet     163

Approve     164

Delete     164

Impact Report     164

Related Materials Report     163

Unused Resources Spreadsheet     163

Contact Us     19

Course Level     110

Cited Resources     146

Cited Sheets     149

Curriculum Development    

Assessment     119

Course Level     110

Enabling Objective Level     117

Module Level     112

Overview     116

Summary     116

Terminal Objective Level     113

Curriculum Development (Design tab)     108

Customizations     226

Before Text     237

Business Rules     244

Comment Statuses     235

Comments     235

Configuration     245

Default Text     247

Intervention Types     239

Lists     227

Priorities     236

Proficiency Levels     229

Resource Sub-Categories     228

Schedule Event Types     233

Status of Training     240

Task Analysis Content     231

Test Items Delivery     243

Types of Training     241

- D -
Dashboard     22

Default Text    

Customize     247

Departments     197

All Departments Report     198

Delete     199

Related Materials Report     198

Design Considerations    

Caution Entry     144

Module Level     112

Note Entry     144

Text Entry     144

Warning Entry     144

Design Documents    

Objective Assessment Information     123

Testing Plan     123

Traceability Matrix     123

Training Design Document     123

Training Management Document     123

Training Outline     123

Design tab     75

Curriculum Development     108

Documents     123

Initiative Management     29, 77

Testing Plan     120

Training Management Document     81

Develop Documents    

Instructor Guide     151

Objective Assessment Information     151

Participant Guide     151

Storyboard     151

Testing Plan     151

Traceability Matrix     151

Training Design Document     151

Training Management Document     151

Training Outline     151

Develop tab     124

Assessment     149

Course Level     126

Enabling Objective Level     132

Front Matter     126

Module Level     128

Overview     131

Sheets     138

Summary     131

Terminal Objective Level     129

- E -
Edit     247

Element    

Add     132

Copy     136

Edit Storyboard     135

Major Heading     135

Paste EO Level     133



255

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Element    

Paste Overview     132

Paste Summary     132

Paste/Append     136

View Design Considerations     135

View Storyboard     135

Enabling Objective Level     117

Add Element     132

Assessment Element     141

Cited Resources     146

Cited Sheets     149

Create New Version     133

Delete     118

Paste Element     133

Practice Element     141

Test Items     141

Enabling Objectives    

Edit     75

Error Messages    

System Logs     202

Existing Interventions     188

Approve     190

Delete     190

- F -
Find Assignments     23

Flags    

Delete     220

Explain     220

New Version (yellow)     222

System (red)     222

User Created (orange)     223

User Edited (green)     222

Font Size     213

Foreword (TMD)     82

Forgot Password     16

Formatting Text    

Text Editor     212

Front Matter    

IG/PG     126

- H -
Help     18

Contact Us     19

History    

Revert     209, 210

Review     209, 210

- I -
IETMs     164

All IETMs Spreadsheet     165

Approve     166

Delete     166

Impact Report     166

Missing File Resources Spreadsheet     166

Node Selection     145

Related Materials Report     166

Table of Contents Selection     145

Unused Resources Spreadsheet     165

ILT Package     153

IMM     167

All IMM Spreadsheet     167

Approve     168

Delete     168

Impact Report     168

Missing File Resources Spreadsheet     168

Related Materials Report     168

Unused Resources Spreadsheet     167

Impact If Not Approved     35

Impact Report    

Consumables     164

IETMs     166

IMM     168

Publications     170

Resource Management     33, 81

Resources (TNA/TMD)     49, 97

Software     172

Tools/Equipment     174

Implement tab    

All Comments     154

Assessment Package     153

ILT Package     153

Instructor Guide     153

Instructor Guide Package     153

Objective Assessment Information     154

Participant Guide     153

Participant Guide Package     153

SCORM Package     153

Skill Hierarchy     154

Testing Plan     154

Traceability Matrix     154

Training Design Document     155



256

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Implement tab    

Training Management Document     154

Training Needs Analysis     154

Training Outline     155

Initiative Locations (TNA/TMD)    

Delete     49, 50, 97, 98

Edit     49, 50, 97, 98

Facilities     52, 102

Funding     53, 103

Personnel     55, 104

Resources     57, 106

Schedule     100

View     49, 50, 97, 98

Initiative Overview (TNA/TMD)     36, 84

Initiatives     26

Analysis tab     28

Curriculum Development (Design tab)     108

Design tab     75

Develop tab     124

Export     27

Implement tab     152

Initiative Management     29, 77

Objectives tab     72

Resource Management     31, 79

Task Analysis     59

Testing Plan     120

Training Management Document     81

Training Needs Analysis     33

Unused Resource Management     175

Version Assessment     150

Version EO Level     133

View All Cited Resources     31, 79

Instructor Guide    

Front Matter     126

Generate PDF     151, 153

Instructor Guide Package     153

Intervention Types    

All Intervention Types Spreadsheet     239

Customize     239

Delete     240

Related Materials Report     239

Interventions     188

All Interventions Spreadsheet     189

Approve     190

Delete     190

Related Materials Report     189

In-Use    

Delete     203

Review     203

- J -
Justification    

Changes from Previous Version (TMD)     83

Edit     36

- K -
Knowledge     183

All Knowledge Spreadsheet     184

Approve     185

Delete     185

Related Materials Report     184

- L -
LEAD    

About     18

Export Initiative     27

License Agreement     19

Version     18

Lesson Level     113, 129

Cited Resources     146

Cited Sheets     149

Library     178

Abilities     187

Conditions     180

Existing Interventions     188

Interventions     188

Knowledge     183

Skills     185

Standards     181

Verbs     178

License Agreement     19

Licenses     204

Add     205

Delete     205

New     205

Locations     199

All Locations Report     200

Delete     200

Related Materials Report     200

Log Out     19

Login    

Forgot Password     16



257

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Login    

Request an Account     16

Single-Sign-On     17

User ID     15

Login History    

[Your User Name]     20

All Logins     193

- M -
Major Heading     135

Mentoring - TO Level     113, 129

Cited Resources     146

Cited Sheets     149

Milestones     37

Add or Create     37

Add Self-Assigned - Dashboard     22

Missing File Resources Spreadsheet    

IETMs     166

IMM     168

Module - TO Level     113, 129

Cited Resources     146

Cited Sheets     149

Module Level     112

Cited Resources     146

Cited Sheets     149

Delete     113

My Profile    

Edit     20

Preferences     20

View     20

- N -
Note Entry     144

- O -
Objective Assessment Information    

Generate Spreadsheet     123, 151, 154

Objective Skill Basis    

Edit     75

Objectives    

Add or Edit     72

View     72

Objectives tab    

Enabling Objectives     75

Skill Basis     75

Terminal Objectives     75

Output Options     208

Overview    

Add Element     131

Cited Resources     146

Paste Element     132

- P -
Page    

Caution Entry     144

Edit Storyboard     136

Note Entry     144

Resource Entry     146

Select Resource     144

Sheet Entry     146

Subheading     136

Text Entry     144

View Design Considerations     136

View Storyboard     136

Warning Entry     144

Paragraph    

Caution Entry     144

Edit Storyboard     136

Note Entry     144

Resource Entry     146

Select Resource     144

Sheet Entry     146

Subheading     136

Text Entry     144

View Design Considerations     136

View Storyboard     136

Warning Entry     144

Participant Guide    

Front Matter     126

Generate PDF     151, 153

Participant Guide Package     153

Password    

Change Your Password     20

Personnel (TNA/TMD)    

Edit (for the Initiative Location)     55, 104

View (for the Initiative Location)     55, 104

Practice Test Items     141

Preferences     20

Print Preview Options     208

Procedure     117

Add Element     132



258

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Procedure     117

Cited Resources     146

Cited Sheets     149

Proficiency Levels    

All Proficiency Levels Spreadsheet     230

Customize     229

Delete     231

Related Materials Report     230

Publications     169

All Publications Spreadsheet     169

Approve     170

Impact Report     170

Related Materials Report     170

Unused Resources Spreadsheet     169

Purpose of Initiative (TMD)     85

- Q -
Qualification Earned (TNA/TMD)     40, 87

- R -
Related Materials Report    

Abilities     188

Conditions     181

Consumables     163

Customizations > Comment Priorities     237

Customizations > Comments Statuses     236

Customizations > Intervention Types     239

Customizations > Proficiency Levels     230

Customizations > Resource Sub-Categories     229

Customizations > Schedule Event Types     234

Customizations > Status of Training     241

Customizations > Task Analysis Content     232

Customizations > Test Items Delivery     243

Customizations > Types of Training     242

Departments     198, 200

IETMs     166

IMM     168

Interventions     189

Knowledge     184

Publications     170

Resource Management     33, 81

Skills     186

Software     172

Standards     182

Tools/Equipment     174

Verbs     179

Reports    

All Conditions/Standards     193

All Departments     193

All Initiatives     193

All Interventions     193

All KSAs     193

All Resources     193

Generate Outputs     192

Locations/Lists Listing     192

Login History     193

Restricted Users and their Initiatives     193

Unused Resources     193

User Listing     193

Resequence Items     209

Resource Entry     146

Resource Management     31, 79

Impact Report     33, 81

Missing File Resources     32, 80

Related Materials Report     33, 81

Resource Sub-Categories    

All Resource Sub-Categories Spreadsheet     229

Customize     228

Delete     229

Related Materials Report     229

Resources     162

Consumables     162

IETMs     164

IMM     167

Publications     169

Resource Entry (Develop tab)     146

Select (Develop tab)     144

Software     171

Tools/Equipment     173

Unused Resource Management     175

Resources (TNA/TMD)    

Missing     34

Select     211

View     48, 96

View (for the Initiative Location)     57, 106

Review History     209, 210

Roles     201

Customizer     202

Delete     202

Reviewer     202



259

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

- S -
Safety Risks and Hazardous Materials (TNA)     38

Schedule (TMD)    

View     91

Schedule Event Types    

All Schedule Event Types Spreadsheet     234

Customize     233

Delete     235

Related Materials Report     234

SCORM Package     153

Section - EO Level     117

Add Element     132

Cited Resources     146

Cited Sheets     149

Section - TO Level     113, 129

Cited Resources     146

Cited Sheets     149

Self-Assigned Assignments    

Delete     23

Self-Assigned Milestones    

Delete     22

Sheet Entry - Page/Paragraph     146

Sheet Test Items     141

Sheets    

Assignment     138

Caution Entry     144

Diagram     138

Information     138

Job     138

Note Entry     144

Outline     138

Problem     138

Resource Entry     141

Select Resource     144

Sheet Entry - Page/Paragraph     146

Text Entry     144

Warning Entry     144

Skill Hierarchy     72, 154

Skills     185

All Skills Spreadsheet     186

Approve     187

Delete     187

Related Materials Report     186

Software     171

All Software Spreadsheet     171

Approve     172

Delete     172

Impact Report     172

Related Materials Report     172

Unused Resources Spreadsheet     171

Standards     181

All Standards Spreadsheet     182

Approve     183

Delete     183

Related Materials Report     182

Status of Training    

All Status of Training Spreadsheet     241

Customize     240

Delete     241

Related Materials Report     241

Storyboard     143

Caution Entry     144

Generate PDF     151

Note Entry     144

Page     136

Paragraph     136

Resource Entry     146

Select Resource     144

Text Entry     144

Warning Entry     144

Sub-Element     136

Subheading     136

Subject     117

Add Element     132

Cited Resources     146

Cited Sheets     149

Summary    

Add Element     131

Cited Resources     146

Paste Element     132

System Logs     202

Export     203

- T -
Target Audience (TNA/TMD)     39, 86

Task Analysis    

Ability     70

Add or Edit Ability     70

Add or Edit Condition     70

Add or Edit Interventions     70

Add or Edit Knowledge     70

Add or Edit Resources     70

Add or Edit Skill     70



260

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Task Analysis    

Add or Edit Standard     70

Condition     70

Copy Duty     63

Copy Job     61

Copy Step     69

Copy Subtask     67

Copy Task     66

Duty     62

Edit     59

Edit Competency Selection     70

Edit Task     64

Interventions     70

Job     60

Knowledge     70

Paste Duty     61

Paste Skill     60

Paste Step     67

Paste Subtask     66

Paste Task     63

Resources     70

Select from Competencies     70

Select Resources     211

Skill     70

Skill Hierarchy Output     72

Standard     70

Step     68

Subtask     66

Task     64

Task Analysis Content    

All Task Analysis Content Spreadsheet     232

Customize     231

Delete     233

Related Materials Report     232

Team Members    

View     29, 77

Terminal Objective Level     113

Cited Resources     146

Cited Sheets     149

Delete     115

Terminal Objectives    

Edit     75

Test Design Considerations    

View     149

Test Items     141

Caution Entry     144

Note Entry     144

Resource Entry     146

Select Resource     144

Sheet Entry - Performance Job Sheet     146

Text Entry     144

Warning Entry     144

Test Items Delivery    

All Test Items Delivery Spreadsheet     243

Customize     243

Delete     244

Related Materials Report     243

Test Matrix    

Edit     121

View     121

Testing Plan    

Edit     120

Generate PDF     123, 151, 154

Test Matrix     121

Text Editor    

Font Sizes     213

Formatting Text     212

Using     212

Text Entry     144

TMD Resources    

Impact Report     49, 97

Uncited Resources Report     48, 96

Unlisted Resources Report     49, 97

TNA Resources    

Impact Report     49, 97

Uncited Resources Report     48, 96

Unlisted Resources Report     49, 97

Tools/Equipment     173

All Tools/Equipment Spreadsheet     173

Approve     174

Delete     174

Impact Report     174

Related Materials Report     174

Unused Resources Spreadsheet     173

Traceability Matrix    

Generate Spreadsheet     123, 151, 154

Training Data (TMD)    

Schedule     91

Training Data (TNA/TMD)    

Facilities     44, 92

Funding     45, 93

Impact Report     49, 97

Personnel     46, 94

Select Resources     211

Uncited Resources Report     48, 96

Unlisted Resources Report     49, 97



261

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

Training Data (TNA/TMD)    

View Resources     48, 96

Training Design Document    

Generate PDF     123, 151, 155

Training Management Document    

Associated Learning Events     41, 88

Changes from Previous Version     83

Edit     81

Facilities     44, 92

Facilities (for the Initiative Location)     52, 102

Foreword     82

Funding     45, 93

Funding (for the Initiative Location)     53, 103

Generate PDF     123, 151, 154

Impact Report     49, 97

Initiative Locations     49, 97

Initiative Overview     36, 84

Missing Resources     34

Personnel     46, 94

Personnel (for the Initiative Location)     55, 104

Purpose of Initiative     85

Qualification Earned     40, 87

Resources (for the Initiative Location)     57, 106

Schedule     91

Schedule (for the Initiative Location)     100

Select Resources     211

Target Audience     39, 86

Training Data     42, 89

Uncited Resources Report     48, 96

Unlisted Resources Report     49, 97

View Resources     48, 96

Training Needs Analysis    

Associated Learning Events     41, 88

Facilities     44, 92

Facilities  (for the Initiative Location)     52, 102

Funding     45, 93

Funding (for the Initiative Location)     53, 103

Generate PDF     72, 154

Impact Report     49, 97

Initiative Locations     49, 97

Initiative Overview     36, 84

Justification     35

Milestones     37

Missing Resources     34

PDF Output     72

Personnel     46, 94

Personnel (for the Initiative Location)     55, 104

Qualification Earned     40, 87

Resources (for the Initiative Location)     57, 106

Safety Risks and Hazardous Materials     38

Select Resources     211

Target Audience     39, 86

Training Data     42, 89

Uncited Resources Report     48, 96

Unlisted Resources Report     49, 97

View Resources     48, 96

Training Outline    

Generate PDF     123, 151, 155

Type of Training    

Delete     243

Types of Training    

All Types of Training Spreadsheet     242

Customize     241

Related Materials Report     242

- U -
Uncited Resources Report    

Resources (TNA/TMD)     48, 96

Unlisted Resources Report    

Resources (TNA/TMD)     49, 97

Unused Resource Management     175

Unused Resources Spreadsheet    

Consumables     163

IETMs     165

IMM     167

Publications     169

Software     171

Tools/Equipment     173

Users     200

Edit My Profile     20

Login     15

Request an Account     16

Single-Sign-On     17

View My Profile     20

- V -
Verbs     178

All Verbs Spreadsheet     179

Approve     180

Delete     180

Related Materials Report     179



262

LEAD Documentation                                                                                                     COMPANY   PROPRIETARY                                                                                                  ©2024 Aimereon

Index

- W -
Warning Entry     144

Workshop     113

Cited Resources     146

Cited Sheets     149

Workshop - TO Level     129


	Table of Contents
	Welcome
	Login to LEAD
	Request an Account
	Forgot Password
	Single-Sign-On

	Using LEAD
	Help
	Contact US

	[Your User Name]
	My Profile
	Change Password
	Login History


	Home > Dashboard
	Milestones
	Assignments

	Initiatives
	Work with Initiatives
	Analysis
	Initiative Management
	Team Members
	Assignments
	Resource Management

	Training Needs Analysis
	Justification (TNA Only)
	Initiative Overview (TNA and TMD)
	Milestones (TNA Only)
	Safety Risks and Hazardous Materials (TNA Only)
	Target Audience (TNA and TMD)
	Qualification Earned (TNA and TMD)
	Associated Learning Events (TNA and TMD)
	Training Data (TNA and TMD)
	Facilities (TNA and TMD)
	Funding (TNA and TMD)
	Personnel (TNA and TMD)
	Resources (TNA and TMD)

	Initiative Locations (TNA and TMD)
	[Selected] Initiative Location (TNA and TMD) 
	Facilities (TNA and TMD)
	Funding (TNA and TMD)
	Personnel (TNA and TMD)
	Resources (TNA and TMD)



	Task Analysis
	Job
	Duty
	Task
	Subtask
	Step
	Adding Conditions, Standards, and Resources
	Adding Knowledge, Skills, and Abilities
	Adding Interventions
	Selecting from Competencies

	Documents

	Objectives
	Viewing or Editing Terminal Objectives
	Viewing or Editing Enabling Objectives
	Selecting the Skill Basis

	Design
	Initiative Management
	Team Members
	Assignments
	Resource Management

	Training Management Document
	Foreword (TMD Only)
	Changes from Previous Version (TMD Only)
	Initiative Overview (TNA and TMD)
	Purpose of Initiative (TMD Only)
	Target Audience (TNA and TMD)
	Qualification Earned (TNA and TMD)
	Associated Learning Events (TNA and TMD)
	Training Data (TNA and TMD)
	Schedule (TMD Only)
	Facilities (TNA and TMD)
	Funding (TNA and TMD)
	Personnel (TNA and TMD)
	Resources (TNA and TMD)

	Initiative Locations (TNA and TMD)
	Selected Initiative Location (TNA and TMD) 
	Schedule (TMD Only)
	Facilities (TNA and TMD)
	Funding (TNA and TMD)
	Personnel (TNA and TMD)
	Resources (TNA and TMD)



	Curriculum Development
	Course Level
	Module Level
	Terminal Objective Level
	Overview/Summary
	Enabling Objective Level
	Assessment

	Testing Plan
	Test Matrix

	Documents

	Develop
	Front Matter
	Course Level
	Module Level
	Terminal Objective Level
	Overview/Summary
	Enabling Objective Level
	Elements
	Sub-Elements

	Sheets
	Adding Multiple Resources to a Sheet
	Editing a Resource Citation/Entry

	Test Items
	Storyboard
	Adding or Editing a Text/Note/Caution/Warning Entry
	Adding a Resource Citation/Entry
	Working with IETM Table of Contents

	Editing a Resource Citation/Entry
	Adding or Editing a Sheet Citation/Entry
	Cited Resources
	Cited Sheets
	Assessment
	Documents

	Implement

	Competencies
	Resources
	Consumables
	IETMs
	IMM
	Publications
	Software
	Tools/Equipment
	Unused Resource Management

	Library
	Verbs
	Conditions
	Standards
	Knowledge
	Skills
	Abilities
	Interventions

	Reports
	Admin
	Announcements
	Departments
	Locations
	Users
	Roles
	System Logs
	In-Use
	Licenses

	Common Actions
	Output Options
	Resequencing Items
	Replacing Resources, Library Items, Departments, Locations, Customization List Items
	Reviewing and Reverting History
	Selecting Resources for the TPP, TCCD, and Skills
	Using the Text Editor
	Viewing Slides
	Working with Business Rules
	Working with Comments
	Working with Flags

	Customizations
	Lists
	Resource Sub-Categories
	Proficiency Levels
	Task Analysis Content
	Schedule Event Types
	Comments
	Statuses
	Priorities

	Before Text
	Intervention Types
	Status of Training
	Types of Training
	Test Items Delivery

	Business Rules
	Configuration
	Default Text

	Tables
	Index

